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Chapter 1   
Using this Guide 

 About this chapter: 

This chapter describes how to use this guide, as follows: 
About this Manual, the following page, describes the chapters in this 
user’s guide. 

What You Should Know, page 1-5, describes things you should know 
and the typographical convention used in this guide. 

Registering Your Product, page 1-6, describes how to register your 
product and how to receive technical support. 
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About this Manual 

Wizcon for Windows and Internet User’s Guide, designed for Wizcon 
for Windows and Internet running under Windows NT and Windows 
95/98 provides developers and system integrators with the necessary 
information to build process and control applications with Wizcon. 

If you are using Wizcon for Windows and Internet for the first time, you 
may proceed in one of the following ways: 

■ 

■ 

Read this guide from cover to cover, exactly as it is presented. 

Read Chapters 1 through 5. These chapters provide you with basic 
information on the Wizcon installation procedure, guidelines for 
designing an application, and a description of the Wizcon 
Application Studio. Then, read the chapters you need, depending on 
the tasks you want to perform. 

If you are an experienced Wizcon user, read Chapter 2, Introducing 
Wizcon, to learn about the available features, and then use the Table of 
Contents to find the information you need. 

Due to the size of this manual it has been divided into two volumes: 

Volume I 
Chapter 1, Using this Guide, covers basic information about this 
manual. 
Chapter 2, Introducing Wizcon, introduces Wizcon and its features.  
Chapter 3, Installing Wizcon for Windows and Internet, describes the 
system requirements and installation procedure.  
Chapter 4, Getting Started, provides guidelines for building 
applications with Wizcon. 
Chapter 5, Getting to Know the Application Studio, describes the 
operational framework of Wizcon. 
Chapter 6, Building a Project, describes the Wizcon Wizard and how to 
optimize application performance. 
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Chapter 7, Security, Authorization and User Management, presents 
an overview on Authorization and Security and in depth description of 
User Management. 
Chapter 8, Communication Drivers, describes how to define 
communication drivers and blocks. 
Chapter 9, Tags, describes how to define and use tags, which are 
contact points through which Wizcon receives data from the controller 
and/or outputs data to it. 
Chapter 10, Alarms, describes how to define and use alarms, which are 
internal system messages that provide the operator with information 
concerning events generated by the system. 
Chapter 11, Advanced Alarm Management, gives an indepth 
description of the AAM module. 
Chapter 12, Users Timetable, gives an indepth description of the User 
Timetable module. 
Chapter 13, Alarm Filters, Printers and Printer Targets, gives an 
indepth description on these modules. 
Chapter 14, Events Summaries, describes different options for alarm 
display. 
Chapter 15, Creating Events Summary Profiles, describes how to 
define the way alarms are displayed in a browser. 
Chapter 16, Introduction to the Image module, introduces the user to 
the Image module. 
Chapter 17, Image Editor, describes how to create and view images.  
Chapter 18, Image Animation, describes the process of image 
animation. 
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Volume II 
Chapter 19, Charts, gives an indepth description of the Charts module. 
Chapter 20, Creating Trend Viewers, describes how to create and 
modify a Trend Profile, to compare device functionality and correlate 
actions and responses, and how to create a Trend Viewer that displays 
these past and current events in a browser. 
Chapter 21, Generating HTML Pages, describes how to generate and 
edit HTML pages. 
Chapter 22, Wizcon Language, describes how to create programs that 
enhance system capabilities.  
Chapter 23, Recipes, describes how to create, define and apply recipes 
and model recipes.  
Chapter 24, History Viewers, describes how to generate and use 
History Viewer lists to provide you with simple and straightforward data 
concerning tags and tag values over specific periods of time. 
Chapter 25, Reports, describes how to define customized reports. 
Chapter 26, Macros, describes how to define macros. 
Chapter 27, Wizcon DDE Support, describes how to define Wizcon as 
a DDE client or server. 
Chapter 28, Wizcon Network, describes how to design and operate a 
Wizcon Network. 
Chapter 29, WizSQL -Wizcon SQL Support, describes how to use 
WizSQL both as a client and server. 
Chapter 30, Multiple Tags, describes how to define multiple tags.  
Appendix A, Wizcon for Windows and Internet Files, describes data 
and configuration files used by Wizcon. 
Appendix B, Tuning Parameters, gives an indepth description of the 
fine-tuning parameters required for the Wizcon application. 
Appendix C, VFI5FST (VFI Fast), describes the VFI5FST tuning 
parameter. 
Appendix D, Networking with OPC Using DCOM, provides 
instructions for accessing data from remote OPC servers using DCOM. 



Appendix E, ASCII (ILS) File Format, describes the structure and 
format of the Wizcon for Windows and Internet ASCII (ILS) file. 
Appendix F, Glossary, provides a description of the terms and 
definitions used in this manual. 
Index  

What You Should Know 

Before you start using Wizcon and work through this user’s guide, you 
should be familiar with the Windows NT and Windows 95 operating 
systems. You should also know how to do the following: 

Operate an IBM-PC or compatible. ■ 

■ 

■ 

Use a mouse. 

Use a dialogbox. 

Typographical Convention 

This guide uses the following typographical convention: 

Web-disabled This symbol indicates that a feature is not supported or applicable 
on the Web. 
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Registering Your Product 

You are important to us, and it’s important for us to know who our 
customers are. Registering your Wizcon product enables us to provide 
you with better services and important notifications about the product. 
Please take a minute to complete the Licensing Agreement included with 
your product and send it to eMation. 

Receiving Technical Support 

You can receive technical support from your local distributor. To receive 
prompt support, make sure that you complete the registration form and 
send it to eMation. 
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Chapter 2   
Introducing Wizcon  

 About this chapter: 

This chapter describes Wizcon for Windows and Internet and its 
features: 

What is Wizcon for Windows and Internet? page 2-2 describes 
Wizcon. 

Wizcon for Windows and Internet Main Features page 2-4 describes 
Wizcon Main Features. 
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What is Wizcon for Windows and Internet? 

Wizcon  is an advanced Supervisory Control and Data Acquisition 
(SCADA) system used as an applications development tool that enables 
system integrators to create sophisticated Supervisory and Control 
applications for a variety of industries. 

Wizcon is an application generator. This means that all the control and 
monitoring facilities are already built into the system, and only the 
project definitions need to be provided by the application engineer. 
Minimal computer or programming skills are required. 

Wizcon takes advantage of the powerful, preemptive, multi-tasking 
capabilities of the Windows 2000 and NT operating systems and a built-
in event-driven mechanism to achieve utmost performance and data 
integrity. It also uses its interface mechanisms to implement clear and 
efficient visualization of its components. 

Wizcon for Windows and Internet enable you to integrate your 
application with your Internet/Intranet network, promoting real-time 
Supervisory and Control using real-time graphics and event-driven 
information updates from any computing platform. It combines the 
benefits of SCADA, Java, HTML and Internet. 

Wizcon for Internet applications can be accessed and used without 
requiring platform-specific software, client software installation, or 
plug-ins. The production floor can be safely monitored and controlled 
through a standard Web browser. You can also view both factory data 
and corporate information through a common interface, from any 
desktop or laptop.  

A Wizcon application communicates with control equipment in the field 
such as Programmable Logic Controllers (PLCs), measuring instruments, 
and other devices. As the equipment is monitored and data is recorded, 
Wizcon responds according to system logic requirements or operator 
requests. 



Typical Wizcon SCADA Configuration 

 

Introducing Wizcon  2-3 



2-4  Wizcon for Windows and Internet User's Guide 

Wizcon for Windows and Internet Main Features 

This section describes Wizcon main features and concepts.  A glossary 
appears at the back of this book in which you can find descriptions of 
Wizcon terms and concepts. 

Advanced Alarm Management  

The Advanced Alarm Management (AAM) uses a multi-service 
communications platform providing alarm transmission over various 
communication channels including Internet, SMS, email, fax and voice.  

Alarms can be defined according to hierarchy, be filtered, appear on the 
user’s screen as a pop-up message with/without voice, sent to a single 
user or when defined sent to groups and teams or to a backup user.  
Additionally, alarms can be defined as system alarms, be delayed, 
inhibited, locked or defined according to zones.   

Authorized users can add comments or instructions to an alarm for future 
reference.  Alarms can be imported/exported to/from previous versions 
or other files.    

Operators can acknowledge the reception of alarms and automatically 
receive instructions for handling them.  Alarms can also be recorded to a 
history file for reference purposes.   

Automatic Network Optimization 

When there are very fast tag changes on the Wizcon station and the 
server is too loaded to send all tag changes, this functionality sends the 
newest tag values to the web client   

If the web client cannot keep up with tag changes from Wizcon for the 
Internet station it will process the latest tag thereby insuring that the 
information displayed is always updated.   



Background Processing 

Wizcon enables you to process heavy jobs without temporarily disabling 
the Wizcon system.  While background processing is in progress other 
operations can be performed.   

Background processing operates when: 

Loading an image file that is larger than 30K  ■ 

■ 

■ 

■ 

Printing an image  

Generating Events Summary and History Viewer reports  

Using MultiAdd, List, and Use functions in the Tag Definition 
dialog box.  (See the Tags chapter). 

The following is an example of a background Processing dialog box. 

 

The string above the Stop button describes the task that is currently 
being executed. The Stop button can be activated to end the process. 
However, in some cases, the Stop button will not appear and termination 
is not possible. During the process, the percentage covered will 
continuously be displayed until the entire process is completed. 
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Built-in Report Generator 

The Wizcon built-in report generator keeps you continuously informed 
and up to date on all plant activities.   
Designed specifically for supervisory and control systems, the report 
generator can produce customized daily shift reports, periodical reports, 
and event-driven reports.  For more sophisticated reports use WizReport, 
available on the Value Pack CD.   

Charts and Reports  

Wizcon charts provide graphical views of process behavior and 
operational trends over a period of time.  A single chart can display 
historical and real-time trends in distinctive colors and styles. Charts can 
also be defined to display a tag’s bit. 

An X-Y chart can be configured with up to 16 related process parameters 
and the user can scroll along the X and Y axis while zooming in and out 
to view the required details.   

Database Connectivity 

The WizSQL module allows application designers to build event-driven 
SQL queries to read and write Wizcon data from and to database tables. 
This simplifies the exchange of information with other applications.   

Note:  The application’s database files are saved in Microsoft Access 
where they can be opened and modified. 
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Easy Maintenance 

Wizcon for Internet reduces operating costs by enabling users to build a 
single application instead of a network solution of multiple applications. 
In addition, it eases the administrative burden tremendously, since it is 
Java based and Java is already an integral part of the web browser 
installed on most desktops. 

Wizcon for Internet does not need to be installed locally on each 
machine. Updates can be distributed centrally through web servers. 

The Wizcon for Internet functionality does not introduce new 
configuration, resource or compatibility issues; nor does it require extra 
administrative or maintenance effort for each machine. In addition, 
Wizcon for Internet relies on Java's portability and eliminates the need to 
support different versions of applications on different platforms.  Wizcon 
for Internet can be viewed online with a browser. 

Events Summary 

The Events Summary Window’s type interface displays alarms 
according to the user’s specifications.   The user can apply filters to 
display only alarms from a defined zone range, severity range, family 
prefix, station, class and more.  Alarms such can also be sorted in the 
Events Summary.   

The Events Summary functionality also provides multi filtering and 
alarm inhibition.  The Go to Zone feature enables connecting predefined 
zones to alarms.  This means that an alarm can be attached to an image 
of a problematic zone enabling the user receiving the alarm to easily 
identify the alarm’s whereabouts. 
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Events Summary Profiles 

Events Summary Profiles determine how active alarms and history are 
displayed in a browser according to the definitions defined by the 
System Integrator.   

Events Summary Viewer  

The Events Summary Viewer features real-time monitoring of alarms 
and history according to the definitions specified in the Events Summary 
Profile.  This enables the user to monitor and acknowledge alarms in 
real-time, adjust alarm display, resize columns, change alert sorting and 
view alarm history. 

Alarm filters can also be changed to view only specific alarms, for 
example, from a certain zone or according to priority.  Filters can also be 
added and removed without affecting the server side.  Html alarms files 
can be used and the alarm background and text colors can be set 
according to alert severity and zone. 

Similar to the Events Summary display, this viewer shows the following 
lists; In History Mode, Load Picture, Inhibit, Ack Selected, Force End, 
Assist, Columns, Filter List and Add Comments. 

Hot Backup Support 

A Wizcon for SCADA station can serve as a backup to other stations. If 
the main SCADA system fails, the backup station immediately takes 
over and continues to function.   
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Imaging 

Wizcon employs the most advanced techniques for presenting images. 
They include:  

■ 

■ 

■ 

■ 

■ 

 

■ 

Drawing a single large image representing the entire plant and then 
zooming in on a selected area to obtain detailed views of small and 
even hidden elements. An image can consist of more than 64 layers, 
with each layer representing specific information. Operators can then 
choose and mix layers, accessing only the information they need and 
are authorized to see. 

Defining dynamics so that as parameters in the field change, so do 
graphical drawings and textual displays. For instance, if a tank is 
being filled, the respective tank drawing will be filled accordingly 
and the display of the liquid level will be updated numerically. 

The zone navigator can be used to navigate through the various 
application’s image zones. 

Defining any object in the image as a trigger, so that whenever the 
object is selected, one of several operations, such as activating a 
macro will be automatically performed. 

Designing an image using the Wizcon simple, yet powerful, Image 
Editor that includes a variety of drawing tools designed specifically 
for Wizcon for Internet requirements. This unique editing feature 
enables you to easily modify any object and simultaneously apply 
the changes to all the applications’ diagrams.  Objects in an image 
file can be locked (and unlocked) to prevent them from being 
modified or deleted. 
In addition to drawing images within the Wizcon framework, 
graphic files generated using other software programs can be 
imported to the Wizcon Image Editor. 

 

The Wizcon clusters library holds a variety of prebuilt objects, 
including valves, pumps, and other industry-standard components. 
The user can define or change the parameters of each object and save 
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the changes in the Wizcon for Internet configuration database. When 
a new library is created it can be saved to the Wizcon Global Cluster 
Library and used in other applications. 

■ The fast actions triggers are predefined built-in macros that enable 
you to easily trigger routine operations.  Among the available actions 
are:  load/close window, load/close image, load/close chart, 
load/close events summary. 

Milli-second Time Stamping 

Wizcon samples PLCs at up to a 50 milliseconds resolution and can 
receive data with a time stamp of up to 1 millisecond resolution. This 
data is registered in Wizcon history files according to the time stamp. It 
allows operators to trace the sequence of plant events exactly as they 
occurred. 

Networking 

The Wizcon solution provides a smooth growth path from a standalone 
workstation through the plant floor configuration to plant-wide network 
architecture connecting the plant floor with existing file servers and 
other management systems.  

The Wizcon network uses client-server architecture.  Wizcon can be 
connected to other Wizcon stations or Wizcon stations using NetBIOS or 
TCP/IP protocol. Thus, tags and alarms defined on any Wizcon station 
can be used on the same network as Wizcon for Internet. 

Online Design 

Changes can be made during runtime and the user can view the results 
immediately. 
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Open Architecture 

Wizcon integrates seamlessly with your existing databases, spreadsheet 
and other customized applications, allowing you to focus on productivity 
rather than compatibility.  

■ 

■ 

■ 

■ 

■ 

■ 

■ 

Wizcon Virtual File Interfaces (VFIs) enable the designer to select 
different file formats to be used by WizPro for historical data 
logging and report generation. The system engineer can use a 
combination of different file systems and databases with the 
application, for data manipulation convenience and optimum 
performance.  

A comprehensive Application Programming Interface (API) is 
included with every Wizcon for Windows and Internet package to 
enable smooth integration with customized programs and application 
modules.  

Wizcon supports two-way Dynamic Data Exchange (DDE) links for 
exchanging data with other DDE-compatible applications. 

Wizcon SQL Interface enables application designers to build event-
driven SQL queries to read and write Wizcon for Internet data from 
and to database tables, simplifying the exchange of information with 
other applications. 

Wizcon is managed by a real-time, event-driven kernel called 
WizPro. This module includes an API that can be used to write 
supplemental Wizcon programs in C and Visual Basic language, to 
meet the specific requirements of any project. For further 
information, refer to the Read Me file located in the Wizcon Toolkit. 

Wizcon  is compatible with a wide variety of PLCs and other control 
system components. Custom adaptation is supported through a fully 
documented toolkit. 

All definitions of alarms and tags are saved in a Microsoft Access 
Database (MDB).  A database can be opened and modified by the 
user in MS Access. 
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■ 

■ 

■ 

■ 

A history of tag changes can be saved and viewed/opened in a 
database that supports ODBC.    

Wizcon’s OPC capabilities enable System Integrators to create a 
common interface for exchanging data with hardware field devices 
or other software that can be reused by this client program, and other 
HMI, SCADA and custom applications. 

PLCs Sampler 

Wizcon samples PLCs at up to a 50 milliseconds resolution and can 
receive data with a time stamp of up to 1 millisecond resolution. Wizcon 
can sample up to 32 networks of PLCs and other field devices. 

Printers 

Alarms and their history, tag history and reports can be printed both on 
local and network printers.  Printing definitions such as color or different 
text fonts and backgrounds can be defined.  There are two printing 
modes: 

Graphical printout, which can appear as a page holding a list of 
events or alternatively, each event is printed on a separate page.    

Line mode printing where each alarm is printed separately in real-
time and is added to the list already printed on the page. 

Recipes 

Wizcon provides recipes that are lists of tag values that are applied to 
specific control processes as groups. 

Operators can edit, load and save recipes for convenient handling of 
production processes and setting control programs. Recipe management 
and downloading production recipes from management systems is simple 
and straightforward. 
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Security 

The System Integrator responsible for the Wizcon application can, using 
the User Management module, grant access permission to users.  Users 
can have full or partial access to the various Wizcon modules.  Access 
can be defined according to users, groups and teams. 
A user password can hold up to 20 characters which can be changed by 
the user (if defined so the System Integrator).  Access to the application 
can also be through a token or PIN number. 

Security on the Web 

Wizcon applications take full advantage of the security features provided 
by the Web server, enabling user access control according to selected 
Web pages.  A Firewall can be used to limit access according to IP 
addresses.  

Wizcon also offers the System Integrator the power to limit the 
operations that the user is able to perform.  Only authorized users with 
specific access permission can login to the application. 

Tags 

A Wizcon tag is used as an internal variable for calculations and display 
and communication with PLCs in order to represent data from PLC 
memory, or to send commands to PLCs.  

Tag values can be scanned and recorded to historical files according to 
several parameters specified by the user. Tags can also be assigned a 
DDE link definition and can therefore receive or send data to/from other 
applications. 

Pre-defined built-in System tags that provide information about the 
system can be created.  System tags could be for example, time, date, 
hour etc parameters.  The list of System tags can be viewed in the All 
Container tree. 
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A tag can also be locked/unlocked according to pre-defined time.  This is 
useful during maintenance enabling the System Integrator to lock tags 
and prevent irrelevant alarms from being sent.  A list of all the tags 
defined in the Lock Tag can be viewed in run-time.  

Tags can be imported/exported to/from other applications or previous 
versions. 

Trend Profiles  

The Trend feature provides real time and historical graphical view of tag 
values over time. 

Wizcon architecture provides additional benefits for remote control 
applications and applications where frequent causal access is required. 
For these applications historical display of data is critical. In such 
applications an operator may wish to log in to their application at the end 
of the day and check what happened during the day. 
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The Trend features include: 

■ 

■ 

■ 

■ 

■ 

■ 

■ 

■ 

Historical cache mechanism: Offers improved performance with 
minimum load on the server. 

Asynchronous historical data download: As a result the Trend is 
always responsive to the user.  

Performance: On a local area network, performance is similar to 
Wizcon for Windows. It is possible to use trends over dial-up 
connection. 

Display of multiple tags over time. 

Historical and on-line data support.  

X and Y axis labeling. 

Different line colors and line types. 

The Trend component takes less than 800kb. 

Trend Viewer 

A Trend Viewer displays online activities and history recorded by the 
Wizcon for Internet system according to definitions specified in the 
Trend Profile. 

The Trend Viewer functionality enables modification of the chart’s tag 
setup over the Internet without affecting the server side.  The Setup 
menu enables updates to Tags, Time and the Grid, whereas the Options 
menu enables Axis Orientation, Print and Show Grid. 
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Wizcon Language 

Wizcon includes a built-in control language called Wizcon Language, 
which can be used to automate plant tasks, augment control capabilities, 
and enhance system flexibility. 

This language enables application engineers with little programming 
expertise to write useful command programs. Each system function, such 
as access to control devices, can be expressed in symbolic form in 
Wizcon Language, so that any application engineer can customize the 
application to meet specific plant design requirements. 

User Management   

 User Management container enables management of all the users of an 
application both locally and remotely.  This system enables definition of 
user groups and teams and their access permission to the various 
application modules.  A timetable can be set for each user/group/team 
and alarms, when necessary can be sent to the appropriate personnel.  
This management methodology allows for easy scheduling of personnel 
for various tasks. 

Providing full backwards compatibility, User Management enables 
import/export of groups created in/for previous/new versions.   
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Zone Navigator  

The Zone Navigator window enables quick and efficient navigation 
through the list of zones defined in the application’s various image 
objects.  Using the Zone Navigator you can define a number of 
navigators each of which can contain a number of zones from one or 
more different image files. 

The Zone Navigator can be applied to images through either Button or 
Action type triggers or by configuring an Action type macro.  A digital 
tag representing the zone’s status can be added to each zone navigator.  
Additionally, color indicators can also be defined.   

The multi-image zone navigator can be activated from the Wizcon 
Studio control panel, from the Wizcon Studio Design menu or at runtime 
from the image using a button or action trigger.  This feature has Web 
support. 
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Chapter 3   
Installing Wizcon for 
Windows and Internet 

 About this chapter: 

This chapter describes Wizcon for Windows and Internet system 
requirements and the installation procedure.  

System Requirements, on the following page, describes the required 
Wizcon for Windows and Internet system requirements. 

Installation, page 3-3, describes how to install and uninstall Wizcon for 
Windows for Internet.  

Starting Wizcon for Windows and Internet, page 3-11, describes how 
to start Wizcon for Windows and Internet.  

Additional Installations, page 3-11, lists the additional software 
components installed during Wizcon installation. 
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System Requirements 

Before you install Wizcon, verify that you have the following: 

Hardware 

Computer: 200MHz Pentium, or higher.  

Memory: 64MB minimum.  

Hard Disk: 120 MB minimum free. 

Display: VGA, SVGA, or any graphic adaptor that supports the 
operating system desktop. The display should be set at 256 colors or 
higher and the screen resolution should be set at 640 x 480 or higher. 

Mouse: Any PC compatible mouse. 

Parallel Port: Required for the Wizcon security plug. 

Software 

Operating System: Microsoft’s Windows NT version 4.0 (or higher), 
Windows 2000 (or higher). 

■ 

■ 

■ 

■ 

Correctly configured TCP/IP: A fixed IP address is required for a 
web server. 

Web server: A web server is required for publishing the application, 
(not for development). 

Browser: Microsoft Internet Explorer 5 (or higher) and virtual 
machine. 

HTML Editor: Any HTML editor may be used. 

 



The following is required to publish a Wizcon application on the Web. 

Windows NT 4.0.  ■ 

■ 

■ 

Java 1.1 enabled browser  

A web server. For example, the Microsoft Internet Information Server 
that can be downloaded from the Microsoft web site. 

Installation 

It is strongly recommended that you close and exit all Windows programs 
before running the installation procedure.  

➤ To install Wizcon: 

1. Insert the CD-ROM into the CD-ROM drive. The WizFactory Setup 
menu is automatically displayed: 
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2. The Setup program has the following options: 

■ 

■ 

■ 

■ 

WizFactory: Loads the Setup program for the WizFactory and 
WizPLC and also includes: 

Wizcon Demo Applications: Enables you to install 
Wizcon demo applications, such as Chemicals and 
Building and Water. Different demo applications run on 
Windows 95/98 and Windows NT. The resolution of 
your screen should be set to either: 
Resolution 1024 x 768 or  
Resolution 800 x 600 

Explore CD: Opens Windows Explorer, enabling you to 
view the CD contents. 

Exit: Exits the Master Setup program. 

Note:  If the menu is not automatically displayed do the following:  Click on 
the Start button, select Run and enter: D:\setup.exe into the Open field, 
where “D” is your CD-ROM drive. Click OK and select WizFactory. 

 



1. Click the Next button to continue the installation. The Welcome to 
the Install Shield Wizard for WizFactory dialog box opens: 

 
2. Click Next to open the WizFactory License Agreement. 
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3. Click Yes to accept the License Agreement terms and to open the 
Choose Destination Location dialog box.  If the location of the 
program is correct click Next, if not click Browse to select a 
different path.   
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4. The Select Type dialog box opens.  Click the setup type and then 
click Next.   

 
If Typical is selected the Select Example Files dialog box opens 
where demo applications can be selected and installed. 

■ 

■ 

■ 

If Compact is selected the Wizcon and WizPLC minimal 
installation pack is installed.   

If Custom is selected the Select Components Tree dialog box 
opens where the user can select only the relevant components 
required for the installation. 
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5. The Select Language dialog box opens.  Select a language and click 
Next. 

 
6. The Select WizPLC version dialog box opens.  Select either Soft and 

Hard Real Time versions or Soft Real Time version and then click 
Next. 
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7. The Finish Reboot dialog box opens indicating that the application 
has been successfully installed.  Click Yes to restart your computer 
or No not to and then click Finish. 

 

Previous WizFactory Versions 

If you have a previous version of Wizcon installed a message box opens 
reminding you to uninstall the previous Wizcon application. 

Uninstalling Wizcon for Windows and Internet 

Wizcon includes an Uninstall utility that you can use to remove the 
program from your computer. The utility will only remove the 
directories, files, folders, icons and registration originally created by the 
Wizcon for Windows and Internet Installation program. 

To achieve the best results, exit Wizcon and make sure that WizPro is 
not running in the background before using the Uninstall program. If 
WizPro is working, some files and icons may not be removed. 
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➤ To launch the Wizcon for Windows and Internet Uninstall Program: 

1. Click on the Start button on your desktop, point to Settings and then 
click on Control Panel. The Control Panel folder is displayed. 

2. Double-click on the Add/Remove Programs icon. The Add/Remove 
Program Properties dialog is displayed.  

3. Select Wizcon for Windows and Internet from the list of available 
programs and click the Add/Remove button.  

4. When the program has been removed, click the OK button to close 
the dialog box. 

Caution 

It is strongly recommended that a personal web server or IIS be installed 
on the computer prior to installation.  If the above software components 
are not installed the following dialog box opens.  

 

Select No to continue Yes to exit the installation. 
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Additional Installations 

The following components are installed during Wizcon installation if 
they are not already installed. 

MDAC (Microsoft Data Access Component) 2.6 SP1 ■ 

■ 

■ 

JET40 SP3 

MXML3 

Starting Wizcon for Windows and Internet 

To start Wizcon, click on the Start button on your desktop, point to 
Programs, to WizFactory and then to Wizcon. Click on Wizcon to open 
the Studio. 

Or, 

Double-click on the shortcut to Wizcon icon  on your desktop. 

➤ To create a shortcut to your Wizcon application (without going 
through the Project Wizard): 

1. Right-click on your desktop, and select New from the popup menu. 

2. Select Shortcut from the popup menu. The Create Shortcut dialog 
box is displayed. 

3. Type the location and name of your application (*.wz7) or search for 
the application by clicking on the Browse button. 

4. Press Next and select a name for the shortcut. 

5. Press Finish to complete the operation. 
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Chapter 4    
Getting Started 

 About this chapter: 

This chapter describes how to open Wizcon and also suggests a 
workflow for building a Wizcon application. 
Accessing Wizcon page 4-2 describes how to open Wizcon and the 
Wizcon Application Studio and also describes the Quick Access bar. 

User Login page 4-5, describes how to log in to Wizcon. 

Designing an Application page 4-11, describes what to do before you 
begin designing an application, as well as typical application 
requirements. 

Wizcon Workflow page 4-15, describes a typical workflow for 
application design. 

Shutting Down page 4-24, describes how to logout of the system and 
how exit Wizcon. 
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Accessing Wizcon 

You can access Wizcon and all its working components in two steps: 

1. Opening Wizcon (see below). 

2. Opening the Wizcon Application Studio that holds all the 
components you need to design as application. 

➤ To open Wizcon  

Click on Start and point to Programs. Point to WizFactory, and then to 
Wizcon and select Wizcon from the popup menu. The Wizcon Getting 
Started Wizard is displayed. This wizard enables you to open 
applications from the Wizcon Application Studio.   
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The Wizcon Getting Started window has three tabs: 

New – creates a new application or opens a template application ■ 

■ 

■ 

Existing – searches and opens an existing application 

Recent – lists recently used applications 

Note: For further details on the Wizcon Wizard see the Building a 
Project chapter. 

After you select and open your application the Quick Access Bar (see 
page 4-3) appears on your screen.   

 

Click the Wizcon Application Studio  icon in the Quick Access bar to 
access the Wizcon Application Studio.   

Quick Access Bar 

The Quick Access bar enables you to: 

Login and out of the system  ■ 

■ 

■ 

■ 

■ 

■ 

■ 

■ 

■ 

■ 

Open the Wizcon Application Studio  

Load and capture a layout  

Load an image, the Events Summary, chart and a history viewer  

Load and save recipes 

Open multiple or single tag dialog boxes. 

Open WizPLC Development and WizPLC runtime applications  

Open the Advanced Alarm Management (AAM) module  

Define new users/groups and open the Users Timetable functionality  

Exit Wizcon   

Getting Started  4-3 



Quick Access Bar Icons 

Icon Command 

 
Show Studio 

 
Load Layout  

 
Capture Layout  

 
Load Image  

 
Load Events Summary  

 
Load Chart 

 
Load History Viewer 

 
Load Recipe 

 
Save Recipe  

 
Multiple Tags  

 
Single Tag  

 
WizPLC Development  

 
WizPLC Run-time 

 
Advanced Alarm Management    

 
Users Timetable  
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Icon Command 

 
User/Groups 

 
Login to Wizcon 

 
Logout of Wizcon 

 
Exit Wizcon 

User Login 

Local User Login 

To login to Wizcon locally, click the  Login icon on the Quick 
Access Bar.  The Wizcon User Login dialog box will open on your 
screen. 

 

If you know your user name and password type them in the relevant 
fields and click OK. 
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Notes: 

1.  A default login name and password can be defined by the System 
Integrator and used by all users to login to the system. 

2.  A user can also be a member of a group or team.  In which case the 
group/team login name and password are used. 

Remote User Login 

Wizcon enables remote users to log in to Wizcon and access Wizcon 
options in much the same way as local Wizcon users.  

A remote user can access the same group-assigned options available 
when logged in as a local user. The definitions behind these options are 
stored on the server, enabling remote users to access their application 
from any computer.  

The Wizcon login option has the added flexibility of being enabled or 
disabled. Users can then either: 

■ 

■ 

Login using their user name and password and access their 
group-assigned options 

Or, 

Login using a default user name and password and access the 
options specified for default users  

Login/Logout Quick Access Bar 

Wizcon provides the Login/Logout Quick Access bar to enable you to 
quickly login and out of the Wizcon system. The Quick Access bar 
appears when the browser is opened. 



 

Wizcon enables you to replace the Login/Logout Quick Access bar, and 
design your own login/logout interface using HTML script. Wizcon’s 
remote user options will still run in the background. 

➤ To login: 

1. Start Wizcon and access your Web application. The browser is 
launched.  

  
 A typical browser will display the Wizcon icon which you can click 

to begin login. You can also click Login on the Login/Logout Quick 
Access bar displayed in the top left corner of the window to open the 
Wizcon User Login.   
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2. If you know your user name and password type them in the relevant 

fields and click OK. 

A user can also be a member of a group or team.  In which case the 
group/team login name and password are used. 

➤ To logout: 

Click the Logout button on the Login/Logout Quick Access bar, or close 
your browser. 

Specifying Remote User Login Parameters 

You can specify the following remote user login parameters:  

Enable only authorized users remote access. ■ 

■ Enable all users remote access by allowing them to login in as a 
default user. This way any user can login and access the options 
specified for default users. 
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➤ To specify remote user login parameters: 

1. In the All Containers list, right-click HTML and select Properties 
from the popup menu. The HTML Properties dialog box is 
displayed.  

2. Select the Users tab. The following dialog box is displayed: You can 
select all or no options. 

  
  

3. Selecting Enable Login Quick Access Bar in Browser defines that a 
user must enter a user name and password to login.  

4. Selecting Automatically Login with Default User enables any user to 
login with a default user name and password. This means that any 
user can access the application and use the options that are assigned 
to default users. 

5. Click OK to save your options and close the dialog box. 
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Customizing the Login/Logout Procedure  

Wizcon enables experienced HTML users to customize the login/logout 
procedure on their computers by creating buttons in HTML and 
attaching HTML script, as follows: 

HTML Script Action 
scriptLoginUser () Displays the Wizcon Login user 

dialog box used to login to the 
system. 

scriptLogoutUser() Logout. 
scriptGetCurrentUserName() Displays the currently logged in user. 

After customizing the login/logout procedure, deselect the remote user 
login parameters described on the previous page, so that the 
Login/Logout Quick Access bar is replaced by your own login interface.  

Note: Wizcon’s remote system mechanisms will continue to run in the 
background. 
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Designing an Application 

A carefully designed application enables a user to easily and efficiently 
supervise an on-going process.  

Before Designing Your Application 

Before you start designing your application, you need to know some 
basic, but necessary details about the process for which you are creating 
the application:  

■ 

■ 

■ 

■ 

■ 

■ 

■ 

Obtain a list of variables that Wizcon will read and write from and to 
a PLC (I/O list or Tag list). 

Look at the control drawings to study the design and use of certain 
equipment. 

Look at the plant drawings to examine the layout of the plant for 
which you are designing the system. 

Find out the type of reports users and managers wish to receive, in 
what format and in which fields.  

Find out the type of network you have, if it uses the NetBIOS or 
TCP/IP protocol, and the name of your network station.  

Determine any authorization definitions. 

Determine PLC definitions, such as blocks and addresses. 

Once you have this background information, you can build an 
application that fully uses the resources of the plant’s equipment. 
Remember that if you are not aware of the limitations of the equipment, 
you may cause damage. 

If you are creating an application for a networking environment, refer to 
the Wizcon Network chapter before you start designing the application.  
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Designing Multiple Applications 

If you are designing multiple applications, you need to decide where 
to store your history files this could be on the local disk or on the 
server. 

Using Wizcon network tags, the same application can run on many 
stations. The application can be designed on one station and copied to 
another station. The only difference will be the station name definition 
(and number).  

Note: The tag, alarm and communication driver definitions should not 
be copied. 

Tip: It is recommended to define the station name and number before 
you begin to build your application (Images, Charts and so on). 

Typical Application Requirements 

A successful Wizcon application takes into account the following:  

Consistent Display Design 

Process visualization accurately represents an on-going plant process, 
enabling a user to clearly understand the process status at any given time. 

It is recommended that displays in the visualization remain consistent 
throughout the application. For example, if a tank’s fill status is 
represented in percentage form, then all fill status should be represented 
in percentages.  
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Alarm Design 

Alarms represent one of the most significant occurrences in a process. It 
is important to design alarms with different severity levels, zones and 
characteristics. This way, a user will recognize each alarm and react 
quickly and correctly. It is important to mark all alarms that are not 
targeted to an Events Summary with an Auto Ack attribute so that they 
will not have to be acknowledged by the operator.   

Chart Design 

Charts visually represent the process progress. When designing charts, 
you should take into account user requirements. For example, if a user 
needs to compare two tags to perform a certain task, it is recommended 
to include both tags on the same chart. Up to 16 tags may be represented 
on a single chart. 

Tag Naming Conventions 

Make sure that the name you assign to each tag clearly indicates what the 
tag represents. For example, all the tags that represent Flow Transmitters 
may be called FTxxx. This naming method is also convenient when 
adding a list of tags that are of the same type. 

It is also recommended to name the stations in a predetermined manner. 
For example, according to plant area. 



4-14  Wizcon for Windows and Internet User's Guide 

Logic 

You can use Wizcon Language to create an application that can enhance 
the capabilities of control equipment working with Wizcon such as 
PLCs, and establish the connectivity interface between Wizcon and 
external computer applications.   

Wizcon enables you to define compound tags. A compound tag is a 
linear calculation based on values of other tags.   

Wizcon scripting language can also be used to implement logic. In 
addition to providing connectivity to SQL databases, WizSQL has 
powerful language functions and its event driven architecture provides 
excellent performance. 



Wizcon Workflow 

This section describes the workflow for building an application. 
 

Step 4:

Step 5:

Step 6:

Step 8:

Step 7:

Step 1: 

Step 2: 

Step 3:

Building a Project, the 
Wizard & Station Properties

Defining Communication 
Drivers and Blocks 

Defining User Management 

Defining Tags and Alarms 

Building the Application Image 

Defining Logic 

Testing the Application 

Defining Charts, Reports and 
Recipes 

Fine Tuning 
Step 9: 

The order of these 
steps can be reversed 
using Wizcon cluster 
technology 
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You can merge steps 3 and 4 into one, and complete the step in four 
stages:  

■ 

■ 

■ 

■ 

■ 

■ 

■ 

Define some of the tags. 

Build part of the image. 

Complete the image. 

Define the remaining tags. 

Tip: If you are building a network application, you should define a 
network name and number before you begin the workflow. Remember to 
restart Wizcon. 

Step 1: Building a Project, the Wizard and Station Properties 

The Getting Started Wizard enables you to create projects either using a 
template or blank application.  The Wizard has three tabs: 

New – for building new projects either as a blank application or a 
template application  

Existing – listing all projects created in Wizcon 

Recent – listing the most recently used projects 

Note: For further details on the Wizcon Wizard see the Building a 
Project chapter. 

A new project file is saved with the suffix *.Wz7.  When the Wizcon 
Application Studio opens on your screen the name of the project appears 
at the route of the All Containers pane.   
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After the project is saved, Station Properties, which enable your to adjust 
system parameters to optimize your Wizcon working environment can be 
defined.   

➤ To open the Station Properties dialog box 

In the All Containers pane right clicking the project name and select 
Station Properties from the popup menu.   

The Station Properties dialog box has the following tabs: 

■ 

■ 

■ 

■ 

■ 

■ 

■ 

General – used to customize the application workplace 

Default User – defines the default user name and password 

Date Format – defines date style and separator used 

VFI – defines history files format by selecting Virtual File Interface 
DLL  

Audit Trail – used to log operator actions to a database via an ODBC 
data source  

ODBC Connectivity – enables Wizcon historial data to be saved to 
various databases through Microsoft ODBC  

Advanced Alarm Management – a multi service communication 
platform providing alarm transmission over various channels 

Note: For further details on Station Properties see the Building a Project 
chapter. 
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Step 2: Defining Communication Drivers and Blocks 

Blocks are defined logically to maximize the efficiency of Wizcon. This 
is done by defining blocks according to common sampling rates and 
consecutive addresses in the PLC.  

After defining communication drivers and blocks restart Wizcon for the 
changes to take effect. 

When defining blocks, avoid: 

■ 

■ 

■ 

■ 

Leaving gaps of more than 20 addresses within the block. 

Defining blocks with a sampling rate that is different from the 
individual tag sampling rate. 

Defining the same tags in more than one block. 

Defining large blocks. 

Note: For further details on Communication Blocks see the 
Communication Blocks chapter. 

Step 3: Defining User Groups 

Defining user groups is important at this stage because each subsequent 
design level may call for user authorization. Once you define the user 
groups, you can add individual users at any time to any group.  

Defining user groups later on in the design process is possible, but not 
recommended. For example, in a car production plant, engineers, 
managers and floor workers have different levels of authorization. If you 
assign authorization rights early in the design process, you will save 
valuable time in later stages of the design. 

Note: For further details on Defining User Groups see the User 
Management section of the Security, Authorization and User 
Management chapter. 
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Step 4: Defining Tags and Alarms 

Defining Tags 

Tags are I/O points that are mapped from PLCs to Wizcon as well as to 
internal (dummy) and calculated (compound) variables. You can use tags 
in images, charts, alarms and all Wizcon functions.  

When defining tags, make sure that tag and block sample rates do not 
conflict with each other. 

 Note: For further details on Tags see the Tags chapter. 

Defining Alarms 

Once you define the tags, continue by defining the alarms. Alarms notify 
a user of an event in the process. They can: 

■ 

■ 

■ 

■ 

■ 

■ 

Indicate the beginning of a process.  

Warn of a failure in part of the process.  

When defining alarms it is possible to: 

Set different severity levels to control grouping and display of the 
alarms. 

Target serious alarms to a pop-up window, ensuring that users will 
not perform any Wizcon function before clearing the alarm. This is 
recommended. 

Group alarms in families. 

Assign an alarm to an object in an image. This object will then 
change its graphical attributes whenever the alarm conditions are 
met. 
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■ 

■ 

■ 

■ 

■ 

■ 

Assign a Help file to each alarm so the user will know what to do 
when an alarm begins. 

Note:  For further details on Alarms see the Alarms chapter. 

Step 5: Building the Application Image 

The Image is a graphical representation of the application process and 
represents the feedback that the user receives from the plant. The image 
is the main part of the application that a user views. Therefore, it should 
be informative, yet easy to understand. 

When designing images, take advantage of the following features: 

The Image Editor that features many different toolboxes to enable 
you to build your application. 

Zones, different areas of the image that can be viewed in close up. 
Each zone can represent a different part of a plant process. 

Layers that can be compared to transparent sheets with the same 
coordinates, which lay on top of each other. You can enable group 
access to certain layers and thereby control sensitive information.  

Cluster libraries that use object-oriented technology to simplify and 
speed up application design and maintenance. A cluster is an object 
with pre-defined behavior patterns and can be linked to existing tags 
and alarms, or can be used to automatically create new tags and 
alarms. 

The Image Editor that features many different toolboxes to enable 
you to build your application. 

Note: For further details on Images see the Introduction to the Image 
Module and Image Editor chapters. 

  



Getting Started  4-21 

Step 6: Defining Language 

Language commands are used to make logic calculations that the PLC 
cannot perform. Wizcon Language is written and implemented according 
to If, Then conditions. For example: 

IF: @FLAG =1 

THEN: REPORT “Shift” 

Some examples of Language commands include: 

■ 

■ 

■ 

■ 

Starting and stopping a process. 

Loading a recipe. 

Writing to a tag value based on another tag value. 

Writing to a file or printer. 

Note: For further details on Language see the Wizcon Language 
chapter. 

 

Step 7: Testing the Application 

At this stage of the design process, it is recommended that you test your 
application to check your image, alarm, tag and block definitions. 

After completing the test and implementing the necessary changes, you 
can continue to define your reports, charts, recipes and fine tune the 
application. 
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Step 8: Defining Charts, Reports and Recipes 

Defining Charts 

Charts provide graphical views of past and current tag values. You can 
use charts to follow a trend or compare values. You can define up to 16 
tags on a single chart.  

When defining a chart, it is possible to: 

■ 

■ 

■ 

■ 

■ 

■ 

■ 

Define a unique color to each chart that is also used by the scales of 
the chart.  

Determine that charts show online or historical activities. 

Defining Reports 

You can define reports for different users such as: operators, engineers, 
and managers. Make sure that each report includes the required 
information for the designated user.  

Reports can be: 

Triggered in the Language. 

Written to a file. 

Sent directly to the printer. 

When designing reports, it is possible to: 

Place fields in different positions and include any text, such as a 
header or short explanation at the end of the report. The fields can 
represent runtime values and a number of calculations performed on 
the historical tag values, such as averages, integrals, sums and more. 

Choose the range calculation, such as start day, start time, end day 
and end time.  
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■ 

■ 

■ 

■ 

■ 

■ 

■ 

■ 

■ 

Define compound fields that are based on two other fields according 
to a specific formula. Multiple fields allow you to receive a value 
based on a group of other fields. 

Defining Recipes 

Recipes are specified sets of tag values that you can store for future use.  

When defining recipes, remember that: 

Each recipe must belong to a model that includes tags for certain 
processes or production modes. The recipe uses the tags in the model 
to which it belongs, but can also include tags that are not defined in 
the model. 

Each model and recipe has a unique name. 

The same tag can belong to more than one recipe.  

You can save the current values of any tags at any time as a recipe. 
This means that at the end of a process, you can save its values as a 
recipe and reload the recipe when the process is resumed. 

Note: For further details read the relevant chapter. 

Step 9: Fine-Tuning the Application 

Once you have completed these steps, it is recommended to check all 
your definitions. Use the Single Tag Value and:  

Invoke Wizcon Language commands. 

Initiate dynamic behavior in an image. 

Invoke reports. 

Check alarms.  



Once you are satisfied with the results, fine-tune your entire 
application, by:  

Adding users to the user groups. ■ 

■ 

■ 

Saving layouts that can be loaded upon login. 

Setting the menus that will be displayed for the different user groups. 

Shutting Down 

This section describes how to logout of Wizcon and how to exit the 
system. 

Logout 

After initiating logout, you will not have access to the system until you 
login again. 

➤ To logout: 

Click the Logout  button in the Quick Access bar.  
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Exiting Wizcon 

You can exit Wizcon from the Quick Access bar or from the Wizcon 
Application Studio. 

➤ To exit Wizcon: 

Click the Exit  button in the Quick Access bar.  

Or, 

From the File menu in the Wizcon Application Studio, select Exit 
Wizcon. 
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Chapter 5   
Getting to Know the 
Application Studio 

 About this chapter: 
This chapter describes the Wizcon Application Studio, which is the 
operational framework of Wizcon for Windows and Internet. 
Overview, page 5-2, describes how to open and exit the Wizcon 
Application Studio.  The components of the Wizcon Application Studio 
interface are also discussed. 
Containers page 5-13 describes the various Wizcon application 
container icons. 
Defining System Options page 5-25 discusses WizPro options and 
how to modify the default Wizcon file path. 

Defining Multi-language Support page 5-30 describes how to define 
multi-language support in an application. 
Layouts page 5-35 describes how to capture and save layouts and how 
to assign them to users 
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Overview 

The Wizcon Application Studio is opened from the Quick Access bar 
that is displayed when Wizcon is accessed.  The Application Studio has 
an explorer-like interface and offers full control and access to all parts of 
the system during application development.  

Instructions for accessing and opening the Wizcon application appear in 
the Getting Started and Building a Project chapters.  The Wizcon 
interface has two panes: 

All Containers ■ 

■ Control Panel  

 
The Wizcon Application Studio window also contains: 

A menu bar through which you can access Wizcon for Windows and 
Internet operational menus.   

■ 

■ A toolbar that enables quick access to the Wizcon Application 
Studio most frequently used functions.   

5-2  Wizcon for Windows and Internet User's Guide 



Toolbar 

Icon Definition 

 Open application  

 
Save application 

 
Add Tag 

 Add Alarm Definition 

 New HTML file  

 New Events Summary Profile  

 New Trend Profile  

 New Layout 

 New Image 

 
New Events Summary  

 New Chart  

 New History Viewer  

 New Recipe  

 
New Report  

 
Help 
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All Containers Section 

The All Containers pane displays a hierarchical structure (tree) of the 
containers from which a Wizcon application is built. Containers can be 
thought of as the building blocks of a Wizcon application. The tree is 
made up of four main folders of containers with the current application 
as its root. 

■ 

■ 

■ 

■ 

User Management lists all the users and groups defined in a project.  
This module also defines the user’s access permission and level.  
Access can be given per user, group and team.  Backup users can 
also be defined. User Management also enables the System 
Integrator to create a user timetable and schedule workplans. 

Web Application contains the elements that are used to publish an 
application, such as HTML pages for the Image and the Events 
Summary Profile, and the Trend Profiles. 

Files contain the Wizcon elements that are stored as files, such as: 
Images, Events Summaries, Charts, History Viewer, Model Recipes, 
Layouts and Reports. 

Objects holding the elements that are stored as objects, such as: 
Tags and Alarms. 

Right clicking on any of the containers opens a popup menu that displays 
related options. For example, right-clicking on Alarms displays a popup 
menu with the following options: Add Alarm, Add Level, Modify Level, 
Import Alarms, Export Alarms and Properties. 



When a container is selected in the All Containers section on the left, a 
list of its contents is displayed in the List Zone on the right. For example 
when Alarms is selected in the All Containers list, a list of all the alarms 
in the application is displayed in the List of Alarms, as shown below. 

 
All lists, for example the List of Alarms shown above, share the 
following common features: 

Right clicking anywhere in the list displays a popup menu with 
context sensitive options.  

■ 

■ Clicking on a column header sorts the list within the column. The 
information for each list is displayed under columns that are relevant 
to the list. For example, the List of Alarms displays the following 
columns: Tag Name, Condition, Text, Family, Zone and Severity. 
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■ A list can be duplicated in a separate window by right clicking in the 
list window, pointing to View and selecting Duplicate from the 
popup menu. A list can be duplicated only once. For example, the 
List of Alarms as shown below: 

  
A list can be customized by right-clicking in the list window, 
pointing to View and selecting Settings from the popup menu. A 
dialog box is displayed in which you can set the order and the type 
of fields to be displayed in the List Zone.  

■ 



For example, the List of Alarms dialog box, as shown below:  

 
To specify the columns to be displayed in the List of Alarms, click 
the checkbox next to a column name to select it. The following 
columns are available: 
Alarm Expression 
Text 
Family 
Zone 
Severity 
You can determine the order by which the columns appear in the 
Wizcon Application Studio by selecting a column and activating the 
Move Up or Move Down buttons. 
You can select all the columns by activating the Select All button, 
and deselect them by activating the Deselect All button. Clicking the 
Default button selects all the columns. 
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The Control Panel 

The Control Panel, on the right of the Wizcon Application Studio, is 
displayed when the root of the tree (the current application) is selected. 
For example, when the application called wizapplication (the default 
name Wizcon for Windows and Internet gives to new applications) is 
selected and the Control Panel opens, the icons representing the 
following elements of Wizcon for Windows and Internet are displayed. 
Icon Definition 

 
Communication Drivers  

 
Printers   

 
Multiple Tags 

 
Single Tag 

 

DDE Blocks 

 
Application Setup 

 
Macros   

 
Wiscon Network 

 
Wizcon Language  

 

WizPLC Development  

 

WizPLC Run-time 
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Icon  Definition  

 

Alarm Files  

 

Printer Targets  

 

Zone Navigator 

 
AAM Channels 

 

AAM Pager Services   

Menu Options 

The following menu options are available in the Wizcon Application Studio. 

Menu  Option Action  
File New Open a new file  
 Open Open an existing Image  
 New Application Display the New Application Wizard 
 Open Application Open an existing application 
 Save Save the current project  
 Save As  Save the current project with a specific name 

and location  
 Exit Wizcon Exit Wizcon for Windows and Internet  
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Menu  Option Action  
View Toolbar Display (or hide) the toolbar  
 Status bar Display (or hide) the status bar  
 Disable non-Web 

Features 
Disable non-Web features in the Image  

 Window System 
Menu 

Display (or hide) the icon in the top left corner 
of the image window. This overwrites the 
System menu property of the image window 
attribute  

Design Add Object Add a new tag or add a new alarm 
 Communication 

Drivers 
View the drivers defined for the application, 
add a new driver, remove a driver, and define 
driver properties 

 Macros Define macros 
 DDE Blocks View the DDE blocks defined for the 

application, add a new block, delete a block and 
define block properties 

 Application Setup  Set up additional add-ons and programs to run 
while starting Wizcon 

 PopUp Settings Design a Popup Events Summary that appears 
on the screen to inform the operator of severe 
alarms. The Pop-up Buzz option is used to add 
sound to defined alarms  

 Class Names Assign class names to alarms 
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Menu  Option Action  
 Alarm Filter This option contains a list of all the alarm filters 

defined in the project 
 Printer Targets A combination of alarm filters and printers.  

When an alarm is issued it is channeled through 
the alarm filters according to predefined 
parameters and sent to the printer targeted for 
it. 

 Zone Navigators The Zone Navigator is a global, multi-image 
zone navigation window that enables you to 
quickly and efficiently navigate through a list 
of zones defined in your application's various 
image files. 

 Wizcon Language Define Wizcon language procedures 
 Options Configure application options such as WizPro, 

Paths and Printers 
 Authorization Configure operator access authorization 
 Advanced Alarm 

Management 
(AAM) 

There are two sub-menu options: 
AAM channels – enabling definition and 
configuration of the communication lines used 
by AAM. 
AAM pager services – displays a list of all the 
installed drivers (drivers can be added).  The 
parameters of each driver can be configured  
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Menu  Option Action  
Network Local Station 

Configuration  
Configure your computer as a SCADA or 
SCADA View station, a Hot Backup Station, or 
a Management View Station 

 Record Remote 
Data 

Record remote tags and alarms 

 Network 
Properties 

Set your network environment and establish 
Wizcon application performance 

Tools Single Tag Assign an immediate value to a tag. This is 
useful for testing tag performance 

 Multiple Tags Define multiple tags to optimize performance 
 Import Import a list of tags or a list of alarms 
 Export Export a list of tags or a list of alarms 
 Find Search for already existing tabs and alarms  
 MultiLanguage 

Support 
Define Language Support 

 WizPLC This menu option is used to run the WizPLC 
program while Wizcon is running.  There are 
two modes; Development (for developers using 
the application) and Run-time   

 Advanced Alarm 
Viewer 

Displays the number of alarms that have 
already been or that are being processed and 
how they are processed by AAM 

Help Help Topics Display Help topics  
 Tip of the Day  Display the Tip of the Day dialog box 
 About studio  Display information about the Wizcon 

Application Studio  
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Containers 

Authorization  
In Wizcon, operator access can be limited to professional level and skill. 
This powerful feature enables the system engineer to control access to 
the Wizcon system.  
Authorization in Wizcon for Windows and Internet refers to the ability to 
limit operator access to system facilities. This powerful feature enables 
the system engineer to control access to the various Wizcon for 
Windows and Internet components and modules, such as menu items, 
tags, macros, and graphical objects. 
 
The components to which access can be limited include: 
■ 

■ 

■ 

■ 

Menus and menu items 
Tag value writing 
Macro activation 
Graphic element layers in images 

System authorization is assigned according to users, groups and teams. 
An unlimited number of groups can be defined in the system, each with 
its own unique name. Each operator can be assigned to one or more 
groups. For example, once a group is assigned to a tag, any operator that 
belongs to the group can perform tag value operations on the tag. 
Operators not assigned to a group matching any of the tag groups will 
not be able to set new tag values. 

Note:  User Management defines users and their passwords and also 
assigns users to groups or teams. The name of the currently logged-in 
operator is displayed in the title bar of the Quick Access bar. 

For further details read the User Management chapter. 
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Communication Drivers 

Communication drivers handle communications with external devices, 
such as PLCs, industrial instruments, remote computers and field buses. 
These drivers are separate program files, which are installed when 
installing Wizcon. Communication driver file names have the format 
VPIWN??.DLL , in which ?? is the two or three-letter code of the 
driver. Since each communication driver is different, the driver 
information documentation should be consulted for specific 
communication driver details. 

You can define communication blocks to improve driver performance 
when working with large quantities of tags. These blocks enable you to 
transfer large blocks of information instead of individual data items.   

The first step in designing a Wizcon application is to define the 
communication drivers and blocks. You then define the tags, which are 
control values monitored by the system. They are used as internal 
variables for: 

■ 

■ 

Calculations and display. 

Communication with PLC’s in order to represent data from PLC 
memory or to send commands to PLC’s.  

Note: In fast Pentium PCs with a 16550 UART (serial interface chip), 
Windows 95 or 98 or 2000 default settings may cause communication 
errors on serial communication drivers. To overcome this problem, 
lower the buffer sizes on the UART in the following menu: 
 Start  Settings  Control Panel  System  Device Manager  
Ports  Communication Port 1.4  Port Settings  Advanced. 
Use a trial and error method to reach the optimum setting. 

For further details read the Communication Drivers Chapter. 
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Printers 

The Printers dialog box enables enhanced printing capabilities.  Each 
printer added to a system can be set to print reports, alarms or both.  In 
addition a definition can be made where many alarms are printed on a 
full page or whether only one alarm is printed on each page.  Page 
orientation and font can also be defined. Alarm properties that are 
printed can also be set together with different colors, text and 
background. 

For further details read the Alarm Filters, Printers and Printer Targets 
chapter. 

Multiple Tags 

The Wizcon Multiple Tags feature can be used to optimize performance 
and enhance functionality. This utility enables you to adjust system 
parameters and establish the correct environment for working with the 
Wizcon application. 

Multiple Tags display tag lists which enable you to read and write tag 
values, as well as change several tag attributes. In addition, Multiple 
Tags provides options to save the tag list as a recipe or a tag list file.  

Tag list files are ASCII files that contain lists of tags and their attributes. 
These files have the extension .GLS and can be used in Wizcon to 
generate tag lists in the tag definition procedure. 

For further details read the Multiple Tags chapter. 

Single Tags 

The Single Tag dialog box is used to assign an immediate value to a 
specific tag.  

In the Single Tag dialog box parameters such as the Station Name, Tag 
Name, Description, Current Value, New Value and Suggested Value 
slider are used to simulate the tag’s value. 

For further details refer to the Tags chapter. 
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DDE Blocks 

The WizDDE Client Block enables Wizcon to receive many tag values 
from the server in one update message. This improves the 
communication between Wizcon and the DDE server. The WizDDE 
Client Block is built from a matrix of rows and columns in which each 
cell of the matrix contains the value of one data item. 

Note: Not all programs support block message. Check the 
documentation of the DDE server application. 

A common use for DDE client blocks is a setup in which a DDE server 
simultaneously updates a block of items that make up a recipe. Wizcon, 
the client, receives all the items, and the tag values are changed 
immediatley.  

Define DDE client blocks only if data items in the server change 
simultaneously (within milliseconds). Wizcon receives the whole block 
of data whenever one of the items in the block changes. Therefore, if 
items change one at a time, Wizcon will receive a whole block of values, 
many of which have not changed. 

For further details refer to the Wizcon DDE Support chapter. 

Macros 

Macros are shortcuts that can be used to execute pre-defined actions, 
commands, or programs whenever designated keys or key combinations 
are activated. This enhances overall Wizcon functionalityand saves you 
the time and effort of having to execute Wizcon operations in several 
stages. 
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You can define up to 1024 Wizcon macros.  Wizcon macros are defined 
by the following attributes: 

■ 

■ 

■ 

■ 

■ 

■ 

■ 

■ 

■ 

Accelerator keys that invoke the macros (F1 to F12, A to Z, ALT 
alone, or in combination with Ctrl, Shift, and others) 

A unique name and description  

Authorization groups  

Confirm before Execute option  

 

Wizcon macros include the following types: 

Actions 

Commands 

Programs 

DDE Command Macros 

Trigger Macros (described in the Trigger Objects section of the 
Image Editor) 

Note:  Macros will only be executed when: 

1. A Wizcon window, including the Wizcon Application Studio, or the 
Single Tag Input dialog box is the active window. If any other 
window is active (for example, an application other than Wizcon or 
a different Wizcon dialog box where you invoke a macro) the macro 
will not be executed. 

2. If Wizcon is used locally (for example, if a trigger macros is invoked 
through a web browser) it will not be executed.  



Wizcon Network 

Wizcon stations operating in a network environment can share objects, 
such as alarms and tags. Direct access to remote tags and alarms can be 
implemented through a simple station definition procedure. Once the 
station is defined to support Wizcon network activities, any operation 
involving tags and alarms on a local station can include remote tags and 
alarms as well. 

The Wizcon network system operates in a manner similar to other 
network systems. WizPro, the Wizcon kernel, handles all network 
operations and transfers data from/to local and remote Wizcon stations.  

Wizcon supports various network components, including Novell 
Requester, LAN Server and TCP/IP. 

Installation in a TCP/IP environment enables Wizcon stations on one 
network to communicate with Wizcon stations on other networks. 
Through TCP/IP, the Wizcon Network offers a complete enterprise-wide 
solution. 

For further details refer to the Wizcon Network chapter. 

Wizcon Language 

Web-disabled

 

Wizcon Language is a simple but powerful tool used to create programs 
that can enhance the capabilities of control equipment working with 
Wizcon, such as PLCs, and establish the connectivity interface between 
Wizcon and external computer applications. 

Note:   Wizcon Language runs on your local PC, it is not supported on 
the Web. 
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WizPLC Development and Runtime 

WizPLC enables you to write control logic programming.  There are two 
modes: 

■ 

■ 

Development which is a programming, monitoring and debugging 
tool, integrated with the Wizcon SCADA system and enables project 
management 

Runtime that runs compiled code on a Windows NT real-time 
processor.  It communicates with I/Os and exchanges data with 
Wizcon and WizPLC Development. 

For further details refer to the WizPLC manual. 

  Alarm Filters 

The Alarm Filter functionality filters alarms and reports before they are 
printed out or written to the Events Summary.  Alarm filters are 
displayed in the Alarm Filters table and defined or modified in the Filter 
Properties dialog box.  Filter properties can be updated, however the 
name of a filter cannot be changed.  

The Alarm Filter filters the alarms sent when parameters defined in tag 
variants are not met.   

When alarms and reports outside the defined categories have been 
filtered out by the Alarms Filter, the remaining alarms are sent to 
Printers defined in the Printer Targets module (if the filter belongs to the 
target).  

For further details refer to the Alarm Filters, Printers and Printer Targets 
chapter. 
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Printer Targets 

A Printer Target is a combination of alarm filters and printers.  When an 
alarm is issued it is filtered according to predefined parameters and sent 
to the printer targeted for it. 

The Printer Target dialog box holds a list of all the printer targets that 
have been defined.  Each printer target is identified by a unique name 
and description.   

For further details refer to the Alarm Filters, Printers and Printer Targets 
chapter. 

Zone Navigator 

The Zone Navigator is a global, multi-image zone navigation window 
that enables you to quickly and efficiently navigate through a list of 
zones defined in the application's various image files. A number of 
navigators each of which can contain a number of zones from one or 
more different image files can be defined in the Zone Navigator module. 

For further details refer to the Image Editor chapter. 

AAM Channels  

Advanced Alarm Management communication lines (TAPI modem or 
modem connected to COM port) are defined in the Channels dialog box 
where channels can be added, removed, deactivated or be modified. 

 The following configurations are available: 

■ 

■ 

■ 

Channels Setup (Tapi modem or modem connected to COM port). 

Pager Services Setup. 

Vocal Server Setup. 

During runtime the real time Advanced Alarm Viewer shows statistics 
and an Events Summary. 

For further details refer to the Advanced Alarms Management chapter. 



AAM Pager 

The AAM Pager Services module enables definition of a list of paging 
drivers and Call Management parameters.  New drivers can be added, 
existing drivers removed and driver setup can be configured. 

For further details refer to the Advanced Alarms Management chapter. 

Application Setup 

The Application Setup dialog box enables you to set up or modify the 
additional add-ons and programs you wish to run when starting Wizcon. 
This section describes the following: 

Opening the application setup dialog box ■ 

■ 

■ 

Setting up the program you wish to run while starting Wizcon 
Selecting a setting environment for a Wizcon application 

 

➤ To open the Application Setup dialog box: 

In the Control panel of the Wizcon Application Studio, double-click the 

 icon. 

Or,  

From the Design menu, select Application Setup. The Application Setup 
dialog box is displayed.  
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The following options are available: 
Add Sets up the additional program you wish to run 

while starting Wizcon.   
Properties Displays the properties of the selected program.  
Remove Removes the selected program from the list of 

programs.  
Move Up Moves a program up one line in the list of programs.  
Move Down Moves a program down one line in the list of 

programs.  
Advanced Determines a setting environment for a Wizcon 

application. 

Note: When adding a list of programs, write the list in the order that you 
want them to run. Do not place a program that should run before the 
Wizcon interface following a program that should run after the Wizcon 
interface. 
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➤ To setup a program you wish to run while starting: 

Click the Add button in the Application Setup dialog box. The Programs 
Specification dialog box is displayed:  

 
The following options are available: 

Program to Run  Specifies the full path of the program. Click the 
Browse button to access the DDE server and client 
settings (Bin/WizDDEs/c.exe). 

Parameters  Specifies the program parameters, if there are any. 

Open a Window Opens the program in a window. The following 
window styles are available:  
Default: Opens the window in a default size. 
Minimize: Opens the window minimized. 
Maximize: Opens the window maximized. 
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Start the Program before User Login 

Specifies whether to run the user program before or 
after user login.  

Wait for the program to end before running the next program 

Specifies whether to wait until the current program will 
end before running the next program. 

➤ To select the setting environment for a Wizcon application: 

Click the Advanced button in the Application Setup dialog box. The 
Advanced Settings dialog box is displayed:  

 
The following options are available: 

Run Wizcon Language Specifies that the default Wizcon Language 
runs. 

Run WizPLC Runtime Specifies that WizPLC runs. 

Select Application Browse to select an application. 
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Defining System Options 

This section describes how to:  

Define WizPro options, as described below. ■ 

■ Change the default Wizcon file paths  

Note: Changes to WizPro Paths and Printers options are implemented 
online.  

WizPro Options 

WizPro is the Wizcon programming interface kernel. It provides 
mechanisms through which PLC and external device communication can 
be implemented, maintains an on-line database, and services all inter-
process requests and messages. 

➤ To set WizPro options: 

From the Design menu, point to Options and select WizPro from the 
popup menu. The Set WizPro Options dialog box is displayed: 
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The following options are available: 

Tag Sampling Enables the WizPro tag sampling mechanism. 
Tags are sampled according to the rate defined 
for the tag in the Analog Tag Definition dialog 
or the Digital Tag Definition dialog box as 
described in the Defining Tags section in the 
Tags chapter. Tag sampling will not occur if 
this option is deselected.  

Write to HIS File Enables the recording mechanism to record 
sampled tags in historical files. Historical 
sampling will not occur if this option is 
deselected. 

Alarm Module Enables WizPro to check if alarm conditions 
are true whenever tag values change. 

Collapse Alarms Enables WizPro to collapse alarms in the 
Events Summary. This means that repeated 
identical alarms will be displayed on a single 
line in the Events Summary. If this option is 
not selected, each alarm will be displayed on a 
separate line until the condition defined for 
the alarm ceases to exist. 

Compress definitions Physically removes all deleted tags and alarms 
from the Wizcon database and renumbers their 
ID numbers. When tags or alarms are removed 
from Wizcon, they are not physically deleted, 
but only marked as deleted so as not to affect 
the internal ID numbers of the remaining tags 
and alarms. Enable this option in applications 
where it is necessary for tags and alarms to 
have sequential ID numbers.  
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Notes:  

1. If the ID number of tags or alarms is changed, the data in the history 
files may not be processed. Therefore, it is strongly recommended 
that you keep a backup of the tag definition files (table tags and 
alarms in Wizdata MDB) deleting any tags from the database.  

2. If the ID number of tags is changes save the Wizcon Language 
commands again in the Wizcon Language Definition dialog box, as 
described in the Wizcon Language chapter. This is necessary so that 
the commands will correspond to the new, internal tag IDs. 

3. Deleted tags count as defined tags when Wizcon checks if the 
number of defined tags is less than the amount allowed by the 
security key.  

Changing Default File Paths 

Default paths can be defined for each file type to enable the system to 
keep track of files and their locations. 

➤ To define file paths: 

From the Design menu, point to Options and select Paths from the popup 
menu. The Set Default Paths dialog box is displayed: 



 
The dialog box displays the following Wizcon file types with their 
current path specifications: 

Application  C:\Wizfactory\Wizcon\Project\ 

Alarm History C:\Wizfactory\Wizcon\Project\ 

Alarm Help C:\Wizfactory\Wizcon\Project\ 

Tag History C:\Wizfactory\Wizcon\Project\ 

Images C:\Wizfactory\Wizcon\Project\ 

Text Tables C:\Wizfactory\Wizcon\Project\ 

Cluster lib C:\Wizfactory\Wizcon\Project\Image\ 

Recipe C:\Wizfactory\Wizcon\Project\ 
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Recipe Model C:\Wizfactory\Wizcon\Project\ 

Window definitions C:\Wizfactory\Wizcon\Project\ 

Users C:\Wizfactory\Wizcon\Project\ 

Macros C:\Wizfactory\Wizcon\Project\ 

Classes C:\Wizfactory\Wizcon\Project\ 

 

➤ To change the path of a specific file type: 

Click in the line that you want to change and specify the new path. 

A path must be specified with a terminating backslash (\). 

Note: Restart Wizcon for changes to take effect. 

Multi Language Support 

Using Multi-language support, the tag description, alarm text and the 
text field in an image can be developed in one language and translated to 
another. During runtime, a user can choose the required language.  

Support for different languages is dependent on the operating system and 
its support for that language.  Far Eastern languages, such as Japanese, 
are supported in Wizcon only in their native operating system. Latin 
languages are supported in any operating system. 

All texts for specific languages are kept in files. The size of this file is 
proportional to the size of the application. For small applications, this 
can take as much as 10 kbyte. A larger application can take as much as 
several mbytes. 
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Strings 

If you have a multi-language application with strings in two or more 
languages, it is possible that not all the strings will be present in all 
languages after import. If a string is absent in a selected language the 
missing string will appear on the screen in the following format: 
<??string ID?>

Where the string ID is a number, such as <??0000000005?>. 

Defining Multi-language Support 

This section describes how to define multi-language support in an 
application. The following steps need to be repeated for each language 
used.  

■ 

■ 

■ 

■ 

Export the language strings into a file. 

Select the language in which the application was written and import 
the file into the application. 

Open the file with a text editor, translate the language strings into the 
required language and save the file with a new name. 

Select the required language and import the translated file into the 
application. 

After you have defined multi-language support for a language, you can 
then select it to determine that the application texts will appear in that 
language. 



➤ To export a file: 

From the WizTools menu, point to Multi-language Support and select 
Export Language from the popup menu. The Export Language dialog 
box is displayed: 

 
1. In the Export to file field, enter the name of the text file you wish to 

create for the language strings. 

2. Click OK to save your definitions and close the dialog box. It is 
recommended to save the file in the same directory as your 
application. 

Note: If multi-language support has already been defined in your 
application, the last language you imported will appear in the Export 
language field.  

➤ To import the text file:  

From the WizTools menu, point to Multi-language Support and select 
Import Language from the popup menu. The Import Language dialog 
box is displayed: 

 
1. Click in the Import Language field to display a list of available 

languages. Select the language in which the application was written.  
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2. In the Import from file field, enter the name of the text file that 
contains the language string (this is the file you created in the Export 
to file field in the Export Language dialog box on the previous 
page), or click Browse to locate the file. 

3. Click OK to import the file. The following message appears: 

  
4. Click Yes to establish a link between the language and its file. 

➤ To translate the file: 

1. Open the language file using any text editor.  

2. Translate the language strings into the required language and 
save the file as a new file.  

3. Access the Explorer and remove the extension (.txt) from the 
file. 

4. Follow step 1 on the previous page to open the Import Language 
dialog box and enter the required language in the Import 
language field.  

5. In the Import from file field, enter the name of the file that 
contains the translated language strings, or click Browse and 
locate the file. 

6. Click OK to import the file. The following message is displayed: 

 
7. Click Yes. The language is now supported. 
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Selecting a Language 

After you have defined multi-language support, you can select the 
language in which you want Wizcon to display the application texts.  

➤ To set a language:  

From the WizTools menu, point to Multi-Language Support and select 
Select Language from the popup menu. The Select Language dialog box 
is displayed: 

 
1. Click in the Select the language for the application field, and select 

the required language from the list of supported languages. 

2. Click OK to save your definitions and close the dialog box. The 
language strings are now displayed in the selected language. 

 

Note: The language strings are displayed in another language only after 
refreshing the required container in the All Containers section. For 
example, to display the alarms language strings in the selected 
language, click the + sign to the left of Objects. The objects list collapses 
and the + changes to a -. Click the - sign to expand the objects list and 
then click Alarms to display the List of Alarms. The alarm text is 
displayed in the Text column of the List of Alarms in the selected 
language. 
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Loading Wizcon Files Created in Another Wizcon Application 

If you try to load (import) an image, or the wizgates.dat and alerts.dat 
file created in another application, the multilanguage support module 
may detect that the file was not created in the current application. The 
following may occur: 

If a language has not been defined for the application, the application 
will work with the default language. The multi-language support 
module will attach the loaded file to the current application. 

■ 

■ If the current application is a multi-language application with two or 
more defined application languages, the Language database selection 
dialog box is displayed: 

  
Click Browse to specify the path of the language database to be used 
with this file.  

If the selected database does not match the loaded file, the Language 
Database Selection dialog box will reappear. You can either click Ignore 
to attach the loaded file to the current language database, or click Cancel 
to prevent file loading. 
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Layouts 

Web-disabled

 
A layout is the position of an open window in an application. This 
section describes how to capture and save layouts and how to assign 
them to users.  

You can assign a layout to a user, so that when the user logs on, the 
windows included in the layout will automatically be displayed in the 
position in which they were saved.  

You can also close all the open windows in your application, as 
described below. 

Capturing layouts, assigning them to users and user log on is for local 
use only. Layouts are not used when interacting with the application 
through a browser. 

Capturing and Saving Layouts 

You can open Image, Events Summaries, History Viewers and Chart 
windows, position them on your screen and save their position.  

➤ To save a layout: 

In the All Containers section of the Wizcon Application Section, right 
click Layouts and select Capture Layout from the popup menu. A 
standard Save As dialog box is displayed in which you can save the 
layout. The layout is displayed in the List of Layouts. 
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➤ To add additional window positions to an existing layout:  

Specify the existing layout file name in the Save As dialog box. 

➤ To load a layout: 

In the List of Layouts in the Wizcon Application Studio, right click the 
required layout and select Load Layout from the popup menu.  

➤ To delete a layout: 

In the List of Layouts in the Wizcon Application Studio, right-click the 
layout you want to delete and select Delete Layout from the popup 
menu. 
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Assigning Layouts to Users 

When you have captured and saved a layout, you can assign it to a user, 
so that when the user logs in, the layout is automatically displayed on the 
screen.  A layout is assigned to a user in the User Management module. 

➤ To assign a layout to a user: 

1. In the User Management container in the All Containers pane click 
Users.  The List of Users opens in the Control Panel.   

2. Select a user and then right click and select Modify from the popup 
menu.  The User Properties: User dialog box opens. 

 
3. In the Layout field click the arrow to open a dropdown list and select 

the relevant layout.  The selected layout will be attached to the User 
and will open on the User’s station. 

Note:  Users can also be assigned a layout when defining new users and 
following the instructions above. 
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Loading a Layout 

➤ To load a layout: 

In the List of Layouts (in the Wizcon Application Studio), right-click the 
required layout and select Load Layout from the popup menu.  

Closing all Open Windows  

You can use the Close All windows feature to close all the windows 
open in your application. 

➤ To close all windows: 

In the All Containers section of the Wizcon Application Section, right 
click Layouts and select Close All windows from the popup menu. 

Saving Layouts (by Default) 

You can configure the layout property so that you are prompted to save 
the layout of any open windows before you exit Wizcon.  

➤ To save a layout by default: 

1. Right-click Layouts and select Properties from the popup menu. The 
Layouts Properties dialog box is displayed: 
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2. Select Prompt to save layout. When you exit Wizcon you are 
prompted to save the current layout. This change can be 
implemented online. 
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Chapter 6   
Building a Project 

 

  

 About this chapter: 

This chapter describes how to create a Wizcon project using the Wizcon 
Getting Started Wizard and how to define Station Properties as follows: 

Overview, on the following page, describes the first steps in creating a 
Wizcon Project. 

The Wizcon Getting Started Wizard page 6-3 describes the Wizcon 
Wizard and the steps necessary for creating a new project. 

Optimizing Application Performance page 6-10 discusses Wizcon 
Station Properties which optimize application performance and enhance 
functionality.  
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Overview 

After the Wizcon program is activated the Wizcon Getting Started 
Wizard opens on your screen.  Through the Wizard you can create new 
projects either using an application template or blank template, search 
for existing application projects or open the most recently used project. 

When a new project is created all files are copied from the NewWizAPP 
folder to your new application folder.  These are the WizUM.mdb file 
containing a user name and password (default = user.password) and the 
Wiztune.dat file.  

The Wizcon Wizard has three tabs: 

■ 

■ 

■ 

■ 

■ 

■ 

■ 

New – for building new projects either as a blank application or a 
template application  

Existing – listing all projects created in Wizcon 

Recent – listing the most recently used projects 

A new project file is saved with the suffix *.Wz7.  (This may change in 
future Wizcon versions).  When the Wizcon Application Studio opens on 
your screen, the name of the project appears at the route of the All 
Containers pane.   
After the project is saved, Station Properties, which enable you to adjust 
system parameters to optimize your Wizcon working environment can be 
defined.  The Station Properties dialog box can be opened by right 
clicking the project name. It has the following tabs: 

General – used to customize the application workplace 

Default User – defines the default user name and password 

Date Format – defines date style and separator used 

VFI – defines history files format by selecting Virtual File Interface 
DLL  
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■ 

■ 

■ 

Audit Trail – used to log operator actions to a database via an 
ODBC data source  

ODBC Connectivity – enables Wizcon historial data to be saved to 
various databases through Microsoft ODBC  

Advanced Alarm Management – a multi service communication 
platform providing alarm transmission over various channels 

The Wizcon Getting Started Wizard 

The Wizcon Getting Started Wizard enables you to open existing 
applications from the Wizcon Application Studio or to create new 
applications.   There are three tabs:  New, Existing and Recent. 

 



 

New Tab 

This tab enables you to open new applications.  There are two options 

Blank Application ■ 

■ Template Application 
 

➤ To open a blank application: 

Click the  Blank Application icon to open the Set Application dialog 
box. 

Or,  

If you have already accessed an existing project and wish to open a new 
one.  From the File menu select New Application to open the Set 
Application dialog box.   
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1. In the Folder Name field, at the end of the folder’s location, type in 
the name of your folder. Click the Create button. The new folder 
name will added to the folder location and also appear in the Folders 
list. 

2. In the Application Name field, type in the name of the application.  
The suffix *.wz7 will be added by default. 

3. Click OK to confirm.  

4. Before the new application opens the Create System Tags message 
box will open on your screen. 

5. Select either Yes or No accordingly.  The Quick Access Bar will 
open on your screen. 

6. To open the Application Studio, click the  icon.  The new 
project will appear at the root of the All Containers pane. 

Note:  If you created a folder for the application before opening Wizcon 
this will appear in the Folders list. 

 
➤ To create a template application: 

 

Click the  Template Application icon to open the Choose Template 
dialog box. 

Or 

If you have already accessed an existing project and wish to open a new 
one.  From the File menu select New Application to open the Choose 
Template dialog box.   
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1. Select the *. Wpj file of the application on which the new 

application is based, and click Open. The Set Application dialog box 
is displayed. 

  
1. In the Folder Name field, at the end of the folder’s location, type in 

the name of your folder. Click the Create button. The new folder 
name will added to the folder location and also appear in the Folders 
list. 

2. In the Application Name field, type in the new name of the 
application. 

3. Specify a new name for the application, in the Application Name 
field. 
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4. Click OK to confirm. Wizcon closes and then reopens with the 
default settings of the selected application.  

5. Before the new application opens the Create System Tags message 
box will open on your screen. 

6. Select either Yes or No accordingly.  The Quick Access Bar will 
open on your screen. 

7. To open the Application Studio, click the  icon.  The new 
project will appear at the root of the All Containers pane. 
 

Default Wiztune.dat File 

When a new application is created all files are copied from the 
NewWizAPP folder to your new application folder. The WizUM.mdb  
file contains a user name and password (default = user.password) and the 
default Wiztune.dat file contains the following parameters: 

DEFAULTUSER=user.password 
NET_PROTOCOL=NPITCP 
VFI=VFI5FST,VFI5CB 
TRG_FEEDBACK=YES 
NET_CHECKTIMEOUT=60 
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Existing Tab 

This tab holds a list of all existing Wizcon applications. 

 
➤ To open an existing application: 

Click the Existing tab and select the relevant application. 

Or, 

From the File menu select Open Application to open the Open dialog 
box.   
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Select the *.wpj file of the application you want to open and click Open. 
Wizcon closes and then re-opens displaying the specified application. 

Recent Tab 

This tab holds a list of all existing Wizcon applications.  
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➤ To open a recent application: 

Click the Recent tab and select the relevant application. 

Optimizing Application Performance  

Wizcon Station Properties enables you to optimize application 
performance and enhance functionality. System parameters can be 
adjusted to establish an optimal working environment for your Wizcon 
Application. 

➤ To define Station Properties: 

Right-click Wiz Application in the root of the container list in the All 
Containers section (if you have saved your application, the application 
name will appear in the root), and select Station Properties. The Station 
properties dialog box is opens.  This dialog box has the following tabs: 

■ 

■ 

■ 

■ 

■ 

■ 

■ 

General - where the application workplace can be customized.   

Default User – where a default user that will be logged in when you 
start Wizcon is defined.   

Date Format – where the date format is defined. 

VFI - where the format for history files by selecting Virtual File 
Interface DLLs is defined.   

Audit Trail  - where an Audit Trail is added or enabled to view 
operator actions stored in a Wizcon system file in the form of tag 
values.   

ODBC Connectivity – to enable the Open Database Connectivity 
(ODBC) dialog box to save Wizcon historical data to various 
databases through Microsoft's ODBC.    

Advanced Alarm Management – where the Advanced Alarm 
Management module is enabled.   



Setting General Station Parameters 

The application workplace can be customized in the General tab of the 
Station Properties dialog box. 

   

The following options are available: 
Show Quick Access Bar Determines whether or not the 

Quick Access bar appears when 
Wizcon is loaded. 

Show done bar Displays a background processing 
dialog box when large tasks such 
as loading a large image are being 
executed. Changes are 
implemented online. 
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Auto Restart after an 
illegal shutdown 

Specifies if Wizcon automatically 
recovers its last state.  For 
example after power failure.  
Changes are implemented online. 

Display untitled windows 
icons in task bar 

When checked the word untitled 
appears in the task bar for new 
items that have not been saved. 

Display windows icons in 
the task bar 

When this option is checked and 
after reset, no icons are displayed 
in the task bar. 

Selecting a Default User 

Web-disabled

 

You can specify the name of the user you want automatically logged in 
whenever you start Wizcon in the Default User tab of the Station 
Properties dialog box. This is enabled after defining a user name and 
password.  

Note that you only log on to the system when using Wizcon locally.  
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1. In the User field type in the User’s name.  Enter an asterisk (*) to 

specify the last user that logged out. Changes are implemented 
online. 

2. In the Password field type in a unique password for the user.   

3. Click OK to confirm and reset Wizcon to actually save the changes. 

Note:  Remote users login parameters are defined by right clicking 
Html/properties/users and checking either: Enable login Quick Access 
Bar in browser, or Automatically login with default user. 
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Setting the Date Format 

You can set the date style and date separator in the Date Format tab of 
the Station Properties dialog box. 

 

The following options are available: 

Date style   Specifies a date style from a list of predefined date 
styles. Listed below are the Date styles: 
DDMMYY        
MMDDYY        
YYMMDD        
DDMMYYYY   
MMDDYYYY   
YYYYMMDD 

Date separator   Specifies a date separator from a predefined list of 
date separator styles. The Date separator files are: 
/   (slash) 
.    (dot) 
   (dash) 
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➤ To Set Date Format 

1. In the Stations Properties dialog box select the Date Format tab. The 
Date Format Dialog opens. 

2. From the Date Style list select a predefined date style. 

3. From the Date Separator list select the way you want the date to be 
separated. 

4. Click OK key to enter your selection. 

When loading for the first time, Wizcon for Window and Internet sets 
default values for these parameters using country code, defined in 
Control Panel Regional Settings. 

The table below lists the default values in Wizcon for different countries. 

Country Date Style Date Separator 

USA MMDDYY /   (slash) 

Japan  YYMMDD /   (slash) 

Netherlands  DDMMYY /  (dash) 

Denmark DDMMYY / (dash) 

Germany DDMMYY .   (dot) 

Austria DDMMYY .   (dot) 

Russia DDMMYY .   (dot) 

All others DDMMYY /   (slash) 

 



Setting a Format for History Files 

The format for history files is set in the VFI tab of the Station Properties 
dialog box.  

VFI enables the designer to select different file formats to be used by 
Wizcon for historical data logging and report generation. The system 
engineer can use a combination of different file systems and databases 
with the application for data manipulation convenience and optimum 
performance.  

VFI uses a unique driver for each database, thereby taking advantage of 
the database’s structure and characteristics.  eMation supplies drivers to 
support specific databases.  
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The following options are available:  

■ 

■ 

■ 

■ 

VFI5CB, that enables writing/reading tag and alarm historical files 
in FoxPro format. This format is readable by most database 
programs. This is the default option and can be used for both tag and 
alarm history files. 

Note: Restart Wizcon for changes to take affect. 
 

VFI FAST Mode (VFI5FST) does the following: 

Records values with old time stamps. This enables backup to 
complete data to the Master. All values can be read, and 
displayed in a Chart. To enable this option, set the following 
environment parameter. 
VFI5FST_MODE_TIMESTAMP=YES

This parameter should be set in the Master only. It can also be 
set in the backup, however from a performance point of view it 
is better to set it only in the Master. 

Note: This option affects the performance of the Fast VFI.  The more 
scattered the recording means that values will not be written in order of 
time.  

Concurrent writing of history from more than one client.  

There is a gap in logging data between the time the Master is up, 
and when the Backup starts updating it until the Master logger 
starts working. This gap is between 20 sec to 2 min depending 
on the overall load of the system.  

Updating from the Backup to the Master may take a few minutes 
(if it logged a few Mb while it was active). Updating is 
performed while the Master is already active and sampling or 
logging the current process. 



Setting a Format for Audit Trail 

Audit Trail is a useful security feature for applications.  This tab enables 
you to log operator actions to a database via an ODBC data source.  

Operator actions are stored in a Wizcon system file in the form of tag 
values that can be accessed and viewed.  
Wizcon logs all manual operations, with exception to those made using 
Add-on programs, such as script language and WizPLC. Additionally, 
Wizcon does not record Smooth Type trigger actions. 

Audit Trail provides data recovery for users connected to a remote 
ODBC data source in instances of network failure. 

Note: It is not recommended to work with a remote database due to 
possible connection failures. 

➤ To enable audit trail: 

1. Right-click New Wizcon Application in the All Containers list of the 
Wizcon Application Studio to open the Station Properties dialog 
box. 

2. Using the arrows scroll to open the Audit Trail Enable tab. 
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3. Check the Enable Audit Control checkbox to activate the Current 
Data Source field.  When the database source is predefined, click the 
Current Data Source field’s drop down list and select the database.  
If it is not predefined click the Add Data Source button. 
The standard Windows Create New Data Source wizard window is 
displayed, in which a database source can be defined. The data 
source can be any valid predefined ODBC data source.  

 
4. In the Select a Type of Data Source section click User Data Source 

(applies to this machine only) and then click Next to open the next 
dialog box.  

5. Select the driver for which you want to set up a data source and click 
next to open the Finish dialog box. 

6. Verify that the information in this dialog box is correct.  If it is, click 
Finish, if not click Back to make any corrections. The ODBC 
Microsoft Access Setup dialog box opens. 
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7. Complete the Data Source Name and Description fields.  

 
8. In the Database section you have four options: 

Select – click to open an existing location  
Create – click to create a new database 
Repair – click this option targets the specific database for repair 
Compact – click to save the database and to remove unused space 
from it 

9. In the System Database field click either None or Database and then 
click OK. 

10. The Database Successfully Created notification will appear on your 
screen.  Click Apply and OK to close the dialog box and then restart 
your computer. 

Caution: Wizcon does not support the File Data Source (Machine 
independent) option. 
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Data Recovery 

Audit Trail provides data recovery for users connected to a remote 
ODBC data source in instances of network failure. 

When a network problem is discovered, Wizcon ends the session with 
the remote database and creates a temporary file in the Temp folder of 
Windows NT. This file, a text file in CSV format, is called BCK*.tmp. 

Wizcon then scans the network connection once a minute, and when 
connection to the server is re-established, writes the temp file to the audit 
trail file. If the information is written correctly, Wizcon then deletes the 
temp file. If the information is not written correctly, Wizcon will notify 
you of possible data loss. 

Note: It is not recommended to work with a remote database due to 
possible connection failures. 
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Database Fields 

The following fields and variables are added to a database file.  

Field Variable and Type 

UserName  
Specifies which user name performed the 
action. 

SQL_VARCHAR  20 

SourceType 
Specifies the Image or browser. 

SQL_VARCHAR  10 

SourceName 
Specifies the Image or picture name. 

SQL_VARCHAR  200 

SourceID 
Specifies the IP address of the browser. 

SQL_VARCHAR  50 

Action 
Specifies one of the following actions: tag 
assign, zone, macro. 

SQL_VARCHAR 10 

TagName 
Specifies the name of the tag. 

SQL_VARCHAR 50 

TagValue 
Specifies the tag value. 

SQL_DOUBLE 

ZoneName 
Specifies the name of the zone. 

SQL_VARCHAR  20 

MacroName 
Specifies the name of the macro. 

SQL_VARCHAR 10 

TimeAction 
Specifies the time and date the action took 
place. When accessed through a browser, the 
time and date will be that of the server. 

SQL_VARCHAR 20 

 



Formatting ODBC Connectivity: 

The ODBC Connectivity dialog box enables you to save Wizcon 
historical data to various databases through Microsoft’s ODBC 
connectivity. 

➤ To enable ODBC Connectivity: 

1. Right-click New Wizcon Application in the All Containers list of the 
Wizcon Application Studio to open the Station Properties dialog 
box. 

2. Using the arrows scroll to open the ODBC Connectivity tab. 

 
3. Check the Enable ODBC checkbox to activate the dialog box 

options. 

4. In the Currrent Data Source field select the database type to which 
you want to save Wizcon Historical Data.  Or click the Add Data 
Source button to open the Create New Data Source dialog box.  

5. In the Cross Reference Table field, type in the name of the table and 
click the Create Reference Table button to create a cross reference 
table including tag definition parameters. 
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6. If you intend to use a protected database (such as Oracle) type the 
user name and password in the identification field. 

7. Under the History Table field type in the name of the historical data 
table.  Check the Enable Tag Name Logging checkbox to write tag 
names to the historical data table.  

8. Click Apply and OK to confirm. 

Formatting Advanced Alarm Management: 

Advanced Alarm Management (AAM) uses a multi-service 
communication platform to provide alarm transmission over various 
communication channels including SMS, email, fax and vocal messages. 

AAM is comprised of two design mode components: 

■ 

■ 

AAM channels and AAM pager services 

Advanced Alarm Viewer – a runtime component  

➤ To enable Advanced Alarm Management: 

If the communication lines used by AAM are already defined then do the 
following: 

1. Right-click New Wizcon Application in the All Containers list of the 
Wizcon Application Studio to open the Station Properties dialog 
box. 

2. Using the arrows scroll to open the Advanced Alarm Management 
tab. 



 
 

3. Check the Enable Advanced Alarm Management checkbox and click 
OK. 

4. Restart the Wizcon application. 
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Chapter 7   
Security, Authorization and 
User Management 

 About this chapter: 

This chapter describes Wizcon security, user authorization and also 
discusses User Management, as follows: 
Authorization Overview on page 7-2 discusses Wizcon Authorization 
using the Menu Items and System options.    
Security Overview, on page 7-8 discusses the Security module with a 
reference to the Installation for further details. 

WizFactory Dialog Boxes on page 7-9 discusses the dialog boxes that 
replace the standard Windows NT/2000 dialog boxes when Wizcon 
system security is installed.  

User Management Overview on page 7-15 discusses definition of 
users, groups and teams.   

Creating Users on page 7-17 discusses how to create new users 

Creating Groups on page 7-31 discusses how to create new groups 

Creating Teams on page 7-36 discusses how to create new teams. 
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Authorization Overview 

 
In Wizcon, operator access can be limited to professional level and skill. 
This powerful feature enables the system engineer to control access to 
the Wizcon system.  
Authorization in Wizcon for Windows and Internet refers to the ability to 
limit operator access to system facilities. This powerful feature enables 
the system engineer to control access to the various Wizcon for 
Windows and Internet components and modules, such as menu items, 
tags, macros, and graphical objects. 
The components to which access can be limited include: 
■ 

■ 

■ 

■ 

Menus and menu items 
Writing Tag values 
Macro activation 
Graphic element layers in images 

System authorization is assigned according to users, groups and teams. 
An unlimited number of groups can be defined in the system, each with 
its own unique name. Each operator can be assigned to one or more 
groups. For example, once a group is assigned to a tag, any operator that 
belongs to the group can perform tag value operations on the tag. 
Operators not assigned to a group matching any of the tag groups will 
not be able to set new tag values. 

Note:  User Management defines users and their passwords and also 
assigns users to groups or teams. The name of the currently logged-in 
operator is displayed in the title bar of the Quick Access bar.  
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➤ To define authorization settings: 

Select the Design menu and point to Authorization and then select either 
Menu Items or System.   
■ 

■ 

Menu Items – assign an authorized group to each menu item in 
Wizcon 
System – Set system authorization options to security groups and 
users. 

Menu Access Authorization 

Each menu item in the Wizcon system can be assigned authorized 
users/groups/teams, whereby only their defined operators have access to 
these items. 

For example, if an operator belongs to the groups called MANAGER, 
SYSTEM, and USERS, and a menu item is assigned the groups TECH, 
SYSTEM, and ENGIN, this item will be accessible to the operator (since 
both have a common group). 



➤ To assign menu item authorization: 

From the Design menu, point to Authorization and select Menu Items. 
The Menu Authorization dialog box is displayed: 

 

This dialog box contains a list of the Wizcon views such as: Image, 
Chart, Events Summary, History Viewer, and the Quick Access bar. 

The menus of these items are displayed in a tree arrangement. Menu 
branches are expanded and contracted by double-clicking on them. An 
item that holds sub-items is indicated by an arrow (>).  When you 
double-click on such an item, the sub-item list appears. For example, 
double-clicking on Events Summary displays the following sub-item list:  
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Double-click on Events Summary to close the sub-item list. 

Set All Assigns all the authorization groups to an item  

Reset All Resets all the groups assigned to an item to their 
original settings 

Save Saves the new definitions 

Groups Opens the Access Permission Manage where the 
access level of users/groups can be defined 

➤ To assign specific groups to an item: 

1. Select the item and click the Group button. The Action Permission 
Manager dialog box is displayed, in which you can select groups to 
be assigned to the menu item. Only operators assigned to the 
specified groups will have access to the menu item. 

2. Click the Set All button to assign all the groups to the item. 
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3. Click the Reset All button to reset all the groups assigned to the item 
to their original settings. 

4. Click Save to actually save these definitions. 

Notes: 

1.  If you assign groups to menus that include sub-menus and sub-
items, all the sub-menus and sub-items are affected. However, if you 
assign groups to a sub-menu or sub-item, the parent menu is not 
affected. 

2. When you select a sub-menu or sub-item that belongs to the menu, 
you can only reset and set the groups that were defined for the 
parent menu, unless you return to the parent menu and change the 
settings. 

Action Permission Manager 

The Action Permission Manager dialog box is used to define authorized 
users and/or groups. 

There are four buttons: 

Add Click here to add a user/group to the Access 
Members list 

Remove Click here to remove a user/group from the Access 
Members list 

Add all Click here to add all users/groups to the Access 
Members list 

Remove all Click here to remove all users/groups from the 
Access Members list 



 

➤ To assign access permission: 

1. Click the arrow in the dropdown list and select the type of list you 
want to view.  There are three options:  

List all Groups Users Select this option to display a list of 
your application's defined groups and 
users  

List all Groups Select this option to display a list of 
your application's defined groups 

List all Users Select this option to display a list of 
your application's defined users  

2. From the Groups/Users column select a group/user and click the Add 
button. The selected groups/users are now displayed in the list of 
Access Members. 
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3. To actually assign access permission, check the All groups and users 
have access permission checkbox.  

4. Click OK to confirm. 

Note:  The option buttons are deactivated when the All groups and users 
have access permission checkbox is checked. 

Security Overview 

Note:  The Wizcon system security module must be installed to enable the 
Security option. 

Wizcon provides additional system security by ensuring that users access 
only those parts of the Windows system to which they have 
authorization.   

When Wizcon system security is installed it replaces the standard 
Windows system control.  The Wizfactory dialog boxes overwrite the 
Windows NT dialog boxes.   

When turned on computers that have the security module installed will 
open with the Wizfactory window.  After clicking the Start button users 
will have to enter their user name and passwords in order to gain 
computer access.    



 

WizFactory Dialog Boxes 

This section describes the WizFactory dialog boxes that replace the 
standard Windows NT/2000 dialog boxes when Wizcon system security 
is installed.  

The WizFactory Welcome dialog box is displayed when Windows is 
initiated: 
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The WizFactory Logon Information dialog box is displayed for user 
logon: 

 

The WizFactory Options dialog box is displayed when Ctrl+Alt+Delete 
is pressed after logon: 
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The Logoff WizFactory Station dialog box is displayed when the user 
logs off: 

 

The Shutdown WizFactory Station dialog box is displayed when 
shutdown is initiated: 

 

Note: The above four options are accessible only to authorized users. 
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The Workstation Locked dialog box is displayed when the station is 
locked: 

 

 

The Unlock Workstation dialog box is displayed when a user unlocks the 
station: 
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The Change Password dialog box is displayed when a user changes a 
password: 

 

System Definition 

This option defines the level of access the user/group has to the Wizcon 
application.  The following access levels are available: 

Full security (disable 
all) 

Specifies that users will be unable to access 
other programs. 

Disable lock station Specifies that a user cannot block access to a 
computer by applying a password 

Disable shutdown 
station 

Specifies that a user will be unable to shut 
down a station 

Disable logoff Specifies that a user cannot logout of the 
system 

Disable changing user 
password 

Specifies that users cannot change their 
passwords 
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Disable ALT-ESC Specifies that a user cannot access the Start 
Menu 

Disable ALT-TAB Specifies that a user cannot navigate between 
the programs open on the computer using the 
Alt Tab keys 

➤ To define operator system settings: 

 
1. From the Design menu, point to Authorization and select Systems. 

The System Authorization dialog box is displayed. 

2. To define authorization level, select an option from the System 
Authorization Options column and then click Add. The name 
user/group will appear in the Unauthorized Members column. 
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3. If there are no users defined for an option, double click the option to 
open the options definition dialog box.  Select the name of the 
user/group/team and click Add and then OK to return to the System 
Authorization dialog box.  

4. Check the Full Security on Logout checkbox to define this option. 

User Management - Overview  

User Management enables management of an application’s users both 
locally and remotely. Users can be a single user, groups or teams built 
from users in the same groups. 

Wizcon management methodology, using the Users Timetable feature, 
enables simple and efficient scheduling of users, groups and teams.   
By default, User Management has a group called Administrators.  Users 
in this group are authorized to modify user properties (including their 
password).  However, the group name cannot be modified or deleted.  
Users belonging to this group cannot remove themselves from it.  An 
authorized user can access a user/group and modify its parameters.  The 
User Management feature provides full backwards compatibility.  
Groups created in previous versions can be imported.   

Notes: 

1.  If you have different applications installed on different stations, 
make sure that each application has its own unique users and 
groups.  Users with the same names defined in different applications 
will be able to share the same data. 

2. The default user can be deleted only after a new default user is 
defined in Station Properties.  Only a user logged in under a 
different name and with Administrator rights can delete the default 
user.  An Administrator must have at least one user in order to 
access the Wizcon application.    
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The following basic activities can be performed through User 
Management: 

■ 

■ 

■ 

■ 

■ 

■ 

■ 

■ 

Definition of users, groups and teams 

Additional user information such as address can be added 

Access permission definition 

Definition of how alarms are transferred and received by users using 
Advanced Alarm Management 

Back up user definition 

Steps for Creating Users, Groups and Teams 

This section describes how users, groups and teams are created in the 
following steps. 

Create new users. 

Create new groups or add users to existing groups.  New users can 
also be created and added in the Groups dialog box.     

Create new groups and add teams to them.   



Creating Users 

➤ To define a user: 

In the All Containers section of the Wizcon Studio click User 
Management and then click Users.  A List of Users opens in the Control 
Panel.   

 

Note:  If no users are defined in the project then the list will still open 
with the Wizcon default User displayed. 

In All Containers right click Users and then click New or right click 
anywhere in the Control Panel and click New. The New Users dialog 
box opens. 
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The New User dialog box has four tabs: 
General Where the user’s basic general properties are 

defined 
Groups Where the group(s) that the user is a member of 

are defined  
Messages Where the user’s communication methods for 

Wizcon Advanced Alarm Management services 
are defined 

Information Containing information such as the user’s 
address, PIN and other comments  
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General Tab 

This tab holds fields that define a user’s name, description, password and 
the layout of the user’s computer screen.  The lower section of the tab 
enables the system manager to define access permission both locally and 
on the Web. 

1. In the Name field type the name of the user. 

2. In the Full Name field type in the user’s full name. 

3. In the Description field type in a short description about the user.  
For example, the name of the user’s department or job. 

4. In the Password field type the user’s unique password. 

5. In the Confirm field type the user’s password again. 

6. In the Layout field click the arrow to open the dropdown list and 
select the relevant layout.  The user’s computer will always open in 
this view. 

7. To enable a user to change passwords check the Allow Changing 
Password checkbox. 

8. To enable the user to update information check the Allow Changing 
Information checkbox. 

9. To enable the user to access the Web module check the Allow Web 
Access checkbox. 

10. Click OK to actually create the user. The new user’s name will be 
added to the Users List. Or, click Apply and then click the Group tab 
in this dialog box.    
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➤ To modify existing users: 

1. In All Containers click User Management then click Users to open 
the List of Users. 

2. Right click the specific user to open a popup menu and click modify. 
Or, double click the specific user.  The User Properties dialog box 
will open. 

3. Modify the users properties and then click OK to confirm. 

➤ To delete existing users: 

1. In All Containers click User Management then click Users to open 
the List of Users. 

2. Right click the specific user to open a popup menu and click delete. 
The Delete User message will open. 

3. Click Yes to delete the user.  The User will be deleted from the List 
of Users. 

➤ To change a users password: 

1. In All Containers click User Management then click Users to open 
the List of Users. 

2. Right click the specific user to open a popup menu and click Change 
Password. The Change Password dialog box will open. 

3. Type in the new password in the New Password field. 

4. In the Confirm Password field type the new password again. 

5. Click OK to confirm. 

Note:  The User Name field cannot be changed. 
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➤ To view the List of Users: 

This option has three sub-options Duplicate, Settings and Clear Filters 
described below: 

■ 

■ 

■ 

Duplicate  - This option opens a duplicate copy of the List of Users.  
When right clicking and/or selecting a user in the list the same 
options as for User are available.  

Settings - This option defines the List of Users settings.  There are 
three columns; Full Name, Description and User Name.  Columns 
can be deleted and their order changed. 

1. To delete/activate a column click the checkbox next to the 
specific column name. 

2. To change the order the columns appear in the List of Users, 
select a column name and click either Move up or Move down. 

3. Clicking Select All activates all columns.  These columns will be 
displayed in the List of Users. 

4. Clicking Deselect All de-activates all columns.  No columns will 
be displayed in the List of Users. 

5. Click Default to return to the Wizcon settings. 

6. Click OK to confirm. 

Clear Filters  - The List of Users table can be filtered alphabetically 
or numerical as follows: 

1. Type the filter number or letter in the textbox under the List of 
Users columns.  The list will be filtered accordingly. 

2. To clear the filter, right click in the List of Users, select View 
and then Clear Filters.  The complete List of Users will open on 
your screen.  



GroupsTab 

Groups can be created for new users by clicking the Groups tab.  
However, existing users can also be added to groups by opening the List 
of Users and double clicking the specific user to open the User Properties 
dialog box. 

This tab is divided into two sections, List of Groups and Member Of.  
The user can be added or removed to a group or added or removed from 
all the groups listed.  Additionally, groups can be created, deleted 
viewed or modified.  A user’s properties can also be viewed and updated.  
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➤ To add a user to a/all group(s): 

1. Select the relevant group/s from the List of All Groups column. 

2. Click the Add button. The name of the Group/s will be added to the 
Member of column.   

3. Click OK to confirm.  The user’s name will be added to the Group/s. 
This can be viewed when selecting Groups in All Containers to open 
the Groups List in the Control Panel, double clicking the group name 
and then checking the Users tab. 

➤ To remove a user from a/all group(s): 

1. Select the relevant group from the List of All Groups column. 

2. Click the Remove/Remove All button. The name of the Group will 
be removed from the Member Of column.  

3. Click OK to confirm.  The user’s name will be removed from the 
Group/s.   

➤ To modify groups: 

1. Select the relevant group from the List of All Groups column. 

2. Either right click to open a popup menu and select Modify or click 
 modify button located under the List all Groups column.  

3. Click OK.  The Group Properties dialog box will open.   

4. Make your modifications and click OK to confirm.  For further 
instructions read the section how to Add New Groups directly 
below.   
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➤ To delete groups: 

1. Select the relevant group from the List of All Groups column. 

2. Either right click to open a popup menu and select Delete or, click 

the  delete button located under the List all Groups column.  

3. Click OK to confirm.   

➤ To add new groups: 

1. Click the  New icon located under the List all Groups column.  
The New Group dialog box opens.  This dialog box has two tabs; 
General and Users.  A third tab opens after the General tab has been 
filled, Alert Group checked and the Apply button clicked. 

 
 

2. In the Group Name field type in the name of the Group. 
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3. In the Description field type in a description of the group.  For 
example, air conditioning or bottling. 

4. To add this group to a team check the Alert Group checkbox. 

5. Click Apply.  The Teams tab is added to the dialog box. 

6. Click the Users tab. This tab is divided into two sections, List of 
Users and Member.  Users can be added or removed from a group or 
added or removed from all the groups listed.  

7. To add a user, select a user from the List all Users column and click 
the Add button. Alternatively, select all the users in the column and 
click the Add all button.  The users will appear in the Members 
column. 

8. To remove a user, select a user from the Members column and click 
the Remove button. Alternatively, select all the users in the column 
and click the Remove all button.  The users will be removed from 
the Members column.  

9. Click Apply and open the Teams tab. 



Creating New Teams 

 
The Teams tab has two columns List All Teams and Members.     

Teams can be created, deleted, renamed and new members 
can be added to them.  To do so either right click the team name to open 
a dropdown list and select your option or, click the relevant button 
located under the List all Teams column. 

1. To create a new team either right click in the List All Teams column 

and click New Team, or click the  New icon.   

2. Type in the team’s name and then click Apply. 

3. To add members to the team, select the team in the List all Teams 
column and then either right click to open a popup menu and select 
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Team Members or click the  button.  The Team Members dialog 
box will open.   

4. From the List all Group Members column select the relevant groups 
that will be added to the team and then click Add.  Click OK to 
confirm.  The name of the user appears in the Members column.  
Click OK to confirm.   
 

Messenger Tab 

This tab is used to define how alarms are sent to a user/group/team.  The 
Advanced Alarm Management (AAM) messenger service enables the 
following modes: 

Generic Beep ■ 

■ 

■ 

■ 

Fax 

Cellone 

Email 
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➤ To define an AAM messenger service: 

 

Click the Messenger tab to open the Messenger dialog box. This dialog 
box enables new services to be defined and attached to 
user/groups/teams.  

AAM Services can be created, deleted, modified and moved 
up and down within the list.  To do so either right click in the 

Assign to AAM Services window or click the relevant button located 
under the window.  In addition back up users can be defined.  
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1. To define a new AAM service either right click in the Assign to 
AAM Services window or click the button to open 
Messenger menu. 

 
2. In the AAM Service Name field click the dropdown list and 

select the type of service. 

3. In the Email/Phone field type in the relevant number. 

4. Click OK to return to the user Messenger tab. 

5. In the Backup user field click the arrow to open the dropdown 
list and select a user. 

6. Click OK to confirm. 
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Information Tab 

Additional information regarding the defined user can be written in the 
Information tab.  This information includes address, PIN number (for 
security/accessing the program) and comments. 

 

➤ To add information: 

1. Click the Information tab.   

2. In the Address field type in the user’s address. 

3. In the PIN code field type in the user’s PIN code. 

4. In the Comments field type in any comments that may be required. 

5. Click OK.  The new user’s name and information appears in the List 
of Users. 
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Creating Groups 

➤ To create a new group: 

In the All Containers section of the Wizcon Studio click User 
Management and then click Groups.  A List of Groups opens in the 
Control Panel.   

 

Note:  If no groups are defined in the project then the list will still open 
with the Wizcon default Administrator displayed. 
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1. In All Containers right click Groups and then click New or right 
click anywhere in the Control Panel and click New. The New Group 
dialog box opens. 

 

When the New Group dialog box opens it has two tabs General and 
Users however, there is a third tab called Teams which only opens after 
the General tab has been filled, Alert group clicked and the Apply button 
clicked. 

General Where the group’s basic general properties are 
defined 

Users Where the users that are members of the group are 
defined  

Teams Where the groups that are members of the team are 
defined 
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General Tab 

The General tab defines the name of the group and a description of it, for 
example Bottling, or Hygiene.  

 
1. In the Group Name field type in the name of the Group. 

2. In the Description field type in a description of the group. 

3. To add this group to a team, check the Alert Group checkbox. 

4. Click Apply.  The Teams tab is added to the dialog box. 
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Users Tab 

The Users tab defines the users that are members of the group. This tab 
is divided into two sections, List of Users and Member.  Users can be 
modified, added or removed from groups. 

 
1. To add a user to a group, select a user from the List all Users column 

and click the Add button. Alternatively, select all the users in the 
column and click the Add all button.  The users will appear in the 
Members column. 

2. To remove a user, select a user from the Members column and click 
the Remove button. Alternatively, select all the users in the column 
and click the Remove all button.  The users will be removed from 
the Members column.  

3. Click Apply and open the Teams tab. 
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➤ To add new users: 

1. Either right click to open a popup menu and then click New or click 
the  button located below the List of Users column.  The New 
User dialog box will open. 

2. Follow the instructions above for creating a new user. Click OK to 
confirm. 

➤ To define a group administrator: 

1. In the Members column check the checkbox next to the relevant 
user’s name. 

2. Click OK to confirm. 

➤ To modify existing users: 

1. In the Group Properties Users tab select a specific user from the List 
all Users column.  

2. Either right click to open a popup menu and then click Modify or 
click the  button located below the List of Users column.  The 
User Properties dialog box will open. 

3. Modify the relevant properties and click OK to confirm. 

➤ To delete existing users: 

1. Right click the specific user to open a popup menu and click delete. 
The Delete User message will open. 

2. Click Yes to delete the user.  The user will be deleted from the List 
of Groups. 

3. Click OK to confirm. 
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Creating Teams 

Creating New Teams 

The Teams tab has two columns; List All Teams and Members.  Teams 
can be created, deleted, renamed and new members can be added to 
them.  To do so either right click the team name to open a popup menu 
and select your option or, click the relevant button located under the List 
all Teams column. 

 
 

1. To create a new team either right click in the List All Teams column 

and click New Team, or click the  New icon.  A textbox with a 
team icon will open in the List all Teams column. 
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2. Type in the team’s name and then click Apply. 

➤ To add users to teams: 

1. To add members to the team, select the team in the List all Teams 
column and then either right click to open a popup menu and select 

Team Members or click the  button.  The Team Members dialog 
box will open.   

2. From the List all Group Members column select the relevant groups 
that will be added to the team and then click Add.  Click OK to 
confirm.  The name of the user will appear in the Members column.   
 

➤ To delete teams: 

1. Right click the specific user to open a dropdown list and click Delete 
or click the  button.  The team will be removed from the List of 
Teams. 

2. Click OK to confirm. 

➤ To rename teams: 

1. Right click the specific user to open a popup menu and click Rename 
or click the  button.   

2. Type in the new team name. 

3. Click OK to confirm. 
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Chapter 8   
Communication Drivers  

 About this chapter: 

This chapter describes how to define communication drivers in Wizcon, 
as follows: 
Overview, on the following page, describes an overview of 
communication drivers and communication blocks. 

Defining Communication Drivers, page 8-3, describes how to add and 
remove communication drivers to and from your application. 

Communication Driver Properties, page 8-7, describes how to define 
general driver properties, serial port parameters and communication 
blocks. It also describes how to view general driver information.  

Converting Communication Block Definitions, page 8-14, describes 
the conversion utility used for communication block defintions. 

Defining OPC (Wizcon Client), page 8-17, provides an overview of 
OPC (OLE for Process Control). 

OPC Driver Properties, page 8-18, describes defining OPC driver 
properties. 
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Overview 

Communication drivers handle communications with external devices, 
such as PLCs, industrial instruments, remote computers and field buses. 
These drivers are separate program files, which are installed when 
installing Wizcon. Communication driver file names have the format 
VPIWN??.DLL , in which ?? is the two- or three-letter code of the 
driver. Since each communication driver is different. The driver’s 
information documentation should be consulted for specific 
communication driver details. 

You can define communication blocks to improve driver performance 
when working with large quantities of tags. These blocks enable you to 
transfer large blocks of information instead of individual data items.   

The first step in designing a Wizcon application is to define the 
communication drivers and blocks. You then define the tags, which are 
control values monitored by the system. They are used as internal 
variables for: 

■ 

■ 

Calculations and display. 

Communication with PLC’s in order to represent data from PLC 
memory or to send commands to PLC’s.  

Caution: In fast Pentium PCs with a 16550 UART (serial interface chip), 
Windows 95 or 98 or 2000 default settings may cause communication 
errors on serial communication drivers. To overcome this problem, 
lower the buffer sizes on the UART in the following menu: 
Start  Settings  Control Panel  System  Device Manager  
Ports  Communication Port 1.4  Port Settings  Advanced. 
Use a trial and error method to reach the optimum setting. 



Defining Communication Drivers 

Communication drivers are defined in the Communication Drivers dialog 
box, in which you can add and remove drivers as described on the 
following page, and define driver properties. 

➤ To add/remove a communication driver: 

In the Control Panel of the Wizcon Application Studio, double-click the 

icon. 
Or, 
In the Design menu of the Wizcon Application Studio, select 
Communication Drivers. The Communication Drivers dialog box is 
displayed: 
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This dialog box has the following fields: 
Logical Name Specifies the name given to the driver for application 

identification purposes. 
Device Specifies the name of the physical device. The 

standard name is COMn, where n is a number that 
refers to the serial port of the computer. Drivers that 
use standard TCP/IP, or proprietary network, do not 
require this parameter. 

Name Specifies the name of the communicating driver. For 
example; SIEMENS, SIMATIC S7. 

Parameters Specifies the Device access rights.   For example, 
Read/Write and out of block.  (See To add a driver 
below). 

➤ To add a driver: 

Click the Add button. The Wizcon Communication Driver Setup Wizard 
is displayed. 

. 
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1. To install a driver from the List (installed with Wizcon) double click 
the name of a cummunication driver and then click Next. 

 
2. Type in a unique logical name for the driver in the relevant field. 

3. Click the up/down arrows to define communication timeout. 

4. Click the relevant text box to define the driver’s attributes.  This can 
be either Write, Read or Sample tags outside of blocks. 
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5. Click Next.  The Communication Driver Setup Wizard opens.  

  
The following options are available: 
Add Click to add a new communication driver 
Delete Delete a communication driver from the list 
Modify Modify an existing communication driver 
Files This option has two sub-options Import and Export 

6.  Click  the Add button. The following dialog box is displayed. 
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The following options are available: 

Block Address  The starting address of the block in the device. For 
address format specifications, see the relevant 
communication driver section in the eMation Driver 
documentation. 

Length  Number of items in the block. 

Sample Rate  Sampling rate of the block in seconds and 
milliseconds. 

Note: After defining communication drivers restart Wizcon to enable the 
new definitions. 

➤ To remove a driver: 

Select the driver you want to remove and click the Remove button. The 
driver is deleted from the list of drivers. 

Note: After defining communication drivers restart Wizcon to enable the 
new definitions. 

Communication Driver Properties 

Communication driver properties are defined in the Communication 
Driver dialog box.  

➤ To define communication driver properties: 

1. In the Design menu of the Wizcon Application Studio, select 
Communication Drivers. The Communication Drivers dialog box is 
displayed.  

2. Select a driver and then click the Properties button to display a 
dialog box in which you can define communication driver properties. 



In this dialog you can define the following:  

General driver properties, in the General tab. ■ 

■ 

■ 

Serial port parameters, in the Serial tab. 

Communication blocks, in the Blocks tab. 

You can also view information about the driver in the Information tab. 

Defining General Driver Properties 

You can define general driver properties in the General tab of the 
Communication Driver dialog box, as described below.  

 
The following options are available: 

Logical Name  Specifies a name for identification purposes. 

Timeout  Serial Drivers:  Defines the period of time (in one 
hundredth of a second) during which the system 
waits for response from a device before indicating a 
communication failure. 
Non Serial Drivers:  Timeout unit is one 
millisecond. 
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Attributes  Read: Check to enable Read Only operations with 
the device. 

 Write: Check to enable Write Only operation with 
the device. 

 Sample tags outside of blocks: Check to enable the 
sampling of tags not included in the communication 
blocks. If you do not select this option, 
communications will be limited to tags within the 
blocks. 

Defining Serial Port Parameters 

You can define serial port parameters in the Serial tab, of the 
Communication Driver dialog box, as described below.  

 
The following options are available:  

Serial port Enter the appropriate device name. The standard 
name is COMn , where n is a number that refers to 
the serial port of the computer. For example, COM1 
for port 1.  
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The Baud Rate, Data Bits, Parity and Stop Bits fields are set to the 
default setting determined by the PLC or manufacturer. (If they have 
been defined they will automatically be displayed). 

Defining Communication Blocks 

You can define communication blocks in the Blocks tab, of the 
Communication Driver dialog box, as described below.   

 

You can define communication blocks to improve driver performance 
when working with large quantities of tags. These blocks enable you to 
transfer large blocks of information instead of individual data items.  

The rationale for assigning communication blocks is the reduction in 
transmission overhead. In serial communications (RS-232C), the serial 
bit rate is relatively slow and 10 to 20 bytes are required just to address 
the items to be transferred. Thus, while approximately 20 extra bytes are 
required to transfer one single item, large blocks containing several items 
can be assigned instead, using the same addressing overhead. 

It should be noted, however, that not all devices support block transfers, 
and those that do may impose restrictions on block size or item types.  
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For more details, see the relevant eMation Driver documentation. 

Wizcon enables you to define contiguous blocks in the address space of 
the external device. Each block can then be transferred in a single 
common transaction. 

➤ To define a communication block: 

Click the Add button in the Communication Driver dialog box. The 
following dialog box is displayed. 

 

The following options are available: 

Block Address  The starting address of the block in the device. For 
address format specifications, see the relevant 
communication driver section in the Driver 
documentation. 

Length  Number of items in the block. 

Sample Rate  Sampling rate of the block in seconds and 
milliseconds. 

Note: The maximum number of blocks that can be defined for each 
driver is 256.  In certain circumstances blocks may be defined 
differently. For more information, refer to the Driver documentation. 
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■ 

■ 

■ 

■ 

Though blocks are efficient in terms of transfer rate, defining large 
blocks that cover unnecessary items may degrade system 
performance. 

It is better to define small blocks with fast sampling rates for items 
that are monitored frequently, and leave the remaining data in larger 
blocks with slower sampling rates. 

Although blocks may overlap each other, this situation is undesirable 
since identical tags that belong to two overlapping blocks will be 
sampled twice (which is insufficient). 

The relationship between the block and tag sampling rates (specified 
in the Block Definition and Analog/Digital Tag Definition dialog 
boxes respectively is such that the slower of the two rates will 
always override the other. 

For example, if you define a communication block for five tags with 
a block sample rate of 30 seconds. Three of the tags will be assigned 
a tag sample rate of 20 seconds, and the remaining two tags assigned 
a tag sample rate of 10 seconds. The following illustration will 
clarify the example: 

  G1 G2 G3  G4 G5 
    20 sec   10 sec 
  └─────────────┘ 
      | 
    30 sec 

The tags will be sampled only after 30 seconds have elapsed since 
the last time the block was sampled. 



However, if you define a sampling rate for a tag group slower than 
the block sampling rate, as in the following illustration. 

  G1 G2 G3  G4 G5 
    40 sec   10 sec 
  └─────────────┘ 
      | 
    30 sec 

The tags in the group (40-second group in the example above) will 
be sampled whenever the amount of time specified by the slower rate 
has elapsed. 

It is therefore recommended to group tags into blocks according to 
their sample rate. 

Viewing Driver Information 

You can view driver information in the Information tab, of the 
Communication Driver dialog box, as described below  
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The following information is available: 

File name The driver file name. 

Type This field can contain one of two parameters: 

Serial which defines parameter for serial 
communication (RS-232C protocol). 

NULL which is not serial and can use an external 
library, or device drivers, supplied by an external 
provider.  

Supports Describes the function that the driver supports. 

Description The name of the driver. 

Converting Communication Block Definitions 

Wizcon provides a conversion utility for communication block 
definitions. You can: 

■ 

■ 

Export communication block definitions to external sources in fixed 
or CSV file format.  

Import communication block definitions to Wizcon in fixed or CSV 
file format. 

➤ To import/export communication block definitions:  

1. In the Design menu of the Wizcon Application Studio, select 
Communication Drivers. The Communication Driver dialog box is 
displayed. 

2. Select a driver from the list of available drivers, click the Properties 
button and then select the Blocks tab. 



 The communication driver properties are displayed:  

  
3. Click the Files button. This displays a popup menu in which you can 

select Export or Import. 

4. To export:  

Select Export from the popup menu. The Open block file for 
export dialog box is displayed. This is similar to the standard 
Open dialog box. 

■ 

■ 

■ 

In the Files of type field, select one of two export options: BLS 
or CSV. Then locate the file enter a filename and click Save.  
The file is exported. 

5. To import:  

Select Import from the popup menu. The Choose block file 
dialog box is displayed: 
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In the Files of type field, select the type of file you want to 
import. You can choose between BLS or CSV. Then locate the 
file you want to import and click Open. The imported file will 
replace previous block definitions. 

■ 

■ 

Note: Restart Wizcon after importing files for changes to take effect. 

Importing and Exporting Definitions Using an External Application 

If you are using an external application you can import and export 
communication block definition files using the command line. 

Exporting Communication Block Definition Files 

➤ To convert a communication block definition file to csv format: 

Type the following in the command line:  

bls2csv [fromfile] [tofile]  
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➤ To convert a communication block definition file to a dat file:  

Type the following in the command line:  

■ 

■ 

bls2dat [fromfile] [tofile]  

Importing Communication Block Definition Files 

➤ To convert a csv file to a communication block definition file: 

Type the following in the command line:  

csv2bls [fromfile] [tofile]  

Note: Wizcon can run in the background. Restart Wizcon for the changes 
to take effect. 

Defining OPC (Wizcon Client) 

OPC (OLE for Process Control) is an industry software standard 
designed to provide business applications with easy access to industrial 
plant floor data.  

Using OPC technology, a system integrator can create a common 
interface for exchanging data with hardware field devices or other 
software that can be reused by this client program, and other HMI, 
SCADA and custom applications. 

This client program uses OPC technology to exchange data with HMI 
and SCADA software and OPC servers. 

For further information see the Networking with OPC Using DCOM 
Appendix. 
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OPC Driver Properties 

Communication drivers are defined in the Communication Drivers dialog 
box, in which you can add and remove drivers as described on the 
following page, and define driver properties. 

➤ To add/remove a communication driver: 

In the Control Panel of the Wizcon Application Studio, double-click the 
Communication Drivers icon. 

Or, 

In the Design menu of the Wizcon Application Studio, select 
Communication Drivers.  

➤ To define communication driver properties: 

1. In the Design menu of the Wizcon Application Studio, select 
Communication Drivers. The Communication Drivers dialog box is 
displayed.  

2. Select a driver and then click the Properties button to display The 
Communication Driver - OPC Client dialog box in which you can 
define communication driver properties. 



 
In this dialog you can define the following:  
Logical Name Specifies the name given to the driver for application 

identification purposes. 

OPC Server Name Name of a specific interface. 

 OPC Servers are provided by different vendors. The 
code written by the vendor determines the devices 
and data to which each server has access, the way 
in which data items are named and the details about 
how the server physically accesses that data. 

 For this reason, we expect that the OPC Server will 
generally be a local or remote program which 
includes code that is responsible for data collection 
from a physical device. 
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Node Name Specifies the name of your computer.  

 If your OPC is running from a remote site you must 
make sure that DCOM™ is configured correctly to 
provide networking. Refer to Appendix F, 
Networking with OPC Using DCOM. 



Chapter 9   
Tags 

 About this chapter: 

This chapter describes how to define and use tags in Wizcon, as follows: 

Overview, on the following page, describes an overview of Wizcon tags. 

Defining Tags, page 9-4, describes how to add a tag, record tag value 
changes and communicate online with other applications through the 
DDE interface. 

Single Tag Input, page 9-24, describes how to assign an immediate 
value to a specific tag. 

The following options can be very useful in large projects:  

MultiAdd Tags, page 9-25, describes how to add a large number of 
tags to an existing tag list. 

Exporting Tags, page 9-29, describes how to generate a list of tag 
definitions into ASCII format. 

Importing Tags, page 9-33, describes how to import a list of tag 
definitions to append or to replace the current list of tag definitions. 

Defining Tag Properties, page 9-35, describes how to define some tag 
properties. 
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Overview 

The term Tags in Wizcon refers to control values monitored by the 
system. These values are similar to variables in a programming language 
such as BASIC, PASCAL, and C.  Like their programming counterparts, 
each value is identified by a unique name and can be one of several data 
types, such as integer, real, or Boolean. 

PLC tags are distinguished from other variables in that they can be 
associated with external device components, such as registers or I/O 
points in PLCs, memory locations in remote devices. A tag value 
represents the value of an external component or device, so that 
referencing the tag is equivalent to referencing the component or device 
itself. Updating a tag causes the external component or device to also be 
updated. Thus, a Wizcon PLC tag is actually a link to external devices. 

Once tags are defined in the Wizcon tag definition module, they can be 
used in other modules for displaying, calculating and control functions.  

Basic Principles 

In Wizcon, a tag can be associated with one of the following sources: 
PLC, Dummy or Compound: 

■ PLC Tags: These tags are associated with external devices and 
mapped to the external device variables (for example, PLC 
registers). Wizcon samples these tags periodically through the 
communication driver so that value changes in the field device 
variable are automatically transferred to the associated tag. PLC tag 
value changes in Wizcon are recognized in the external device. 
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■ 

■ 

■ 

■ 

■ 

■ 

Dummy Tags: These tags represent internal variables and are used 
for a variety of calculations, control and other application-related 
needs. Dummy tags are updated by user input or changed by other 
application modules. These tags are set to 0 upon system 
initialization. 

Compound Tags: Tags that are linear calculations based on values 
of other tags. 

System Tags:  Tags that are pre-defined and built to provide system 
status information. These tags can be added to an application only 
once either when Wizcon is activated or anytime afterwards.  Once 
added, System Tags will appear under the Tags icon in the All 
Containers pane.  When double clicked a list of all the System Tags 
in the application will open in the Control Panel. 

According to their data types, tags can be one of the following: 

Digital: Discrete logic tags that have Boolean values of TRUE (1) or 
FALSE (0). 

Analog: Tags that have numeric values represented in various 
formats (signed or unsigned integer, floating point, BCD). 

String: Tags which are defined to receive alpha-numeric strings. 

Tag Icons 

Wizcon marks tag-type with icons. Below are the Analog, Digital and 
String icons used to mark tags in the Studio Tag List. 

  Analog Tag 

  Digital Tag 

    String Tag  



 Defining Tags 

➤ To define a tag: 

Click the Tag  icon in the Wizcon Application toolbar to open the Tag 
Definition dialog box. 

Or, 

From the All Containers section of the Wizcon Application Studio, right-
click Tags and select Add Tag to open the Tag Definition dialog box.  

The Tag Definition dialog box has four tabs: 

General – used to create new tags and modify existing ones  ■ 

■ 

■ 

■ 

Record – defines how tag value changes will be recorded to history 

DDE interface - online communication method for other 
applications (such as Excel) 

Lock – enables tag values to be locked for a predefined period of 
time.  The Status Tag (digital) option indicates the locked tag status 
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General Tab 

The General tab defines a tag’s general properties.  This tab is dynamic 
and changes when either the Tag Source or Tag Type fields are defined. 

 

The following options are available: 

Tag Name Enter a unique tag name with no more than 32 
characters. 

Description Enter a brief description of the tag with no more 
than 254 characters. 

Groups  Click to display the Access Permission Manager 
dialog box in which you can define security groups 
so that only authorized operators can set the tag 
value.  
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Tag Source This field is divided into two sections: 
Tag source option 
Tag source parameters  
Click to display a drop-down list in which you can 
choose the source to work with: Your choice will 
determine the available tag source parameters. 
Dummy: select for internal application-related 
processing and needs. The Dummy tag has no tag 
source parameters. 
PLC: select to associate with a PLC driver.  
Compound: select for automatic calculations based 
on tag values.   

Tag Type This field is divided into two sections: 
Tag type  
Tag type parameters 
Click to display a drop-down list in which you can 
choose the tag type to work with. Your choice will 
determine the available tag type parameters. 
Analog (the default tag type) 
Digital  
String  
The default tag type is Analog.  



PLC Tag Source Parameters 

Note:  If drivers have not been previously defined then do so now.  For 
further information refer to the Communication Drivers chapter. 

➤ To open the Tag Source parameter fields: 

In the Tag Definitions dialog box click the arrow in the Tag Source field 
and select PLC.  The Tag Source field opens. 

 

Note:  The following parameters are available both when creating and 
modifying a tag. 

The following options are available: 

Driver Specifies the name of the driver responsible for 
communication with the relevant external device. 
The available communication drivers should be 
previously defined in the communication driver 
definition module. For a list of currently defined 
communication drivers, click on the arrow to the 
right of the field.  See page 9-9 for further details. 

Address The address string specifies the location of the tag 
data source in the PLC or other field device. 
Generally, the address represents combination of a 
PLC unit and PLC register number and type. The 
exact address format is specific for each PLC and 
depends on the driver used for the communication. 
For more details, refer to the driver on-line 
reference. 
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Sample External devices are sampled periodically to update 
the values of their associated tags. Therefore, a tag 
value always reflects the state of its associated 
device. Each tag is assigned its own sampling rate. 
However, if the device component, with which the 
tag is associated is included in a communications 
block, the block will ultimately determine the 
sampling rate. The following options are available: 

 Never: The external device is never sampled to 
update its respective tag. 

 In Monitor: The device is sampled to update its 
respective tag only when the tag's value is requested 
by one of Wizcon modules (for example, displayed 
in an Image). This option is useful for minimizing 
communications traffic, thereby improving system 
performance. Select this option for tags that are used 
for monitoring field activities and do not record into 
history files. Do not select this option for tags that 
are used for alarm definition. 

 Always: The device is always sampled to update its 
respective tag. If you select this option, specify the 
sample rate in seconds and/or milliseconds. 

Note: If the tag is included in a communication block, the block will 
ultimately determine the sampling rate.  Tags can be sampled at a rate 
of upto 40 milliseconds. 



➤ To Define OPC Source Parameters 

You can associate the tag you want to define with an OPC driver by 
clicking in the Tag Source field of the Tag Definition: New Tag dialog 
box and selecting the driver from the drop-down list. The Tag Source 
parameters will appear.  

Note:  The following parameters are available both when creating and 
modifying a tag. 

1. From the Driver drop-down list select the OPC driver. 

2. In the Address field click on the Browse button . The Add Item 
dialog box opens.  

Note that this dialog box opens only if your OPC Server supports 
Browsing. If not you must enter the address manually. 

  

3. From the Browse Items list, select the name of the item that you 
want to be linked to and click OK to complete the operation.  
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Compound Tag Source Parameters 

A compound tag is either an analog or digital tag, the value of which is a 
combination of two other tags.  

Note:  The following parameters are available both when creating and 
modifying a tag. 

➤ To define compound tags:  

Click in the Tag Source field of the Tag Definitions: NEW Tag dialog 
box, and select Compound from the drop-down list. The Tag Source 
parameters will appear:  

 

The compound tag formula is as follows: 

Constant1 * Tag1 oper Constant2 * Tag2

Where oper is one of the following operators: +, -, / (division), or * 
(multiplication).  Operators can be selected by clicking on the relevant 
operator. 

Note: In the tag field click on the arrow to the right of the fields, to 
obtain a list of available tags. 
 

Define the compound tag in the Calculate field as either In Monitor or 
Always. Select Always if you want the compound tag to be calculated 
always (also when the tag is not In Monitor). 
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After you define the formula, whenever the individual tags are sampled, 
the compound tag will be assigned a value according to the evaluated 
formula. 

Analog Tag Type 

Analog tags have numeric values represented in various formats (signed 
or unsigned integer, floating point, BDC). 

➤ To define an analog tag type: 

Click in the Tag Type field of the Tag Definitions: New Tag dialog box 
and select Analog from the drop-down list. The Tag Type parameters 
will appear as follows:  

 

The following options are available: 

Format This field is used to specify the data format of the 
external device. The options include: 

 Unsigned 16: Unsigned 16-bit integer. 

 Signed 16: Signed 16-bit integer. 

 BCD: 4-digit BCD format. 

 Float: 4-byte IEEE single-precision, floating point 
format. 

 Signed 32: Signed 32-bit integer. 

 Unsigned 32: Unsigned 32-bit integer. 

Tolerance Specifies the minimum amount of change that must 
occur to a tag value, since the last change, for an 
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event to be recognized. Using this parameter is a 
convenient way of smoothing sensor fluctuations.  

 Tolerance applies to analog PLC tags only. The 
value is in the external device measurement units 
(raw PLC units) and not engineering units (ref 
Conversion). 

Low/High Limit These fields specify the upper and lower limits of 
the tag's value. If the low limit you specify is greater 
than the high limit, then no limits are set. 

Conversion External devices normally generate values according 
to their internal format and in order to obtain the 
maximum accuracy. For instance, a temperature 
measured in the field, which is in the range between 
0 and 600 degrees, may be presented as a numerical 
range of between 0 to 65535. To convert the field 
measured value in engineering units, Wizcon uses 
the linear conversion. 

 Value 1 Measured: Measured raw value sample. 
 Value 1 Engineering: Corresponding engineering 

value sample. 
 Value 2 Measured: Another measured raw value 

sample. 
 Value 2 Engineering: Another corresponding 

engineering value sample. 
For example, if you specify the following:  
Value 1 Measured = 0. 
Value 1 Engineering = 0. 
Value 2 Measured = 1. 
Value 2 Engineering = 2.  
The converted value would be the raw PLC value 
multiplied by two.  

Note:  When converting a float tag value the result will always be a float 
number even if the tag format is WORD or DWORD. 



Digital Tag Type 

A digital tag type is a discrete logic tag with Boolean values of TRUE 
(1) or FALSE (0). 

➤ To define a digital tag type: 

Click in the Tag Type field of the Tag Definitions: New Tag dialog box , 
and select Digital from the drop-down list. The Tag Type parameters 
will appear as follows:  

 

The following option is available: 
Filter Used for debouncing, which is filtering out oscillations.  

This option is only available for PLC tags. 

String Tag Type 

A string tag can receive an alphanumeric string as a tag value. 

➤ To define a string tag type: 

Click in the Tag Type field of the Tag Definitions: New Tag dialog box 
and select String from the drop-down list. The Tag Type parameters will 
appear as follows:  
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In the Width field, specify the maximum number of characters that you 
want the string to include. The maximum length of a string tag is 255 
characters. 

Authorization Groups 

Security authorization can be added during tag definition.  This enables 
the group/user to sample tag value changes. 

This is implemented by assigning authorization groups/users to each tag. 
Operators who do not belong to any of the assigned groups will not be 
authorized to change tag values.  

Note: All operators can read tag values, but only authorized operators 
can change them. 

Operator authorization is discussed in more detail in the User 
Management chapter. 

Once a group is assigned to a tag, any operator who belongs to that 
group can perform tag value operations on that tag. 



➤ To assign groups to a tag: 

Click the Groups button to open the Access Permission Manager where 
authorized users and/or groups can be selected. 

 
1. Click the dropdown list above the Groups/User Name field and 

select the type of list required.  There are three list modes:   

List all Groups&Users - displaying a list of the application's 
defined groups and users  

■ 

■ 

■ 

List all Groups - displaying a list of the application's defined 
groups. 

List all Users - displaying a list of the application's defined 
users. 

2. To actually assign access permission select the relevant groups/users 
and click the Add button, or, click the Add All button to assign all 
groups/users. The selected groups users are now displayed in the list 
of Access Members. 
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3. To delete users/groups from the Access Members List, select the 
relevant groups/users and click Remove, or click the Remove All 
button.  

4. Check the All groups and users have access permission checkbox to 
assign access permission to all your application's groups and users. 

5. Click OK to confirm. 

Record Tab  

Click the Record Tab to access the Record tab dialog box to determine 
how tag value changes are recorded. 
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The following options are available: 

Never Specifies that tag value changes will never be 
recorded. 

Changes Specifies that the tag value will be recorded 
whenever it is sampled and is found to have changed 
by more than the tolerance since the previous 
sample. 

Update  Specifies that the tag value will be recorded 
whenever a driver is set to update the values (even if 
no changes were detected.) 

Every Specifies that the tag value will be recorded each 
specified time interval.  

ODBC Loging Specifies that tag value changes will be written in 
the same format both to the ODBC and to Wizcon 
history.  This option is available when either 
Changes, Update or Every is selected. 



Dynamic Data Exchange (DDE) Link Tab  

Click the DDE Link tab to access the DDE Link dialog box where how 
Wizcon communicates with other applications (such as Excel) can be 
defined. 

 

DDE is a common protocol that allows applications to exchange data 
freely, using either one-time data transfers, or ongoing transfers in which 
applications send updates to each other whenever new data is available.  

The DDE Link tab contains options that enable you to specify that the 
tag will be linked to another application through the DDE. This will 
cause the tag value to be updated immediately, whenever a change 
occurs in the object to which the tag is linked.  
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There are three options: 

In the DDE Type field click the arrow in the dropdown list and select 
either: 

None   Specifies that no DDE link is associated with the 
tag.  This is the default option. 

Single Specifies the application, topic, item name and type 
of link   

Block Specifies the block name, row, column and type of 
link   

DDE Type - Single 

Select Single from the Tag Definition dialog box for tags that will not be 
part of a DDE client block. 

 

The following fields define the DDE connection: 
Application The application to which you want to link the tag.  
Topic The topic in the application that contains the object 

to which the tag will be linked. 
Item Name The name of the item to which you want to link the 

tag. The name is taken from the application and 
topic to which the tag is linked. For example, an 
Excel cell number. 
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Link Enables you to define the DDE Link as: Always 
linked to the DDE server or In Monitor. When 
selecting Always, every change will be passed by 
WIZDDEC to WizPro, even if the tag is not In 
Monitor. 
WIZDDEC enables your Wizcon application to run 
as a DDE client and receive information from server 
applications. Refer to the Wizcon DDE Support 
chapter for more details about WIZDDEC.  

DDE Type - Block 

Select Block from the Tag Definition dialog box to connect a tag to one 
item from a DDE block. 

  
The following options are available: 

Block Name The block to which the tag will belong. 

Row The row number of the item in the block relative to 
the start position. 

Column The column number of the item in the block relative 
to the start position. 

Link Enables you to define the DDE Link as: Always 
linked to the DDE server or In Monitor. When 
selecting Always, every change will be passed by 
WIZDDEC to WizPro, even if the tag is not In 
Monitor.  

The WizDDEC block mechanism enables Wizcon to receive many tag 
values from the server in one update message. This improves the 
communication between Wizcon and the DDE server. 
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A common use for DDE client blocks is a setup in which a DDE server 
immediately updates a block of items building a recipe. Define DDE 
client blocks only if data items in the server change simultaneously 
(within milliseconds). For more details, refer to the Wizcon DDE 
Support chapter. 

PLC tags linked to DDE items will actually cause the DDE application 
to update the PLC, and the updated value sampled from the PLC will be 
automatically transferred to the DDE application. However, if any 
Wizcon module reads or writes tag values, it will first access the PLC 
tags and then update the DDE link. 

Lock Tag 

Click the Lock tab to access the Lock dialog box.  Tag values can be 
locked for a predefined period of time.  This could be for a short time or 
permanently.  
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The following options are available: 

Lock Tag  This field when checked enables the Lock 
Tag option. 

Tag value in locked state Specifies the value of the tag in its locked 
state.  The tag remains with this value until 
the date/time limits expire. 

Never expire  When checked defines that the tag will 
remain permanently locked. 

Lock until  Defines the time and date when the defined 
Lock Tag option expires.  

Status Tag  Defines the status of the locked tag (digital 
only). 

Station   Specifies a tag station. 

Tag  Specifies a tag name. 

➤ To modify a tag: 

1. In the All Containers section of the Wizcon Application Studio, 
click on Tags to display the List of Tags. 

2. In the List of Tags section, right-click the tag you want to modify 
and select Modify Tag from the popup menu. 

Or,  

Double-click on the tag in the List of Tags section. The Tag Definition 
dialog box is displayed in which you can modify the tag. 



➤ To delete a tag: 

1. In the All Containers section of the Wizcon Application Studio, 
click on Tags to display the List of Tags. 

2. In the List of Tags, right-click the tag you want to delete and select 
Delete Tag from the popup menu. A dialog box is displayed in 
which you can confirm your request or cancel it. 

➤ To find a tag: 

1. In the List of Tags right-click anywhere and select Find Tag from 
the popup menu.  The Find Tag dialog box opens. 

 
2. In the Find What field type in the name of the tag, its description or 

address. 

3. In the Conditions field select either; Tag Name, Description or 
Address (your selection will depend on the information you typed in 
the Find What field). 

4. Click Find.  The tag is highlighted in the List or Tags. 

5. To close the dialog box click Exit or anywhere in the Wizcon 
Application Studio. 
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Single Tag Input 

This section describes how to assign an immediate value to a specific 
tag.  

➤ To define single tag input: 

In the Control Panel of the Wizcon Application Studio, double-click the 

 icon. 

Or, 
From the Tools menu of the Wizcon Application Studio, select Single 
Tag. The Single Tag Input dialog box is displayed: 

 
The following options are available: 

Station Name  The Wizcon network station to which the tag 
belongs. 

Tag Name The tag for which the value is to be modified. Click 
on the arrow on the right side of the field to display 
a drop-down list of tags. When a tag is selected, its 
description is displayed underneath the Tag Name 
field and its value is displayed in the Current Value 
field. 

Current Value Specifies the current value of the selected tag. 
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New Value Enter the new tag value, or click on the arrows in 
the Suggest field slider, to determine a new tag 
value. 

Set Specifies a new current value that is written 
immediately.  

Suggest Specifies a new current value that is displayed in the 
New Value field and written by clicking Apply. 

MultiAdd Tags 

The MultiAdd operation is used to automatically generate a group of 
tags according to a user-defined pattern format.  

➤ To define tag pattern format: 

1. In the All Containers section of the Wizcon Application Studio, 
click on Tags to display the List of Tags. 

2. In the List of Tags section, right-click the tag you want to add to a 
group and select MultiAdd from the popup menu. The MultiAdd 
Tag Definition dialog is displayed: 

 

This dialog box is used to generate a pattern for tags to be added to 
the existing tag list. Once a pattern is defined for the Name format 
and Address format fields, you can activate the Generate button to 
add tags to the list according to the pattern you defined.  

The following options are available: 
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Name format The contents of this field can be any of the 
following characters: 
*: This character will remain as is in the next tag. 
A: This character will be incremented 
alphabetically. 
D: This character will be incremented in decimal 
numeric order. 
H: This character will be incremented in 
hexadecimal numeric order. 
O: This character will be incremented in octal 
numeric order. 
#: This character will cause whatever character 
appears in that position to be incremented according 
to its specific character type. If the character is 
alphabetical, it will be incremented alphabetically; if 
the character is numerical, it will be incremented 
numerically. Any other character will remain as is. 

Note: The MultiAdd operation increments only the 
tag name and address. 

For example, if the current tag name is WATER39X 
and the next name format was defined as 
*****DHA, the MultiAdd operation will cause the 
tag name WATER39Y to be generated. 
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Note that if the format length is less than the current 
name/address length, the format will affect the right 
part of the name/address. For example, if the name 
format was defined as **HHH, and the current name 
is WATER001, the next name will be WATER002. 

Address format  The contents used for the Name format field can 
also be used for the Address format field. 

Pattern and Step Specifies incremental amounts. You can enter any 
numerical value from 1 to 7. The Name and Address 
of the next tag will be incremented according to the 
amount specified in these fields. For example, in the 
Name format field, if you entered AA for the Pattern 
and 2 for the Step, the next tag will be called AC.  

Amount to add Specify the number of tags that will be added to the 
list when the Generate button is activated. 

 

After you set the MultiAdd definition, activate the Generate button to 
generate the specified tag pattern. 



System Tags 

System Tags are pre-defined, built in tags providing system status 
information. These tags can be added to an application only once either 
when Wizcon is activated or anytime afterwards.  Once added, System 
Tags will appear under the Tags icon in the All Containers pane.  When 
double clicked a list of all the tags in the application will open in the 
Control Panel. 

System Tags also hold information for the WizPLC integrated 
application. 

➤ To define Systems tags when opening the Wizcon program: 

If global tags have not been defined in your project then during 
application start-up the following message box will open on your screen. 

 
1. Click Yes to add system tags or No not to. 

2. Check the Never ask again checkbox to define this option. The 
System Tags icon will appear in the All Containers pane as a sub 
item of Tags.   

3. Double click the System Tags icon to view the List of System Tags.   
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➤ To define System Tags using the Tools menu: 

1. From the Tools menu select Add Systems Tags.  The following 
warning will appear on your screen. 

 
2. Click Yes to add System Tags.  The System Tags icon will appear in 

the All Containers pane as a sub item of Tags.   

3. Double click the System Tags icon to view the List of System Tags.   

Exporting Tags 

The Export Tags option enables you to generate a tag list file (list of tag 
definitions) in two formats: 

• ASCII – where files can be added. The list files are saved with a 
GLS extension 

• CSV as Excel files -  limited to numbers beginning with 0, for 
example tag addresses.  This is a convenient tool for editing.   

You can edit the file to add, modify or delete tags. You can then import 
the file back into the system.  
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➤ To generate a list of tag definitions: 

In the All Containers pane right-click on Tags and select Export Tags 
from the popup menu. The Tag List dialog box opens: 

 

This dialog box is divided into two fields: Filter and List Tags.    

Filter Name  - Specifies the tag you want to filter. 
Address  - Specifies the address you want to filter. 
Comm. Driver - Specifies the name of the 
communication driver. 

List Target Specifies the target destination of the generated list: 
Printer – the generated list will be sent to the 
defined printer. 
File (.GLS) – the generated list will be sent to file 
which can be either: 
Fixed format 
CSV 
 

1. Filter conditions can be set so that only specific tags will appear in 
the generated tag list.  

2. The Filter and Address fields in this dialog box are in From/To 
format and are used to set the tag list filter. In addition, you can 
specify the tag list target.  
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3. If File is selected as the target, the filename, without the path or 
extension, must be specified and then select Fixed or CSV.  The file 
will be placed in your Wizcon application directory. 

Fixed (GLS File) Format 

Tag list files (.GLS) are ASCII files that you edit, or create and add to or 
replace the existing Wizcon tag list. 

Note: Long tag names, address strings and additional parameters in tag 
definitions make length of a line in a GLS file over 256 bytes. In order to 
work with GLS files, use any Standard Windows Editor and set the Wrap 
option to OFF. 

The title line of the tag list file has the following format: 

;No., Name, Description, Groups, Rcd, Rcd

Rate, DDE

Params, Source, Source

Params, Type, Type

Params

Note: Any line that begins with a semicolon (;) will be ignored. 

Tag descriptions appear inside the characters < >. Addresses have the 
format driver address or empty spaces for dummy tags. 

For DDE-Params, the parameters are Link (Y/N), and 
<Application:Topic:Item>. 
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For Source-Params, the parameters are: 

PLC Driver address Smp Smp-Rate 

Dummy No parameters 

Compound Const1 Tag1 Oper Const2 Tag2 

For Type-Params, the parameters are: 

Analog Format Tol Conversion Min./Max. 

Digital Filter 

String Length 

The lines following the title line contain the tags and their corresponding 
tag information. 

The following is an example of a tag list: 

VERSION 8.0

; No. Name <Description> Groups Rcd Rcd-Rate
DDE-Params ication:Topic:Item> Source Source-
Params Type Type-Params RO Odbc Local Lock
LDef Lock-Value Status-Tag Unlock-time;
Driver Address SmpMod SmplRate Frmt
Tol/Filter/StrLen Conversion Min/Max

1 Dummy1 <> 00000001 N N DUMMY A U 0 0 1
0 1 1/ 0 N N N N N 0 <>
1001853938000

2 PLC1 <> 00000001 E 4294967294 S A
<Excel:Book1:R01C01> PLC 0 0001 A 1000 A
U 0 0 1 0 1 1/ 0 N Y N Y Y 0 <>
18446744073709551615 



Tags  9-33 

Exporting Tag Definition Files Using an External Application  

If you are using an external application you can export tag definition 
files using the command line or, save the option in the dialog box in a 
CSV file format. 

➤ To convert a tag definition file to CSV format: 

Type the following in the command line:  

■ gls2csv [fromfile] [tofile]  

Importing Tags 

The Import Tags option enables you to import a tag list file into the 
system. The imported file can replace the current list of tag definitions. It 
can also be appended to the current list of tag definitions.  

➤ To import tag definitions: 

In the All Containers section of the Wizcon Application Studio, right-
click on Tags and select Import Tags from the popup menu. The List to 
Tags dialog is displayed: 



 
1. In the Files of type field, select the type of file you want to import. 

You can choose between CSV and GLS. Locate the file you want to 
import and click Open. The Import Mode dialog is displayed. 

 

Click Replace to replace the alarms in the alarm list with the imported 
alarm, Append to add the specified alarm to the alarm list, or Cancel to 
cancel the import. 
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Importing Tag Definition Files Using an External Application  

If you are using an external application you can import tag definition 
files using the command line.  

➤ To convert a csv file to a tag definition file: 

Type the following in the command line:  

csv2gls [fromfile] [tofile] ■ 

 Defining Tag Properties 

You can define properties for the tag buffer size and the flush rate. 

➤ To define tag properties: 

In the All Containers section of the Wizcon Application Studio, 
right-click Tags and select Properties from the popup menu. The Tag 
Properties dialog is displayed: 
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The following options are available: 

Buffer size Determines the WizPro logger buffer size for history 
files, in lines (records). The maximum is 2048 
records. Increase the value of this option if you 
anticipate that a large number of changes will occur 
at any time during the Wizcon session.  

Flush rate: Determines a value that will represent the WizPro 
logger flush to disk rate in seconds (for history 
files). The maximum is 3600 seconds.  

Note: Restart Wizcon for changes to take place. 



Chapter 10   
Alarms 

 About this chapter: 

This chapter describes how to define and use alarms in the Wizcon 
system, as follows: 
Overview, on the following page, describes an overview of Wizcon 
alarms. 
Basic Principles, on page 10-2, describes the basic principles of alarm 
definition. 
Defining Alarms, page 10-4, describes how to define alarms, how to 
define a single action for an alarm and how to assign a name to alarm 
classes. 
Alarm Filters, page 10-3, describes how to define filters and apply tag 
counters to alarms. 
Alarm Help Files, page 10-15, describes how to create alarm help files. 
Alarm Properties, page 10-18, describes how to define a login and 
logout message, the time format that appears in the Events Summary 
and the alarm printout, and how to overwrite default print sequences. 
Exporting Alarms, page10-21, describes how to generate a list of 
alarms in ASCII format, and describes the ALS file format. 
Importing Alarms, page10-26, describes how to import alarm 
definitions from an ASCII file. 
Locating Alarms, page 10-34, describes how to locate an alarm in the 
List of Alarms in the Wizcon Application Studio. 
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Overview 

Alarms are configured application messages used to notify operators of 
exceptional conditions at the workplace. The Wizcon application 
generates automatic system messages that provide operators with 
information about internal system events, such as communication driver 
failure, network communication errors and others.  

Wizcon alarms can be targeted to and be displayed in the Events 
Summary, appear in a popup window, or be printed out.  
Alarms can be defined in order of hierarchy.  New alarms can be added 
(or existing alarms modified) to different levels of the hierarchy tree.  
Alarms can be defined according to attributes, inhibited, delayed, have 
Help messages containing instructions on how to handle the cause of the 
alarm and have comments attached to them.  They can also be recorded 
to history for report purposes. 

Basic Principles 

Only users with the appropriate authorization can define alarm 
conditions. Wizcon alarms are generated whenever predefined conditions 
exist.   

Up to 65,000 alarms can be defined in Wizcon. Each alarm can be 
assigned different characteristics and properties during the alarm 
definition procedure.  Alarms can be sent to different targets and be 
checked by different attributes. 
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Alarms in Events Summaries 

Alarms are written to the Events Summary.  If previously defined the 
operator can see a graphical display of the cause of the alarm, check 
Help for instructions in handling the alarm, acknowledge and end the 
alarm, add comments or inhibit (on the Internet) the alarm.  The Start, 
End and Acknowledgement time and date of the alarm can also be listed 
in the Summary Events.   

Alarm Objects in Images 

Wizcon enables you to visualize alarm conditions graphically by 
associating image objects with alarms. Alarm objects in images react to 
the conditions of the alarms in the alarm family with which they are 
associated. For example, if the alarm condition is true in the alarm 
family, the object may begin to blink or change colors.   

Alarm Filters 

Wizcon enables you to define filters and apply tag counters to alarms. 
The tag counters collect the specified alarm information that can be used 
in Images or WizSQL. The alarm filter is automatically activated when 
Wizcon is loaded. 

  



Defining Alarms 

Alarms are defined in the Wizcon Application Studio. After defining an 
alarm, you can assign a name to alarm classes, as described below. 

➤ To define an alarm: 

Click the Alarms  icon in the Wizcon Application Studio toolbar 

Or,  
In the All Containers pane of the Wizcon Application Studio, right-click 
Alarms and then select Add Alarm from the popup menu. The Alarm 
Definition dialog box opens.   
This dialog box has two tabs: 

General  - where general alarm properties such as Alarm Condition, 
Alarm Text, Zone, Family, Target, Attributes and Delay are defined.   

■ 

■ Action on Alarm  - where actions such as, Go to Zone, Execute 
Macro on Alarm and AAM Configuration are defined. 
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General Tab   

This tab is used to define general alarm properties. 

 
Alarm Condition This field defines the alarm conditions. 

Alarm Text  This field when completed shows a description of 
the alarm.  An alarm message can include tokens. 

Zone You can enter a zone area from 0 to 50,000. This 
value is used to classify and filter alarms in the 
Events Summary and Wizcon popup windows.  

Severity Specifies the priority order of each alarm. For 
example, a low priority could be 0 and a high 
priority, 50,000). It is also used for classification 
and filtering. 

Groups This option is used to assign groups of users to the 
alarm.  Alarm recipients can handle the alarm 
according to user authorization. 
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Family Specifies the name of the group to which the alarm 
belongs. The name can consist of up to 16 characters 
and is the link to alarm objects. It is also used for 
classification and filtering. 

Help File Specifies the name of the Help file that contains 
information for the operator. For more details about 
creating alarm help files, refer to the section on 
Alarm Help Files. 

Targets Specifies the alarm destination. The following 
options are available:  
Default Printer: The alarm message is sent to the 
printer defined as the alarms printer. 
Events Summary: The alarm is displayed in the 
Events Summary. 
Popup: The alarm is displayed in a Popup window. 
Popup buzz: The alarm is displayed in a Popup 
Events Summary that will buzz when the alarm is 
displayed. If you do not select this option, the Popup 
Events Summary will not buzz when the alarm is 
displayed even if it was defined to do so in the 
PopUp Buzz dialog box. 
User class: Enables you to identify an alarm and to 
classify it online and in historical Events 
Summaries. Select this option and click on the arrow 
on the right of the field to select an alarm user class 
from a drop-down list of predefined classes. Each 
alarm can be assigned only one class. 
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Attributes The alarm operational attributes include the 
following: 
System Wide: Alarms can be limited to a single 
station or distributed among several Wizcon stations 
using Wizcon network support facilities.  
If this option is selected, the alarm will be 
distributed to other stations in the network. It can be 
acknowledged from any station across the network. 
By default, alarms appear only on the station used 
by the operator. 
Auto Acknowledge: The system automatically 
acknowledges alarms (as they occur) as if already 
acknowledged by the operator. 
Auto END: The system automatically ends alarms 
(after they occur) as if the condition that caused the 
alarm to be generated has already terminated. 
Class at Acknowledge: Enables you to re-assign a 
User Class property to the alarm when the alarm is 
acknowledged. This means that you can change the 
routing of an alarm upon its acknowledgment. 
Record to File: Records the alarm in the alarm’s 
history file. 
Discard: Discards active alarms when the 
application is terminated. 
Exclude from Printing:  If this option is selected 
the alarm will not be printed. 
Inhibit: If this option is selected, the alarm will not 
be generated, even if the alarm conditions are true. 
This enables the operator to de-activate an alarm 
temporarily and then reactivate it. Alarms can be 
inhibited in the Events Summary during runtime. 
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Note: If an alarm is defined with both the Auto Acknowledged and Auto 
End options, it will be considered inactive and will not be displayed in 
the Events Summary. 

Delay Delay intervals can be defined during which time 
alarms will not be generated.  There are three 
options defining when the alarm will be reset: 

 Condition is false: Alarms will not be generated 
when the alarm condition is false (within the time 
delay). 

 Delay time ends: If the alarm condition is True, at 
the end of the defined time delay alarms will be 
generated.  This is without taking into consideration 
changes in alarm status during the delay period. 

 Never: The delay feature will not be imposed.   

Note:  The default is Never. 

Alarm Conditions 

Expressions are displayed in the Alarm Condition field in different 
colors and according to their expression type.  

■ 

■ 

■ 

■ 

■ 

Red for errors 

Black for operations 

Blue for correct tag names 

Olive green for functions 

Alarm Condition options consist of a list of tags, operators and functions 
from which you can build an expression.  

Tag - when selected a field box with an arrow is added to the Alarm 
Condition field. 
 



 
 
 

The Alarm Condition field is divided into two when the Tag  (right 
click on the field) option is selected from the popup menu.  The 
upper field enables selection of the Station Name whereas the lower 
field enables selection of a tag from this station’s tag list. 
 
Clicking the arrow to the right of the field displays a dropdown list 
of available tags from which you can select the required tag.  Only 
one tag can be added at a time to the Alarm Condition field. Clicking 
anywhere in the Alarm Condition field removes the tag field box and 
enters the tag into the expression. Tags can be written manually by 
first entering a @ and then the required tag name. 
 

■ 

■ Numeric Operator – when selected displays the following options: 
Option Description 

+ plus 

- minus 

= equal 

/ backslash 

% percentage 
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■ Relational Operators – when selected displays the following options: 
Option Description 

= = Equal 

!= Not equal 

<= Less than equal 

>= More than equal 

< Less than  

> Greater than 

 

■ Logical Operator when selected displays the following options 
Option Description 

AND Combines two conditions logically. 

OR Combines two conditions logically. 

NOT Negates the condition that follows it. 
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■ Function - when selected displays the following options: 
Function Syntax Description 

Log LOG(expression) 
where expression > 0 

Calculates base 10 
logarithm.  

Ln LN(expression) where 
expression > 0 

Calculates natural 
logarithm. 

Root ROOT(expression) 
expression>= 0 

Calculates square root. 

Min MIN(x,y) 
where both x and y are 
expressions. 

Returns the minimum out 
of the two parameters. 

Max MAX(x,y) 
where both x and y are 
expressions. 

Returns the maximum 
out of the two 
parameters. 

Power POWER(x, y) 
where both x and y are 
expressions. 

Returns the value of xy. 

Sign SIGN(expression) Calculates the sign. 
Returns –1 if 
expression<0 and 1 if 
expression >=0. 

Floor FLOOR(expression) Calculates the floor. 
Returns a floating-point 
value representing the 
largest integer that is 
less than or equal to 
expression. 

Bit BIT(B,I) 
where B is bit and I is 
Integer. 

Returns the bit (B) value 
from the Integer (I) value. 
Returns 1 if the bit B is 
set and 0 if the bit is 
reset. 
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Function Syntax Description 

Abs Abs (expression) Calculates absolute 
value. Returns the 
absolute value of 
expression. 

Sin SIN(expression) 
where expression angle 
is in radians. 

Calculates sine. 

Cos COS(expression) 
where expression angle 
is in radians 

Calculates cosine. 

Tan TAN(expression) 
where expression angle 
is in radians. 

Calculates tangent. 

 

■ Bit Operator – when selected displays the following options: 
Option Description 

OR Combines two conditions logically. 

AND Combines two conditions logically. 

XOR Exclusive OR. 

NOT Negates the condition that follows. 
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Alarm Text 

The alarm text can include the following tokens:  

@tagname Replaces @tagname with the current tag value when 
the alarm is started. 

@!tagname Replaces @!tagname with the value of the tag that is 
force read from the PLC when the alarm is started. 

@#tagname Replaces @#tagname with the value retrieved from 
the block to which the tag belongs, if the block is 
fresh. If the tag does not belong to a block, the @# 
control will function the same as @!. 

Note: The above three tagname tokens must be typed in lower case 
letters. Otherwise the system will not recognize them. 

$TIME The current time in Hours.Minutes.Seconds format. 
The value range is from 00.00.00 to 23.59.59. 

$DATE The current date in Day.Month.Year format. The 
value range is from 01.01.00 to 31.12.99. 

$HOUR The current hour. The value range is from 0 to 23. 

$MINUTE The current minute. The value range is from 0 to 59. 

$SECOND The current second. The value range is from 0 to 59. 

$DAY The current day. The value range is from 1 to 31. 

$MONTH The current month. The value range is from 1 to 12. 

$YEAR The current year. The value range is from 00 to 99. 

$WEEKDAY The current day of the week. The value range is 
from 1 to 7, where 1 is Sunday and 7 is Saturday. 

$OPERATOR The current operator name. The value is a string that 
represents the operator name. 

$GROUP The groups associated with the current operator. 



$INTIME The number of minutes that passed since midnight. 
The value is used for tag comparison and definition. 
The value range is from 1 to 1439. 

$INDATE The number of days that passed since January 1, 
1980. The value is used for tag comparison and 
definition. The value range is from 0 and on. 

Assigning Names to Alarm Classes 

This option is used to assign user-defined names to alarm classes. Alarm 
classes can be used to categorize alarms to identify them more easily, 
and to filter them in the system Events Summary. 

➤ To assign class names: 

From the Design menu, select Class Names. The Alarm User Class 
Names dialog box is displayed: 

 

The dialog box displays 16 default class names. Double-click on the 
default name to select it, and enter the new name. 
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Alarm Help Files 

Alarm Help files are user-created ASCII files.   Each Help File contains 
handling instructions for an associated alarm. The operator receiving an 
alarm can open the alarm’s Help File in the Events Summary by clicking 

the  assist icon or by right clicking on the alarm and selecting Assist. 

Help files can also be saved in HTML format and be sent to the operator 
via the Internet. 

Help Files can be created using any text editor.   However the Help File 
folder must be saved in the same location as the Wizcon application. 

System Help Files are saved as XXX.AHP ■ 

■ HTML Help Files are saved in a folder called DOCS as XXX.HTML 

After a Help File for an alarm has been created and saved in the Wizcon 
application folder it can be attached to an alarm in the Alarm Definition 
General tab. 

➤ To define a Help File: 

Click the Alarms  icon in the Wizcon Application Studio toolbar. The 
Alarm Definition dialog box opens.    
Or,  
In the All Containers pane of the Wizcon Application Studio, right-click 
Alarms and then select Add Alarm from the popup menu. The Alarm 
Definition dialog box opens.    

1. In the Help File field click the  browse icon.  The Open dialog 
box opens displaying Help Files folders. 

2. Select the relevant Help File and click Open to return to the General 
tab. 

3. Click Apply or OK. 
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Defining Action on Alarm 

You can define a single action for an alarm when it reaches one of three 
states: when it starts, when it is acknowledged and when it ends. When 
the alarm reaches the selected state, it will trigger a macro.  

➤ To define an action on alarm: 

In the Alarm Definition dialog box click the Action on Alarm tab.  The 
Action on Alarm dialog box will open.  

 
The following options are available: 

Go to Zone When selected an image of the zone specific to the 
alarm opens on the users screen when the alarm is 
generated. 
Image Defines the image file that will be opened 
when the alarm is generated. 
Zone Defines the specific zone in the image file 
that will be displayed when an alarm is generated. 
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Exclude Macro on Alarm 
Started: Enables defining an action when the alarm 
starts.    
Acknowledged: Enables you to define an action 
when the alarm is acknowledged.    
Ended: Enables you to define an action when the 
alarm ends.  
Create Macro: Macros can be attached to all three 
alarm states. Defined actions will be activated 
automatically by Wizcon for Windows and Internet 
at run-time. This feature makes building applications 
easier. The user does not need to use either Wizcon 
Language or an add-on to perform an action when 
an alarm changes its status.   

AAM  Enables configuration of alarm transmission to users 
and groups via printer, fax, e-mail, SMS, voice 
messages and other services.  Before configuring 
advanced alarm transmission verify that the 
appropriate drivers providing this service in 
Advanced Alarm Management are defined.    
Select Recipients:  Click Groups to define AAM 
recipients. 
File Association:  Add text file for the email 
message.   
Synchronize Alarm Text: If this checkbox is 
checked this text file is sent as a voice message.  
When this checkbox is not checked the For Voice 
WAV file will be defined. 
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➤ To define AAM transmission: 

In the Alarm Definition dialog box click the Action on Alarm tab.  

1. In the Select Recipients field click the Groups button to open the 
Alarm Recipients dialog box.  Select the relevant recipients and click 
Add and then OK.   

2. In the File Association field select a text file that will be attached to 
your e-mail, or will be sent by fax or to the printer. 

3. To send a vocal message, click the browse button and select a sound 
file (file of type *.wav).   

4. Click OK to confirm.   

Note:  Before configuring advanced alarm transmission, verify that the 
appropriate drivers providing this service in AAM are defined.  



Alarm Levels 

Alarms can be defined according to hierarchy.  Each alarm can be 
defined at a different level in the hierarchical tree.  Levels can be 
modified, added or deleted. Level definition contains most of the 
parameters used by alarm definition so that when one alarm level is 
defined and then modified its sub-levels also receive the same 
modifications.   

Alarm hierarchy is defined and viewed in the All Containers tree. 
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➤ To add a level: 

In the All Containers pane right click Alarms.  From the dropdown menu 
select Add Level.  The Alarm Level Definition dialog box opens. 

 
1. Type in the Level Name in the Level Name field of up to 253 

characters. 

2. The Modify field has the following sub-fields: 
Include Alarms, Change and Override.  Make your selection 
accordingly.   

3.  Click OK to confirm. 
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➤ To modify a level: 

In the All Containers pane right click Alarms and select Modify Level 
from the dropdown menu.  The Alarm Level Definition dialog box will 
open on your screen. 

Or, 

In the All Containers pane double click the Alarms icon.  A List of 
Alarms opens in the Control Panel. Select an alarm and either right click 
and select Modify Level or double click.  The Alarm Definitions dialog 
box will open on your screen.  

➤ To delete a level: 

1. In the All Containers pane right click Alarms and select Delete Level 
from the dropdown menu.   A message box opens on your screen. 

2. Click Yes to delete the alarm level.  The alarm level will be removed 
from the list. 

Exporting Alarms 

The Export Alarms option enables you to generate a list of alarms in 
ASCII or CSV format and send the list to the printer or a file. The 
generated list can also be filtered to include only specific alarms.  
Alarm lists can be generated and then edited using a text editor. Once 
generated, the list can be printed for project documentation. This is 
useful in large projects, where thousands of alarms must be defined. In 
this case, working with a text editor is faster than defining each alarm 
separately. 



➤ To generate a list of alarms: 

In the All Containers section of the Wizcon Application Studio, 
right-click Alarms and select Export Alarms from the popup menu. The 
Alarm List dialog appears: 

 

The dialog box contains filter options that you can select to determine 
which alarms will appear in the list that you want to generate. Each filter 
field is optional (except for the filename in the List Target field, which 
must be specified if you select the File option). 

The following options are available: 

No. Specifies the range of numbers of the alarms that 
you want to appear in the generated list. 

Tag Name Specifies the name, or name prefix range of the tags 
associated with the alarms that you want to appear in 
the generated list. 
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Family Specifies the name or prefix of the family to which 
the alarm belongs that you want to appear in the 
generated list. 

Severity The severity range of the alarms that you want to 
appear in the generated list. 

Zone The zone range of the alarms that you want to 
appear in the generated list. 

Targets The target specifications of the alarms that you want 
to appear in the generated list (any, none, or all can 
be selected). 

User Class Activate this button to select classes to filter the 
alarms that will appear in the generated list. After 
you activate this button, the Set User Class dialog 
box appears: 

 
 You can select one or more classes, so that only the 

alarms that belong to the classes will appear in the 
generated list. Activate the Set All button to select 
all the classes. Activate the Reset All button to 
deselect all the classes.  
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Attributes The attribute specifications of the alarms that you 
want to appear in the generated list. You may select 
any attribute, all of the attributes, or none at all.  

List Target  Specifies the target destination of the list to be 
generated: Printer or File (.ALS). You can select 
Printer to send the list to the printer, or File (.ALS) 
to save the list in a file with the extension .ALS. For 
File (.ALS), specify the name of the file without the 
extension. The file will be located in the application 
directory specified in the Set Default Paths dialog 
box. 

After you complete the dialog box and activate the OK button, an alarm 
list will be generated according to the filter you specified. 

ALS File Format 

This section describes the field definitions of an ALS file. An ALS file 
can be opened with any text editor. 

The following is an example of an .ALS file: 

;No. Tag Cond Value Text
Prt Ann Pop Buz Fil Sys AAc AEn Dis ClA Sev Zone
Name Help UserClass AOS AOA

0 T2 > 200 <Shutdown> N N N
N N N N N N N 0 0 <> <>
0 Y Exit

1 T3 = 150 <Open 3> N Y Y
N N Y N N N N 0 0 <MSG> <>
Admin
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The format of the file is as follows: 

The first line contains the alarm attribute fields. This line begins with a 
semicolon. 

Each remaining line contains one alarm definition. 
 

The fields in the alarm definition lines are as follows: 
No. Specifies the alarm original number.  
Tag Specifies the name of the tag associated with the 

alarm. 
Cond Specifies the conditional operator of the alarm 

condition.   
Value Any numerical value for the alarm condition. 
Text The text that will appear when the alarm condition is 

true. The text appears in brackets < >. 

Prt,Ann,Pop,  These fields represent the target specification of the 
Buz,Fil alarm. The value can be Y for Yes or N for No. 

Sys,AAc,AEn,  These fields represent the alarm attributes. The 
Dis,ClA value can be Y for Yes or N for No.  
Sev Specifies the alarm severity from 0 (lowest level) to 

50,000 (highest level). 
Zone Specifies the alarm zone number from 0 to 50,000. 
Name Specifies the alarm name (assigned in the alarm 

definition). The name appears in brackets <>. 
Help Specifies the name of the help file associated with 

the alarm (specified in the alarm definition). The 
name of the help file appears in brackets <>. 
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User Class Specifies the user class associated with the alarm. 
The value 0 represents no user class specification. 

Action on Alarm Specifies the name of the action macro, which can 
be attached to each state of the alarm.  

Exporting Alarm Definition Files Using an External Application  

If you are using an external application you can export alarm definition 
files using the command line. 

Note: WizPro must not be running during this operation.  

➤ To convert an alarm definition file to CSV format: 

Type the following in the command line:  

■ als2csv [fromfile] [tofile]  

Importing Alarms 

The Import Alarms option enables you to import alarm definitions from 
an ASCII file. You can use the imported ASCII file to replace the current 
list with the generated one, or append it to the current list of alarms. 



➤ To import alarm definitions: 

In the All Containers section of the Wizcon Application Studio, right-
click Alarms and select Import Alarms from the popup menu. The Open 
Alarm file for Import dialog box opens on your screen. 

 
1. In the Files of type field, select the type of file you want to import. 

You can choose between CSV and ALS. Locate the file you want to 
import and click Open. The Import Mode dialog box is displayed. 

 
2. Click Replace to replace the alarms in the alarm list with the 

imported alarm, Append to add the specified alarm to the alarm list, 
or Cancel to cancel the import. 
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Importing Alarm Definition Files Using an External Application  

If you are using an external application you can import alarm definition 
files using the command line. 

Note: WizPro must not be running during this operation.  

➤ To convert a CSV file to an alarm definition file: 

Type the following in the command line:  

csv2als [fromfile] [tofile] 

Alarm Properties 

This section describes how to define alarm properties also for predefined 
alarms. 

➤ To define alarm properties: 
 

In the All Containers section of the Wizcon Application Studio, 
right-click Alarms and select then Properties.  The Alarms Properties 
dialog box opens.  
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This dialog box has the following tabs: 

General  - where the message that appears when a user logs in and 
out is defined. This message is usually by default acknowledged and 
ended and can be viewed in the Events Summary and History.    

■ 

■ 

■ 

■ 

■ 

■ 

■ 

Time Format  - where the time and date format of the message is 
defined.  

Hotbackup - used when an application that has master backup is 
run.   

Network Communications – used during network communications 
failure. 

VPI Communication Error – used during communication failure 
between the application and communication drivers. 

User Login – defines how and where an alarm issued during user 
login/logout is written to.   

Wil Diskfull – defines when and how an alarm is sent when the 
computer disk is xxx full. 

Specifying a Login/Logout Message 

You can specify a message that will appear when a user logs in and logs 
out in the General tab of the Alarms Properties dialog box. 
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The following options are available: 

Avoid generating new alarms  Specifies that logins and logouts are 
not logged. Restart Wizcon for changes 
to take effect. 

Login Alarm Text Specifies the text you want to appear 
when a user logs in. This change can 
be implemented online. 

Logout Alarm Text  Specifies the text you want to appear 
when a user logs out. This change can 
be implemented online. 

Determining a Time Format  

You can choose between four different alarm time formats to determine 
the time format that will appear in the Events Summary and the Alarm 
printout, in the Time Format tab of the Alarm Properties dialog box. 
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The following options are available: 

Day + Time Displays a time format of month, time. 

Day + Time + MilliSeconds Displays a time format of month, time 
plus milliseconds.  

Date + Time Displays the full date and time. 

Date + Time + MilliSeconds Displays the full date and time plus 
milliseconds. 

Note: Restart Wizcon for changes to take effect. 

Determining Hotbackup  

 
This is a system filter used when an application that has master backup is 
run.     

Note: Restart Wizcon for changes to take effect. 
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Determining Network Communications Errors 

 

This is a system filter that defines backup during network 
communications failure.  Refer to Determining Hotbackup 10-31 for 
information regarding this tabs fields. 

Determining VPI Communication Errors 

 

This is a system filter used to communicate with other drivers.  Refer to 
Determining Hotbackup 10-31 for information regarding this tabs fields. 
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Determining User Login Parameters 

 

This is a system filter used to define how and where an alarm issued 
during user login/logout is written to.  Refer to Determining Hotbackup 
10-31 for information regarding this tabs fields. 

Determining WIL Diskfull 

 

This is a system filter that defines when and how an alarm is sent when 
the computer disk is xxx full.  Refer to Determining Hotbackup 10-31 
for information regarding this tabs fields. 
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Finding Alarms  

Wizcon enables you to locate alarms in the List of Alarms in the Wizcon 
Application Studio. This is especially useful if you have an application 
with many alarms. 

➤ To locate an alarm: 

1. Click anywhere in the List of Alarms and select Find from the Tools 
menu. The Find Alarm dialog box is displayed: 

  
2. Enter the alarm text in the Alarm Text field.  

3. Enter the alarm family in the Family field.  

4. Select the condition(s) by which you want to conduct the search in 
the Conditions area. You can choose between Alarm Text, Family 
name or Both. 

5. Click Find. The alarm is located in the List of Alarms. 

6. Click Exit or anywhere in the Wizcon Application Studio outside the 
List of Alarms to close the dialog box.   

Note:  The Alarms List can also be obtained by using the filter option in 
the Application Studio. 
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Chapter 11  
 Advanced Alarm 
Management (AAM)  

 About this chapter: 
This chapter describes Advanced Alarm Management 
(AAM), as follows: 
Overview, on page 11-2, describes an overview of the  
Wizcon network environment. 
Getting Started page 11-3, describes the basic requirements for AAM 
AAM Channels page 11-7, describes working with AAM Channels 
AAM Pager Services page 11-19, describes working with AAM Pager 
Services 
Advanced Alarm Viewer page 11-28, describes working with the 
Advanced Alarm Viewer 
Vocal Server Setup page 11-35, describes working with the Vocal 
Server Setup 
User Message Format page 11-47, lists different types of user message 
formats 

Advanced Alarm Management  11-1 



11-2 Wizcon for Windows and Internet User's Guide 

Advanced Alarm Management (AAM) Overview 

The Advanced Alarm Management (AAM) module provides additional 
alarm services. This is useful when critical alarms requiring urgent 
attention need to be sent, read and the cause of the alarm handled. 

The AAM module sends either alphanumeric or voice messages.  An 
alarm can be sent by SMS, pager, email, fax, printer, or as voice to single 
or multiple users.  An alarm sent by voice mail can be acknowledged and 
any messages sent with the alarm can be read. 

AAM messages can be sent to groups (defined in the User Management 
Module) and according to schedules set in the Users Timetable module.  

The AAM module supports multilanguage.  User messages can be 
translated into French, English or German. 

Advanced Alarm Management can be used in two modes: 

■ 

■ 

■ 

■ 

■ 

Demo mode:  Used for trial purposes, runs for two hours after which 
the user (developer) must restart the computer.  The voice option is 
not available.   

Plug with AAM option:  Authorized unlimited fulltime mode. 

The following AAM configuration module defines how and where an 
alarm is sent: 

AAM Channels – defining the modems (TAPI modem or modem 
connected to COM port). 

AAM Pager Services – defines the types of services used to send 
alarms (SMS, Email, Pager, Fax, Printer, Voice). 

Advanced Alarm Viewer – a real time log where outgoing alarms 
can be viewed. 
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■ User Timetable – where users within teams and groups work 
schedules can be defined. Alarms will be sent to users in realtime 
and according to work shift. 

Getting Started 

 
This section discusses basic work principles and requirements for using 
AAM. 

Requirements 

■ 

■ 

■ 

Network communications – LAN or regular modem. 

Plug authorization. 

Multi media hardware – soundblaster (for voice functionality only). 

Plug Upgrade 

Contact your Wizcon supplier for details regarding ordering a new plug 
or upgrading existing Wizcon software through the Remote Upgrade 
Service (RUS).  Or visit our website at www.emation.com to find your 
nearest supplier. 

http://www.emation.com/


Workflow for Alphanumeric Messages 

 

Step 4: 

Step 5: 

Step 6: 

Step 7: 

Step 1: 

Step 2: 

Step 3: 

Activate AAM module in the 
Station Properties dialog box 

Define COM modem 

Define email driver 

Define message recipients 
(User Management, Groups 
tab) 

Define alarm conditions (User 
Management, Messenger tab) 

Generate an alarm using the 
Single Tag tool 

Verify message status 
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Workflow for Vocal Messages 

 

Step 4: 

Step 5: 

Step 6: 

Step 7: 

Step 1: 

Step 2: 

Step 3: 

Activate AAM module in the 
Station Properties dialog box 

Define COM modem 

Define Vocal Driver 

Define synthesis engine 

Define message recipients 
(User Management, Groups 
tab) 

Generate an alarm using the 
Single Tag tool 

Verify message status 

Define alarm conditions (User 
Management, Messages tab) 

Step 8: 
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Configuring AAM 

Advanced Alarm Management is configured in the Station Properties 
dialog box Advanced Alarm Management tab. 

➤ To define Advanced Alarm Management: 

In the route of the All Containers pane right click on the project name.  
The Station Properties dialog box opens. 

 
1. Using the arrows scroll and select the Advanced Alarm Management 

tab.  

2. Check the Enable Advanced Alarm Management checkbox. 

3. Click OK to confirm and restart the Wizcon application.   
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AAM Channels 

Advanced Alarm Management communication lines (TAPI modem or 
modem connected to COM port) are defined in the Channels dialog box 
where channels can be added, removed, deactivated or be modified. 

 Quick Access Bar Icon 

The Quick Access bar icon takes you through all the AAM stages. 

 

The following configurations are available: 

Channels Setup (Tapi modem or modem connected to COM port). ■ 

■ 

■ 

Pager Services Setup. 

Vocal Server Setup. 

During runtime the real time Advanced Alarm Viewer shows statistics 
and an Events Summary. 
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Defining Channels 

➤ To specify AAM Channels: 

In the Quick Access bar click the  AAM icon  

In the Control panel of the Wizcon Application Studio, double-click the 

AAM Channels icon. 

Or, 

From the Design menu, point to Advanced Alarm Management and 
select Channels from the popup menu. The Channels dialog box is 
displayed. 
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The Channels dialog box has four buttons: 

Add This button, when clicked opens the Channel dialog 
box where TAPI modems and COM ports can be 
selected and added. 

Properties This button when clicked opens the Line Properties 
dialog box where communication line parameters 
can be configured. 

Remove This button when clicked removes a selected 
modem/or port from the list. 

Deactivate This button, when clicked deactivates a selected 
modem/port. 

TAPI Modem/COM Port setup Dialog Box 

In this dialog box you can view and select TAPI modems and/or physical 
COM ports. 

 

Select a modem, port or both and click the OK button.  The Line 
Properties dialog box opens on your screen. 
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Notes: 
By default all modems and physical ports defined in the system are listed 
in this dialog box.  To view TAPI modems or COM ports, check the 
Display only Modems and Display only Available COM ports 
checkboxes. 

We highly recommend you to use a modem connected to a COM port 
rather than a TAPI modem to enable maximum parameters control. 

TAPI Modem Properties Dialog Box 

 

Click the Setup button to open the standard Microsoft dialog box where 
setup modem parameters can be defined. 

Voice functionality:  The AAM module supports voice 
functionality with the TAPI modem if the 
modem driver also supports voice 
functionality. 

With Windows NT4:  Generally, modem drivers do not support 
voice function and AAM cannot be used 
with the TAPI modem.  Therefore, the COM 
port is connected to the modem.  
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With Windows 2000:   Most TAPI modem drivers support voice 
functionality and the AAM module can use 
TAPI modem for voice call management.  
Not all driver modems support voice 
functionality.  

➤ To check that a driver can manage voice functionality:  

In the AAM dialog box, click Setup. Add a TAPI modem, and click 
Properties to open a standard Microsoft dialog box. If in the Assigned 
Service on Incoming Call field the Vocal Server option is defined this 
means that your TAPI modem driver can handle voice calls and can be 
used by AAM. 

COM Port Properties Dialog Box 

 

This dialog box is used to configure the parameters of the 
communication line.  
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Line Properties has the following fields: 

Port The port number is the name of the port defined in 
the Channels or Channel Modem and Port dialog 
box.  

Keep Open When this option is selected AAM defines that this 
port remains open permanently solely for the 
Wizcon application.  If this checkbox is not checked 
then this modem/port will be opened on demand and 
when available and will be automatically closed 
when communication terminates.    

Type There are two port types: 
Hayes Modem - where communication is 
established through the telephone network 
Direct Communication - for example, a printer 
connected to the port 

Bauds, Bits, Parity Where port/modem communication bandwidth is 
defined  

Flow Control Where communication error control parameters are 
defined: 
None – no flow control 
Hardware – communication errors will be checked 
at the hardware level 
Xon/Xoff – communication errors will be checked 
at the software level. Xoff code (13h) request for 
data emission suspension sent to the transmitter who 
then returns Xon (11h) code to resume transmission.  

Assigned service This field assigns services to incoming calls: 
Direct line – assigned service that will manage port 
communication  
Modem – assigned service that will manage 
incoming call 

Prefix to dial The number dialed to receive an outside 
communication line. 



Voice Modem Modem used to carry voice messages. Voice modem 
parameters can be defined by clicking the  button 
to open the Modem Parameters in the Vocal Code 
dialog box. 

Fax Modem Modem used to carry fax messages. 

Modem CSM/PCS Where the parameters for this modem can be 
defined. Click the  button to open the GSM/PCS 
modem parameters dialog box. 

Reserved for Defines that this modem/port is reserved for 
incoming calls only. 

Automatic Setting Port/modem settings according to Wizcon 
definitions.  

Carrier Detect   DCD carrier settings. 

Modem Parameter Where the Hayes modem parameters are defined. 
 

1. Check the Keep open checkbox to enable port sharing between 
several applications. 

2. In the Type field select either Hayes Modem or Direct.   

3. Port baud rate should be defined as follows: 
Parameter  Value 
Baud rate 300-11520 
Bits  7,8 
Parity  Even, Odd, None 
Stop bits 1,2 
These parameters can be modified by the services using the port for 
outgoing calls according to the communication type established. 

4. In the Flow Control field select either None, Hardware or Xon/Xoff. 

5. In the Assign Service on Incoming Call field click the dropdown list 
and select the relevant service. 

6. In the Prefix to Dial field type the prefix used to access the outside 
communication line if relevant. 
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7. Select the relevant format type: 

• If a Hayes Modem has been selected then click the Modem 
parameters button to open the Hayes Modem Parameters dialog 
box. 

• If Direct has been selected in the Type field then select either 
Automatic connection, Connect detect or both. 

8.  Click OK to confirm.   

Modem Parameters in Vocal Mode 

This dialog box defines the parameters of the modem that transmits voice 
messages. 

➤ To specify modem parameters in vocal mode: 

In the Line Properties dialog box click the voice modem  button to 
open the Modem Parameters dialog box. 
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1. In the Modem field click the arrow to open the dropdown list and 

select a modem type. 

2. In the Sampling field click the arrow in the Rate field to select how 
often the transmission line is sampled and then select the number of 
bits per sample. 

3. In the Silence Detection Voice Receive field type in the silence 
detection period number (x100ms) and then in the Silence 
Sensitivity Tuner field select either; Low, Medium or High. 

4. DTMF tone detection can be either on Transmission, Reception or 
Command, select a mode. 

5. In the Other Parameters field type in the relevant parameters.  

6. In the Reinitialization in Vocal Mode field define baud level. 

7. In the Flow Control field select either None, Hardware or Xon/Xoff. 
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8. In the Begin and End Voice Communication fields type in the 
relevant number. 

9. Click OK to confirm. 

 Notes: 
To avoid noise problems on the phone line, select the hardware flow 
control option. 
The parameter Ringback Goes Away Timer (100 ms) enables 
synchronization of messages that are played during user download. By 
default this is defined at 50.  The value must be modified according the 
modem you use (with Olitec Speed Com 2000 the value could be 100). 

GSM/PCS Modem Parameters 

This dialog box defines the parameters of the GSM/PCS modem and the 
format of SMS messages. 

➤ To specify GSM/PCS modem parameters: 

In the Line Properties dialog box click the  button to open the 
GSM/PCS modem parameters dialog box. 

 
1. In the PIN number field type in the unique PIN number. 

2. In the SMS format field select either; Auto, PDU or Text. 

3. Click OK to confirm. 
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Hayes Modem Parameters 

This dialog box is used to define the Hayes Modem communication line 
parameters. 

➤ To specify Hayes modem parameters: 

In the Line Properties dialog box click the Modem Parameter button to 
open the Hayes modem parameters dialog box. 

 
1. In the Init String field type the command string that will be 

transmitted to the modem at interface initialization and at the end of 
each communication session. 

2. Specify the Dial field parameters: 
Prefix – type the string to be transmitted before the dial number 
Suffix – type the attention string to signal a modem command during 
data communication 

3. Specify the Hang-up field parameters: 
Prefix – type the attention string to signal a modem command 
during data communication 
Suffix – type the disconnection command 
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4. In the Originate Connection field type the command that will be sent 
to the modem to connect it after an incoming call received when the 
modem is setup for manual use. 

5. In the Answer Connection field type the connection command that 
will be sent to the modem when an incoming call is received and the 
modem is set up for manual use. 

6. Check the Hang-up by DTR checkbox to enable the DTR line to 
function as a command to disconnect the modem from the line. 

7. Type the number of rings the system waits before answering an 
incoming call. The type of answer depends on the service selected 
for incoming calls in the Line Properties dialog box. 

8. Select the Caller ID to enable a protocol generation for identification 
of the call dial number during incoming calls.  There are three 
protocol types: 
Formatted ID – analog voice modem with caller identification 
Unformatted ID – analog voice modem with caller identification 
Register S190 – ISDN modem, caller ID installed in the S190 
modem register. 

Note: To avoid problems during phone line connection add W to the 
ATDT for commands, for example; ATDTW.  This will cause the modem 
to generate an error when the phone line is not connected. 

➤ To modify Channel Line Properties: 

In the Channels dialog box select the specific port or modem and click 
the Properties button.  The Line Properties dialog box will open.  Refer 
to page 11-11 for further details.   

➤ To remove Channel Line Properties: 

In the Channels dialog box select the port or modem and click the 
Remove button..



 

➤ To deactivate Channel Line Properties: 

In the Channels dialog box select the port or modem and click the 
Deactive button. 

AAM Pager Services 

The AAM Pager Services module enables definition of a list of paging 
drivers and Call Management parameters.  New drivers can be added, 
existing drivers removed and driver setup can be configured. 

Defining Paging Service Setup 

➤ To define paging service setup: 

In the Quick Access bar click the  AAM icon.  

In the Control panel of the Wizcon Application Studio, double-click the 

 AAM Pager Services icon. 

Or, 

From the Design menu, point to Advanced Alarm Management and 
select Pager Services from the popup menu. The Paging Service Setup 
dialog box is displayed. 
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The Paging Service Setup dialog box has the following options: 

Installed Drivers A list of all drivers installed in the system. 

 Setup This option opens the setup dialog box for the 
selected service. 

Add This opens the Add Paging Drivers dialog box 
where drivers can be selected and added. 

Remove This button when clicked removes a selected driver 
from the list. 

Call Management This option defines the number of times 
transmission connection is attempted before a failure 
message is sent.  It also defines the time interval 
between each attempt. 
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Adding Pager Services 

This button when clicked opens the Add Paging Drivers dialog box. The 
list of drivers can be configured according to country and with/without 
the GSM modem. 

 
1. In the Paging Service Setup dialog box click the Add button to open 

the Add Paging Drivers dialog box. 

2. In the Country field click the arrow to open the dropdown list and 
select a country.  The Drivers list will show only the drivers 
available for the specific country. 

3. To enable the GSM modem, click the With GSM Modem checkbox. 

4. Select a driver from the Drivers list. 

5. Click OK.  The driver will appear in the Paging Service Setup 
Installed Drivers list. 
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Remove Pager Services 

This option removes a driver from the Installed Drivers list. 

Select the driver from the Installed Drivers list and click the Remove 
button.  The driver is removed from the list. 

Defining Call Management 

This field defines both the number of times connection is attempted 
before a failure message is sent and the timeout before each call attempt. 

1. In the Tries Number if Call Fails field type in the number of times a 
transmission is sent. 

2. In the Timeout before New Try field type in the number of seconds 
between each connection attempt. 

3. Click OK to confirm. 

Driver Setup  

This option defines the selected driver’s setup.  In general different 
dialog boxes open for different drivers. 

Email Driver Configuration (Direct SMTP connection) 

An SMTP server can be used to send email (directly) by defining the full 
address of the SMTP server given by the Internet provider. 



 

 

Email Driver Configuration (With Internet modem connection). 

Email can be sent through a modem and an Internet connection: 

1. Setup the Internet connection independently of Wizcon.  In the 
Email Driver Setup dialog box enter the name of the Internet 
connection. 
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2. Define the login and password of the connection. 

3. Click OK to confirm. 

11-24 Wizcon for Windows and Internet User's Guide 



SMS Driver Configuration 

Each country already has an SMS driver profile configured and therefore 
generally these do not need to be configured.  However, in most 
countries SMS messages are sent via TAPI or ERMES servers.  
Therefore, if the SMS driver profile is not in the list contact eMation for 
an updated configuration file. 
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Pager Driver Configuration 

Each country already has a page profile configured and therefore 
generally these do not need to be configured.  However, in most 
countries message pagers are sent via TAPI or ERMES servers.  
Therefore if the SMS driver profile is not in the list contact eMation for 
an updated configuration file 
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Fax Driver Configuration 

Note: To avoid flow communication problems select the hardware flow 
control option by clicking the More button.   

 

Voice Driver Configuration 

Note: No specific parameters are needed in the configuration of the 
voice driver. 
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Advanced Alarm Viewer 

The AAM viewer displays detailed information on all AAM alarms in 
the application. 

➤ To open the Advanced Alarm Viewer 

In the Quick Access bar click the  AAM icon.  The Advanced 
Alarm Management dialog box opens.  Click the Advanced Alarm 
Viewer to open the Advanced Alarm Viewer dialog box. 

Or,  

In the menu bar select Tools and then Advanced Alarm Viewer.  The 
Advanced Alarm Viewer opens.  
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Description of available statistics: 

Alarms in process Displays the number of alarms that are 
being processed 

Alarms processed Displays the number of alarms that have 
been processed 

Alarms well processed Displays the number of alarms that have 
successfully reached their destination 

Alarms processed with errors Displays the number of erroneous 
alarms generated 

Joined users Displays the number of users that have 
been reached  

Unreachable users Displays the number of users that cannot 
be reached  

Alphanumeric messages sent 
correctly 

Displays the number of alphanumeric 
message sent correctly  

Alphanumeric messages sent with 
error 

Displays the number of erroneous 
alphanumeric messages  

Vocal messages sent correctly Displays the number of vocal message 
sent correctly. 

Vocal messages sent with error Displays the number of erroneous vocal 
messages  

Alarms acknowledged Displays the number of alarms that have 
been acknowledged by user  

Alarms unacknowledged Displays the number of alarms that have 
not been acknowledged  
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Description of fields available in the Events Summary: 

Status Displays an icon according to the 
management status of the alarm  

AAM ID Displays the alarm identifier provided by 
the AAM module 

Date Displays the date the alarm was raised  

Time Displays the time that the alarm was 
raised 

User Displays the name of the user receiving 
the alarm 

Driver Name Displays the driver used to reach the user 

Destination Displays the destination address of the 
sent message 

Backup User Displays Yes if the user is the backup 
user, otherwise it displays No 

Detailed Status Additional informations on the AAM 
status 

More Details  This button when clicked opens the Event 
Log Journal  

 



Event Log Journal 

The Event Log Journal is a table that holds the historical record of all 
events detected by the Advanced Alarm Management module.  A new 
Event Log Journal file is opened every day where each event is written 
in order of occurrence.  The file is saved in the Trace folder located 
under the Wizcon bin folder in the following format: 

tYYMMDD.LOG

YY=year, MM=month DD=date 

➤ To open the Event Log Journal 

Click the Details button in the Advanced Alarm Viewer dialog box. 
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The Event Log Journal has the following fields columns and options: 

Date: The date of this Event Log Journal file 

Service: The AAM service where the event occurred, this 
could be Pager, Vocal Server or both 

Events: The Events button when clicked opens a list of all 
event types. 

Print: The Print button when clicked prints a copy of this 
page 

Time: The event time stamp 

Service: The AAM service where the event occurred, this 
could be Pager, Vocal Server or both 

Event: Label of the event including the event code number 
and name 

Identifier: The user whose station generated the event 

Information: Additional information regarding the event 

➤ To select the Event Log Journal date: 

1. In the Date field click the arrow to open the dropdown list.  

2. Select the relevant date.  The Log will show only the events that 
occurred on the selected date. 

➤ To select a service: 

1. In the Service field click the arrow to open the dropdown list.  

2. Select the relevant Service.  This could be Pager, Vocal Server or 
both.  The Log will show only the events that occurred in the 
selected service. 



➤ To select an event type: 

Click the Events button to open the Events Type list.  

 
1. Check the relevant event types.   

2. Click the All button to select all event types and None for no event 
types. 

3. Click Close to close the list.  The selected event types will be 
recorded. 

Customizing the Event Log Journal Window 

Each column in the Event Log Journal can be customized according to 
requirements. 

➤ To customize the Event Log Journal: 

Right click in the column you wish to customize to open the dropdown 
list options.  

➤ To define the column title: 

1. Select Column Title from the dropdown list to open the Column 
Title dialog box. 

2.  Type in the new name of the column and click OK.    
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➤ To define the column width: 

1. Select Column Width from the dropdown list to open the Column 
Width dialog box. 

2. In the Column Width field type in the new measurement and click 
OK.  

➤ To define the column position: 

1. Select Column Position from the dropdown list to open the Column 
Position dialog box. 

2. In the Column Position field type in the new position (range 1-5) and 
click OK.  The position of the column within the table will change 
accordingly. 

➤ To define column alignment: 

1. Select Column Alignment from the dropdown list to open the 
Column Alignment dialog box. 

2. In the Title Alignment field select either; Left, Center or Right. 

3. In the Column Alignment field select either; Left, Center or Right 
and click OK.  The column will be aligned accordingly. 

➤ To sort a column: 

Select Sort on Column from the dropdown list. The column in the Event 
Log List will be sorted accordingly. 

➤ To mask a column: 

Select Mask from the dropdown list. The column will be hidden. 



➤ To display a column: 

This option is used to retrieve masked columns. 

1. Select Display from the dropdown list to open the Column Display 
list. 

2. Select the columns you wish to display in the Event Log Journal 
table and click OK.  The selected columns will open in the table.   

➤ To print a column: 

Select Printing from the dropdown list to open the Printing Format list 

1. Select the columns you wish to print. 

2. Select printing orientation, which is either Default, Portrait or 
Landscape.  Click OK to print the column. 

Vocal Server Setup 

The Vocal Server dialog box configures the sound of the voice message 
defined in the Alarms dialog box Action on Alarms tab AAM field.  The 
voice can be defined as male, female, according to age, volume, pitch, 
rate, country of origin and more. 

➤ To open the Vocal Server Setup 

In the Quick Access bar click the  AAM icon.  The Advanced 
Alarm Management dialog box opens.  Click Vocal Server Setup to open 
the Vocal Server Setup dialog box. 
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This dialog box has the following fields: 

About This button when clicked opens the Vocal 
Server license agreement.  

Engine The Engine field defines the type of 
synthesizer. 

Test Message Type in the message of the alarm text  

Voice Synthesis Parameters: 
Advanced - this button opens the Voice 
Synthesis Parameters dialog box.   
Voice – this field defines the type of voice 
speaking the message 
Rate – this field defines how fast the 
message is spoken 
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Pitch – this field defines the pitch at which 
the message is spoken  
Volume – this field defines the volume at 
which this message is spoken 

1. In the Engine field click the arrow in the dropdown list and select 
ViaVoice Outloud 4.0. 

2. In the Text Message field type in the text of the voice message. 

3. In the Voice field click the arrow to open the dropdown list and 
select the voice type. 

4. In the Rate, Pitch and Volume fields slide the button to change 
parameters. 

5. Click the Advanced button to open the Voice Synthesis Parameters 
dialog box to make further changes to the voice. 

6. Click OK. 

Voice Synthesis Parameters 

The Voice Synthesis Parameters edits the voice of the voice message. 

This dialog box has four tabs: 

■ 

■ 

■ 

■ 

Voice – defines the voice label, gender, and other parameters. 

Features – defines voice language, dialect, style and more 

Dictionaries – holds lists of words, roots, abbreviations common to 
the module. 

Identifiers – lists the identifier codes recognized by the Id field. 



➤ To open the Voice Synthesis Parameters 

In the Vocal Server Setup dialog box click the Advanced button to open 
the Voice Synthesis Parameters dialog box. 

 

Voice Tab 

This tab has the following fields: 

Voice Characteristics This field defines the voice sound in the 
following options:  Label, vocal tract, pitch, 
speed, volume, head size, pitch fluctuation, 
roughness and breathiness. 

Describe As This option defines voice gender and age. 

Store This option displays the Edit Stored Voices 
list 

Edited Stored Voice This option is used to edit the Stored Voices 
list 
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Show/Hide Test Panel This option shows/hides the test panel where 
the defined voice can be tested, compared to 
another voice in the list and saved 

1. In the Speaker field click the arrow to open the dropdown list and 
select the speaker type.  The values in the Voice Characteristics tab 
change accordingly. 

2. Change the sound of the voice using the Voice Characteristic fields. 

3. Click Test to hear the voice. 

4. To change the voice gender click the Describe As button to open the 
Describe Voice As dialog box, where you can change the gender 
characteristics. 

5. Click the Show Test Panel button to compare the voice to another 
voice in the list. 

6. The Save Speaker button saves the voice to file. 

7. Click the Delete Speaker button to erase this voice. 

8. Click OK to confirm. 



Features Tab 

 

This tab has the following fields: 

Speaker This option when opened displays the 
Speakers list 

Native Language &Dialect This option defines language and dialect 

Style   This option defines type of speech 

Tag Processing This option defines how the selected tab will 
be processed: 
Interpret – causes all tags to be recognized 
and interpreted 
Treat as Unknown – causes all tags to be 
treated as unknown and processed according 
to the application’s definitions  
Speak – causes all unknown tags to be 
spoken as individual characters and numbers 
Ignore – causes all unknown tags to be 
ignored 
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Audio This option defines the Audio sampling rate 
used.  PC optimizes the sampling rate for 
the computer while Phone optimizes 
sampling rate for the telephone 

Show/Hide Test This option shows/hides the test panel 
where the defined voice can be tested, 
compared to another voice in the list and 
saved 

1. In the Speaker field click the arrow to open the dropdown list and 
select a speaker type. 

2. In the Native Language and Dialect field click the arrow to open the 
dropdown list and make your selection. 

3. In the Style field click the arrow to open the dropdown list and make 
your selection. 

4. In the Tag Processing field select the relevant processing method. 

5. In the Audio field select either PC (11.025kHz) or Phone (8kHz). 

6. Click the Show Test Panel button to compare the voice to another 
voice in the list. 

7. Click OK to confirm. 

Dictionaries Tab 

This tab is used to add or edit dictionaries and to define special word 
types. 



 

This dialog box has the following fields: 

Dictionary Type  There are three dictionary types: 
Special Words – contains entries which 
may include digits or other non-alphabetic 
symbols or entries that require translations 
with annotations, SPRs or other non-
alphabetic symbols 
Roots – contains the root of the word only 
Abbreviations – contains entries that 
include periods 

Edit When this button is clicked it opens the Edit 
Dictionary dialog box where you can add, 
edit, delete, add speakers, keys and 
translation  

Show/Hide Test This option shows/hides the test panel 
where the defined voice can be tested, 
compared to another voice in the list and 
saved 
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1. In the Dictionary Type field click the arrow to open the dropdown 
list and select a dictionary term. 

2. To edit a dictionary term click the Edit button to open the Edit 
Dictionary dialog box. 

3. Click OK to confirm. 

Edit Dictionary  

 

This dialog box has the following fields: 

Add This option when clicked opens the Dictionary 
Entry dialog box 

Edit This option when clicked opens the Dictionary 
Entry dialog box 

Delete When selected deletes the dictionary entry 

Key The string of characters that the dictionary searches 
for. Click this option to hear the pronunciation of the 
key 

Trans Click this option to hear the translation of the key. 
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1. To add a new dictionary entry, click the Add button.  The Dictionary 
Entry dialog box will open. Complete the fields as described on page 
11-44 and click OK to return to this dialog box. 

2. To edit a dictionary entry, select the entry and click the Edit button. 
The Dictionary Entry dialog box will open. Complete the fields as 
described on page 11-44 and click OK to return to this dialog box. 

3. To delete a dictionary entry, select the entry and click the Delete 
button.  The entry will be removed from the list. 

4.  Click the Key button to listen to the pronunciation of the key for the 
selected dictionary term. 

5. Click the Trans button to listen to the pronunciation of the 
translation that was provided by the user for the selected dictionary 
term.    

6. Click OK to confirm. 

Dictionary Entry   

This dialog box opens when the Edit Dictionary Add or Edit buttons are 
selected. 

 

This dialog box has the following fields: 

Key The string of characters that the dictionary searches 
for. 
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Translation The translation of the key that the dictionary 
searches for. 

SPR from Key Phonetic alphabet the dictionary searches for 

SPR fm Translation The phonetic alphabet that the dictionary searches 
for. 

1. In the Key field type in the new directory term. 

2. In the Translation field type in the way that the word should be 
pronounced. 

3. If the translation sounds correct click OK, if not continue modifying 
the spelling of the translation. 

4. For phonetic alphabet pronunciation click the SPR from Translation 
field. 

5. Click OK to confirm. 

 



Identifiers Tab 

The Identifier tab dialog box holds a list of identifier codes recognized 
by the vocal server.  

 
This dialog box has the following fields: 

Speaker This field when opened displays the Speakers list 

Description This field shows the description of the selected 
speaker 

Guide This field shows the Description field’s code 

Show/Hide Test This option shows/hides the test panel where the 
defined voice can be tested, compared to another 
voice in the list and saved 
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1. In the Speaker field click the arrow to open the dropdown list and 
select a speaker type. 

2. Click the Show Test Panel button to compare the voice to another 
voice in the list. 

3. The Save Speaker button saves the voice to file. 

4. Click the Delete Speaker button to erase this voice. 

5. Click OK to confirm. 

User Message Format 

This section shows message formats for different kinds of pager services. 

Email Message Format 
Station Name: Station1

Alarm Status: Alarm Started

Alarm Date/Time: Thursday August 30 2001, 10
Hours, 22 Minutes, 21 Seconds

Alarm Text: The test variable is equal to 46

Alarm Severity: 2

Alarm Zone: 15
Alarm Family: Electrical  

Note: The contents of the Alarm Text field will appear also in the Object 
of the email. 
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SMS Message Format 

St: Station1
Alarm Started: Thursday August 30 2001, 10
Hours, 57 Minutes, 46 Seconds, <The test
variable is equal to 46>
Svr: 2
Zn: 15
Fam: Electrical.

Pager Message Format 

Station Name: Station1
Alarm Date/Time: Thursday Augu
Alarm Text: The test variable is equal to 46
Alarm Severity:
Alarm Family: Electrical

Fax Message Format 

<Logo>

<Fax Message Header>

Station Name: Station1

Alarm Status: Alarm Started.

Alarm Date/Time: Thursday August 30 2001, 10
Hours, 22 Minutes, 21 Seconds

Alarm Text: The test variable is equal to 46

Alarm Severity: 2

Alarm Zone: 15

Alarm Family: Electrical
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Printer Message Format 

Station Name: Station1

Alarm Status: Alarm Started

Alarm Date/Time: Thursday August 30 2001, 10
Hours, 22 Minutes, 21 Seconds

Alarm Text: The test variable is equal to 46

Alarm Severity: 2

Alarm Zone: 15

Alarm Family: Electrical

Voice Message Format 

Station name is: Stations1
Alarm started at:
Date is: Thursday August 30 2001, 11 Hours, 12
Minutes, 28 Seconds
Severity is equal to
Family is: Electrical. 

Notes: 
An introduction message will be played before the alarm message.    An 
alarm message can be acknowledged by pressing the * character 
afterwhich a confirmation message will be played. 
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Chapter 12  
 Users Timetable 

 

 About this chapter: 

This chapter describes the Wizcon Users Timetable module. 
Users Timetable Overview, on the following page, discusses the basic 
User Timetable options. 

Customizing the Users Timetable, on page  12-5, discusses how to 
create a personalized teams schedule. 

Selecting the Schedule Time Frame, on page 12-7 discusses how to 
create time frames. 

Scheduling Teams, on page, 12-10, discusses how to create a team 
schedule. 
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Users Timetable Overview 

The Users Timetable module enables efficient management of the 
application’s workforce teams.  Using this module teams can be selected 
and scheduled in a calendar environment, which can be either; daily, 
weekly or yearly.  For further timetable management efficiency each 
team can be allocated a specific color. 
Commands and options in the Users Timetable module are performed 
through the module’s menu bar, toolbar or by right clicking in the 
timetable.  

Timetable intervals can be locked or unlocked.  This could be to reserve 
time period cells for scheduled teams or for defining public holidays and 
so on. 

➤ To access the Users Timetable: 

In the Quick Access Bar click the  icon.  The Set Users Timetable 
dialog box opens. 
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Menu bar 

The Users Timetable menu bar has the following options and commands: 

Menu Option Sub Option 

File Save 
Print 
Exit 

 

Select all  Edit 

Clear  Clear all 
Clear selected 
Clear row 
Clear column 

Fit to view all  

Gridlines Both 
Vertical 
Horizontal 
None 

View 

Team name 
Week separator 

 

 

Options Set time intervals 
Stop marking 
Headers font 
Colors 

 

 



Toolbar 

The Users Timetable toolbar icons have the following options and 
commands: 
 

Icon  Description 

 
Save current group timetable 

 Print current group timetable 

 Clear group timetable 

 
Insert row to the timetable 

 
Remove the row from the timetable 

 
Set timetable interval 

 
Lock selected cells in the timetable 

 
Unlock selected cells in the timetable 

 
Toggle stop/start marking in the timetable 
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Customizing the Users Timetable 

The Users Timetable fonts and colors can be customized to meet your 
personal requirements.  Additionally rows and columns can also be 
added or removed. 

➤ To customize the timetable font: 

1. In the Options menu select Headers Font.  The Font dialog box 
opens. 

2. Select and define the font type, style and size. 

3. Click OK to confirm. 

➤ To customize timetable colors: 

1. In the Options menu select Colors.  The Colors dialog box opens. 

 
2. Click the dropdown menu in each field to display a color palette. Select 

the relevant color. 

3. Click OK to confirm. 
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Note:  When a group with teams is selected for the first time the teams 
are assigned random colors. 

➤ To customize timetable gridlines: 

1. In the View menu select Gridlines.  The Gridlines sub menu opens. 

2. There are four options: 
Both – displays both horizontal and vertical gridlines 
Vertical – displays vertical gridlines only 
Horizontal – displays horizantal gridlines only 
None – displays no gridlines 

➤ To insert time rows: 

1. Click the  icon or right click in the table area to open the popup 
menu and select Insert time row.  The Insert New Time dialog box 
opens. 

 
2. Using the arrows scroll up or down to define the new time. 

3. Click OK to confirm. A new row with the new time will be added to 
the table. 

➤ To remove time rows: 

1. Select the specific row and then click the  icon or right click in 
the table area to open the popup menu and select Remove time row.  
The time row is removed. 
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Selecting the Schedule Time Frame 

The Users Timetable has three time frames each of which changes the 
appearance of the table.  The frames are:  

Daily – displays a 24 hours work schedule ■ 

■ 

■ 

Weekly – displays a weekly work schedule 
Yearly – displays a monthly schedule with upto 31 days per month 

Notes:  The start day can only be set in a weekly time frame whereas 
start and end times can be set in all time frames. The Daily/weekly/ 
Yearly Schedule field is activated only after a group with teams is 
selected. 

➤ To customize a time frame: 

 

1. In the Options menu select Set Time Intervals or click the  icon.  
The Set Time Intervals dialog box opens. 

2. In the Time Interval field define the period of time that each time 
cell represents.  The default is 60 minutes. 
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3. In the Day Start At and Day Ends At fields use the arrows to scroll 
and define the new time.  The default is 00:00. 

4. Select the day of the week that the timetable begins. 

Note:  The Yearly Schedule field at the bottom of the dialog box is for 
reference purposes only. 

Yearly Schedule 

The Yearly Schedule displays a month by month view of the yearly 
calendar. In turn, each month can be split into weeks. 
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➤ To customize a yearly time frame: 

1. In the Select Group field click the dropdown arrow to open the 
groups/teams list. 

2. Select the relevant groups and then in the field above select Yearly 
schedule. 

3. To select a month either click the month fields arrow to open a 
dropdown list or scroll backwards/forwards using the   buttons. 

4. To select a year click the Year field’s arrow and scroll down to select 
the relevant year. 

5. Click the  button to display the current month’s calendar. 

6. If you have made changes to the User Timetable and wish to return 
to the timetable that is currently saved in the database click the 

 button. 

➤ To customize a weekly calendar in a yearly time frame: 

1. In the View menu select Week Separator. The timetable is marked 
with weekly gridlines. 

➤ To lock/unlock time intervals: 

 

1. Select the specific time cell and then click the  icon.  The selected 
time cell will be locked. 

2. To unlock a time cell select the relevant cell and click the  icon. 
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Notes:  

1. This option is only available in the Daily and Weekly options.  

2. Time cells can only be locked when the Stop Marking option is on.  

3. Locked Time cells remain locked even when the group changes. 

Scheduling Teams 

Teams are groups of users defined in Alert Groups. When an alarm is 
generated and targeted to a specific group of users, the team that is 
scheduled in the Users Timetable at that specific time will receive the 
alarm. 

Note:  Users/Groups/Teams are created in the User Management 
module. 

➤ To schedule a team: 

 
1. Click the Select Group dropdown list to display all the application’s 

Alert Groups.  A + sign to the left of the group’s name indicates that 
the group has teams. 
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2. Click the relevant team.  The team will now appear in the List of 
Teams. 

3. To change the team color code, right click on the specific team to 
open the Change Teams Color dialog box, and select a color.  The 
team’s color identifier will change to the selected color both in the 
List of Teams and in the Users Timetable. 

4. To schedule a team, select a team and in the Users Timetable click 
the relevant table cells.  The cells will be painted the team’s color 
identifier and the name of the team will appear in the cell. 

➤ To print a user timetable: 

1. To print a timetable either click the  icon or select Print from the 
File menu.  The Print option dialog box will open. 

2. Check that the Printer parameters are correct and Click OK. 

➤ To save a user timetable: 

To save a timetable either click the  icon or select Save from the File 
menu.   

Mark/Stop Marking Options 

Time cells can be automatically marked according to row, column or 
specific cell.  The Stop Marking option prevents time cells that are not 
included in a team’s time scheduling from being marked. 

➤ To activate/deactivate the marking option: 

1. In the Option menu check that the Stop Marking option is not 
activated. Or, click the  icon.   

2. Select the team for which the time cells are allocated.   

3. Select the first time cell and then right click to open a popup menu.   

4. Select either Mark Entire Column or Mark Entire Row accordingly. 

Users Timetable  12-11 



5. To deactive the Marking option either; click the  icon or from the 
Options menu select Stop Marking or right click in the Users 
Timetable to open the dropdown list and select Stop Marking. 

Note: Stop Marking is deactivated when a new team is selected.   
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Chapter 13   
Alarm Filters, Printers and 
Printer Targets 

 About this chapter: 

This chapter describes Alarm filters, Printers and Printer Targets and 
how to configure them as follows: 
Overview, on the next page describes Alarm filters, Printers and Printer 
Targets and their functionality in the Wizcon program. 

Defining Printers, page 13-4, describes how to define printers and their 
various functions. 

Defining Alarm Filters, page 13-12, describes alarm filters and their 
functionality in the Wizcon program and how to define their different 
parameters. 

Defining Printer Targets, page 13-18, describes printer targets and 
their functions in the Wizcon program.  
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Overview 

Alarm Filters 

The Alarm Filter filters alarms and reports before they are printed out or 
written to the Events Summary.  Alarm filters are displayed in the Alarm 
Filters table and defined or modified in the Filter Properties dialog box.  
Filter properties can be updated, however the name of a filter cannot be 
changed.  

The Alarm Filter filters the alarms sent when parameters defined in tag 
variants are not met.   

After alarms and reports outside the defined categories have been filtered 
out by the Alarms Filter, the remaining alarms are sent to the Printers 
defined in the Printer Targets module. 

Printers 

The Printers dialog box enables enhanced printing capabilities.  Each 
printer added to a system can be set to print reports, alarms or both.  In 
addition a definition can be made where many alarms are printed on a 
full page or whether only one alarm is printed on each page.  Page 
orientation and font can also be defined. Alarm properties that are 
printed can also be set together with different colors, text and 
background. 
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Printer Targets 

A Printer Target is a collection of pre-defined filters and printers 
specifying the conditions under which the targeted printer is activated. 

The Printer Target dialog box holds a list of all the printer targets that 
have been defined.  Each printer target is identified by a unique name 
and description.   

Workflow 

This section describes the order of the steps required for defining 
Printers, Alarm Filters and Printers Targets.  

 

Step Description 
Define tags Tags definition. 

Define alarm Alarm definition. 

Define Printer The Printer module has three tabs; General, 
Alarm Properties and Color.   

Define Alarm 
Filter 

Alarm filters are attached to alarms. The 
Alarm Filter filters alarms according to 
family, severity, zone and classes.   

Define Printer 
Target 

The Printer Target dialog box connects 
between the defined filters and printers.   

 



Defining Printers 

The Printers dialog box provides enhanced printing capabilities.  Each 
printer added to a system can be set to print reports, alarms or both.  
Printers can also be Network printers that are shared by multiple users. 
In addition, you can define whether many alarms will be printed on a full 
page or whether only one alarm will be printed on each page. Page 
orientation, font and printed alarm properties can also be defined and 
printed in different colors, text and background. 

 

➤ To specify printers: 

In the Control panel of the Wizcon Application Studio, double-click the 
Printer icon. 
Or, 

From the Design menu, point to Options and select Printers from the 
popup menu. The Printers dialog box is displayed: 

The Printers option has four tabs: 

General ■ 

■ 

■ 

■ 

Alarm Properties 

Colors 

Line Printers 
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General Tab  

 
1. To define a printer either, click the name of a printer from the 

Printers List or click the arrow in the Select Printer field’s dropdown 
list and select a printer. 

2. Printers can be added or deleted from the Printers List.  To add 
printers to the Printers List click either Local Printer or Network 
Printer. Double click the name of a printer in the List and OK to 
confirm.  To delete a printer select a printer and click Delete Printer.  
The printer will be deleted from the list.   

3. Report, Alarms or both can be printed.  In the Use Printer For field 
check the relevant checkbox(es) to define this option. 
Alarms:  This option has backwards compatibility.  This means that 
alarms from previous versions that have the Default Printer option 
selected will print to the defined printer. 
 
Reports:  This option has backwards compatibility (see Alarms 
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above) and also prints reports. 
Default Printers:  This option can be selected by itself or together 
with Alarms or Reports or both.   

4. The Alarm Print Options has three options, Full page, One alarm per 
page or Line printing, click the relevant option.  

5. In the Orientation field click either Portrait or Landscape. 

6. To change font style or color, click the Choose Font button and 
select a font or color. 

7. Click OK to confirm. 

Notes: 

1. When the Network Printers button is clicked the Network Browser 
opens. Browse to open the Network Place directory where a list of 
the computers that have shared printers is located. Select the 
relevant computer name from this list and then select a printer. 

2. Only one Alarm and one Reports printer can be defined per 
application.  This means that the remaining printers will all be 
Default.  If one printer has both Reports and Alarms selected then 
all other printers in the application will be Default. 

3.  The Line Printing tab only opens when this option is clicked in the 
Alarm Print Options and is for Dot Matrix printers only.  



Alarm Properties Tab 

 
1. To define a printer either, click on the name of a printer from the 

Printers List or click the Select Printer field’s dropdown list and 
select a printer. 

2. Printers can be added or deleted from the Printers List.  To add 
printers to the Printers List click either Local Printer or Network 
Printer. Double click the name of a printer in the List and OK to 
confirm. To delete a printer select a printer and click Delete Printer.  
The printer will be deleted from the list. 

3. The Columns Order field lists the column fields and the order in 
which they will appear in the printout. Check the relevant column in 
the list to define this option. 
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4. The order in which columns appear in the printout can be defined 
using the following buttons: 
 
Move Up Moves a column up one space. 
Move Down Moves a column down one space.  
Select All  Selects all the columns in the options list. 
Deselect All Removes all the columns in the options list. 
Default  Resets to the default options list. 
 

5. Click OK to confirm these changes. 

Note:  When Network Printers is selected the Network Browser opens. 
Browse to open the Network Place directory where a list of the 
computers that have shared printers is located. Select the relevant 
computer name from this list and then select a printer. 



Colors Tab 

Note:  Alarms should first be defined in the Alarm Definition dialog box 
tabs and in the Printers/General tab. 

 
1. To define a printer either, click on the name of a printer from the 

Printers List or click the Select Printer field’s dropdown list and 
select a printer. 

2. Printers can be added or deleted from the Printers List.  To add 
printers to the Printers List click either Local Printer or Network 
Printer. Double click the name of a printer in the List and OK to 
confirm.  To delete a printer select a printer and click Delete Printer.  
The printer is deleted from the list. 

3. Select either Zone or Severity.  Additional zones can be entered, by 
typing the zone number in the sequential textbox.  The highest zone 
number indicates the report/alarm urgency. 
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4. Colors can be added to text. Each alarm/report type can be defined a 
different color.  To add/change a color click the (empty) color box to 
open the color chart, select a color and click OK.  The color will be 
added to the list.  

5. In the Background field select either Zone or Severity.  Additional 
zones can be added by typing the zone number in the sequential 
textbox.  The highest zone number indicates the alarm’s urgency. 

6. To add/change a background color, click the (empty) color box to 
open the color chart, select a color and click OK.  The color will be 
added to the list and appear as background color on the printout.   

Note:  Color can be defined for Windows mode printing. 

Line Printing Tab 
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Note:  This tab only appears after Line Printing is defined in the Alarm 
Print Options of the General tab. 

1. To define a printer either, click on the name of a printer from the 
Printers List or click the Select Printer field’s dropdown list and 
select a printer. 

2. Printers can be added or deleted from the Printers List.  To add 
printers to the Printers List click either Local Printer or Network 
Printer. Double click the name of a printer in the List and OK to 
confirm.  To delete a printer select a printer and click Delete Printer. 

3. An escape sequence is a set of characters giving additional 
commands to the printer regarding printing format.  Each printer has 
its own escape sequence, which is usually written in the printer’s 
manual.  

4. The number of characters in each line can be defined.  To do so 
either type in the number or use the arrows to scroll up/down. 

5. The number of lines on each page can be defined.  To do so either 
type in the number or use the arrows to scroll up/down.  The digit 0 
indicates continuous printing. 



Defining Alarm Filters 

 
When the value of a tag deviates from the values set in the Single or 
Multiple Tag dialog box an alarm is sent to the relevant station.  The 
Alarm Filters module filters alarms according to family, severity, zone 
and classes. 

In the Control panel of the Wizcon Application Studio, double-click the 
Alarm Filters icon. 
Or, 

From the Design menu select Alarm Filters. The Filter Alarms dialog 
box is displayed: 

The Alarm Filters dialog box has four columns: 
Alarm Filters   Displays an Alarms Filters list 
Tag for Started&Unacked Number of active alarms 
Tag for Started&Acked  Number of acknowledged alarms 
Tag for Ended&Unacked Number of alarms that were 

activated and not acknowledged 

Alarm filters can be added, updated and deleted. 
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➤ To add Alarm Filters: 

To define an Alarm Filter click the Add button located under the Alarm 
Filter list.  The Filter Properties dialog box opens. 
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There are three tabs:   

General ■ 

■ 

■ 

Network 

Counters 

General Tab 

This tab holds general information about the alarm filter. 

1. In the Name field type a unique name for the alarm filter. 

2. In the Description field type a short description of the alarm filter. 

3. Click the Family field’s arrow to open the dropdown list and select a 
family. Only alarms from this family will be displayed. 

4. In the Severity field specify the Minseverity and Maxseverity fields. 
Alarms out of these fields will not be displayed. 
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5. In the Zone field specify the Minzone and Maxzone fields. Alarms 
out of these zones will not be displayed. 

6. Click the Select Class button to open the Set Class Filter dialog box. 
Filter classes can be used to categorize alarms to identify them more 
easily and to filter them in the Events Summary. Classes can be 
added and removed individually or as a group by clicking the Set All 
and Reset All buttons. Click OK to return to the General tab. 

 
7. Click OK to actually save the Alarm Filter definitions. 

Note:  The Family name list is defined in the Tags dialog box in the Tag 
Name field.   
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Network Tab 

This tab is used to define the Filter Alarm’s network station.  The 
stations appearing in the List All Stations list are active in the Network 
menu.   

 
1. In the List All Stations column select the relevant station.  

2. Either double click the station name or, click the  button.  The 
station name will be transferred to the Selected Station column. 

3. To remove a station from the Selected Station list click the  
button.  

4. Click OK to confirm. 
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Counters Tab 

This tab displays the status of the number of alarms in the system. 

 
1. To enable the fields in this dialog box check the Enable Count 

Alarms checkbox. 

2. In each field click the arrow to open the dropdown list and select the 
tag that will be counted. Do not select system tags. 

3. Click OK to confirm.  The defined fields will appear in the Alarm 
Filter dialog box. 

➤ To change Alarm Filters specifications: 

1. To change an Alarm Filter either double click the alarm filter in the 
list or select the Alarm Filter and click the Change button located 
under the Alarm Filter list.  The Filter Properties dialog box will 
open. 
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2. Change relevant parameters using the instruction for Adding Alarm 
Filters page 13-13. 

3. Click OK to confirm.  The changes will appear in the Alarm Filters 
list. 

➤ To delete an Alarm Filter: 

1. To delete an Alarm Filter select the alarm filter and click the Delete 
button located under the Alarm Filter list.   A message box will open 
asking if you are sure that you want to delete this alarm filter. 

2. Click Yes to delete the Alarm Filter. 

3. Click OK to confirm. 

Defining Printer Targets 

A Printer Target is a collection of pre-defined filters and printers 
specifying the conditions under which the targeted printer is activated. 

The Printer Target dialog box holds a list of all the printer targets that 
have been defined.  Each printer target is identified by a unique name 
and description.   

➤ To specify Printer Targets: 

In the Control panel of the Wizcon Application Studio, double-click the 
Printer Target icon. 
Or, 

From the Design menu select Printer Target. The Set Printers dialog box 
is displayed: 



 
1. To add a printer target click the Add button.  The Target Definition 

dialog box opens.   

2. To modify a printer target select the printer target in the Name 
column and click the Modify button. 

3. Printer targets can be deleted.  To do so select the printer target in 
the Name column and click the delete button. 

4. To load a printer target, select the printer target in the Name column 
and click the Load button.  A √ will appear in the checkbox next to 
the selected printer target.   

5. To unload a printer target select the printer target in the Name 
column and click the unload button.  Or uncheck the checkbox of the 
selected printer target   

Note:  When a printer target is loaded and an alarm that meets the filter 
criterion is generated, the alarm will be sent automatically to the printer 
defined for printing alarms. 
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➤ To specify Target Definition: 

A Target Definition is comprised of a user defined name and description 
and a selection of printers and filters.  This dialog box opens when either 
the Add or Modify button is clicked in the Printer Target dialog box. 

 
1. Type the name of the target in the Name field.  

2. Type a description for the target in the Description field. 

3. In the List all Selected Filters field select the relevant filter.  To add 
filters to this list click the Select Filter button to open the Select 
Filter dialog box.  Select a filter, click Add and OK to confirm. 
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4. In the List all Selected Printers field select the relevant printer.  To 
add printers to this list click the Select Printers button to open the 
Select Printers dialog box.  Select a printer, click Add and OK to 
confirm. 

5. To automatically load the printer target during Wizcon application 
start up click the Load at Application Startup button and click OK.  
The printer target now appears in the Printer Targets list. 

Note:  The Name must be unique. 
  



13-22 Wizcon for Windows and Internet User's Guide 

 



Chapter 14   
Events Summaries 

Web-disabled

 

For the Web refer to the Events 
Summary Profiles chapter. 

 About this chapter: 
This chapter describes the Wizcon Events Summary module, as follows: 
Overview, on the following page, describes an overview of the Wizcon 
Events Summary features. 
Creating and Modifying Events Summaries, page 14-3, describes 
how to define an Events Summary, how to close an Events Summary 
window, and how alarms are displayed in the Events Summary. 
Operations, page 14-5, describes how alarm messages are handled in 
the Events Summary module. 
Settings, page, describes how the layout of the Events Summary is 
defined and filtered.  It also discusses the Online and History modes. 
Reports page 14-30 describes how reports are made and their options. 
It also discusses the Alarm History Folder. 
Popup Events Summary, page 14-34 describes an Popup Events 
Summary, how to design it and to define its parameters, and how to 
make a Popup Events Summary buzz to indicate a severe warning 
Events Summary Properties, page 14-46, describes how to define 
Events Summary tuning parameters and Events Summary window 
attributes. 
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Overview 

The Events Summary is a window in which alarms are displayed. 
Several Events Summaries may be created each with different types of 
alarm categories.  This enables the operator to identify the type of alarm.  
Alarms in the Events Summary can be classified according to several 
groups, and insignificant events and information can be inhibited for 
operator convenience. 

Events Summaries operate in one of two modes, Online or History.  

■ 

■ 

■ 

■ 

■ 

In the Online mode, only active alarms are listed (according to the 
specified filters).  

In the History mode, a historical list of alarms is shown in the Events 
Summary (according to the specified alarm filter) and can be 
directed to the Internet, Intranet, operator’s screen, fax, file, or a 
printer. 

The Events Summary can display alarms generated on any Wizcon 
station on the network. This way, an operator can see alarms of the same 
logical functional group from different parts of the controlled area. 

Alarms are displayed in default colors, specified during Application 
Setup. Different colors for background and foreground (text) can be 
defined for each severity range and zone, but event time (Start Time, 
Ack Time and End Time) colors are assigned by the system and cannot 
be changed. 

The event time colors are: 

Start Time Red 

Ack Time White 

End Time Green 



Creating and Modifying Events Summaries 

This section describes how to create a new Events Summary and how to 
modify an existing one.  

➤ To create an Events Summary: 

Click the Events Summary  icon in the Wizcon Application Studio 
toolbar. 
Or,  
In the All Containers section of the Wizcon Application Studio, 
right-click Events Summaries and select New Events Summary from the 
popup menu. The Events Summary window appears as follows:  
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Toolbar 

Icon Command 

 Save Event Summary 

 Print Event Summary 

 Go to Zone: Displays a graphical view of location 
where the alarm occurred 
 

 Assist: Opens either Html or system Help holding 
instructions for handling the alarm 

 Ack All: Acknowledges all alarms in the Events 
Summary. Once acknowledged these alarms will be 
deleted from the list. 

 Ack Selected: Acknowledges only selected alarms 
in the Events Summary. Once acknowledged these 
alarms will be deleted from the list. 

 
Force End: Acknowledges unacknowledged alarms. 

 
Messages: These can be added and read by users. 

 
Add Comments: These can be added and read by 
users. 

 
Online: Toggles between the Online and the History 
mode.  

 Inhibit: Locks alarms for a specific period of time. 
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Operations 

The options in the Operations menu can be applied to each individual 
event in the Events Summary or, as in the Ack All command to all the 
events. 
To perform any operation on alarms in an Events Summary (except for 
Ack All), the alarm must first be selected. When an alarm is selected, it 
appears in a light gray color. Selecting an alarm again will cancel the 
initial selection.  Alarms that were modified, added, or deleted, will be 
sorted immediately into their correct locations. 

Option  Action 

Go to Zone Jumps to the graphical display of the cause of the 
alarm 

Assist Opens either a system or Html Help file where 
instructions for handling the event are displayed 

Ack All Acknowledges all the alarms in the Events 
Summary list 

Ack Selected Acknowledges only the selected alarms in the 
Events Summary list 

Force End Manually acknowledges an unacknowledged 
alarm 

Messages Messages added to the alarm 

User 
Comments 

Comments added by an operator to the alarm 
which can be read by other operators 

Inhibit Alarms that have been frozen for a predefined 
period of time 

 



Notes: 

1. Events Summary operations can be performed only by 
authorized operators.  

2. Authorization is defined during Application Setup.  These 
options can also be accessed by right clicking an alarm to open 
a popup menu. 

Go to Zone 

This option when selected jumps to a graphical display of the cause of 
the alarm.  The zone is defined in the Images module and attached to an 
alarm in the Alarms module - Alarms Definition dialog box - Actions on 
Alarms tab.  

➤ To activate the Go to Zone option: 

Select the alarm in the Events Summary and then select Go to Zone from 
the Operations menu.  

Or,  

Select the alarm and then right click to open a popup menu. Click Go to 
Zone 

Or, 

Select an alarm and then click the  icon. 
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Assist 

This option when selected opens either a system or Html Help file where 
instructions for handling the event are displayed.    

➤ To activate the Assist option: 

Select an alarm in the Events Summary, and then select Assist in the 
Operations menu. 

Or,  

Select an alarm in the Events Summary, and then right click to open a 
popup menu. Select Assist. 

Or, 

Select an alarm and then click the  icon.  The Assist message box 
opens. 

 

Assist information is taken from alarm Help files.  
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Note: Alarm help can also be obtained by double-clicking on any alarm 
(for which a Help file exists) in the Events Summary. 

Ack All 

The Ack All option acknowledges all the alarms in the Events Summary. 

➤ To acknowledge all the alarms in the Events Summary: 

Select an alarm in the Events Summary, and then select Ack all in the 
Operations menu. 

Or,  

Select an alarm in the Events Summary, and then right click to open a 
popup menu. Select Ack All. 

Or, 

Select an alarm and then click the  icon.   

Alarms defined with the Class-at-Ack option are displayed individually, 
showing the Set User Class dialog box in which you can assign a class to 
each alarm.  

If Acknowledge Time (Ack) appears in the Events Summary, the current 
time will be displayed in white. 

The Events Summary can hold between 0-4000 alarms and can 
acknowledge between 2-1000. 

You can display the name of the station from which the alarm was 
generated. The station name can also be used as a sort parameter.  
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Ack Selected 

This option when selected acknowledges only the selected alarms in the 
Events Summaries list.  If the Acknowledge Time (Ack) appears, the 
current time will be displayed in white. If the Ack column is sorted, the 
order of the alarms will change accordingly. 

If the ACK value was specified for the ANN_DOUBLE_CLICK 
parameter in the WIZTUNE.DAT file, an alarm can also be 
acknowledged by double-clicking the alarm. 

Note: Alarms that are Acknowledged and Ended will not appear in the 
Events Summary. 

➤ To acknowledge selected alarms in the Events Summary: 

Select an alarm in the Events Summary, and then select Ack selected in 
the Operations menu. 

Or, 

 
Select an alarm in the Events Summary, and then right click to open a 
popup menu. Select Ack selected. 

Or, 

Select an alarm and then click the  icon.   
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Force End 

This operation is used to force alarms to end. This is useful to remove 
alarms that cannot be ended due to communication or equipment 
modifications, or other causes. An alarm that was force ended will be 
removed from the Events Summary. 

➤ To force alarms to end: 

Select an alarm in the Events Summary, and then select Force end in the 
Operations menu. 

Or,  

Select an alarm in the Events Summary, and then right click to open a 
popup menu. Select Force end. 

Or, 

Select an alarm and then click the  icon.   

If End appears in the Events Summary, the current time will be 
displayed in green. 

Messages 

This operation is used by the operator to spontaneously record alarm 
messages in the system. This enables the operator to immediately record 
special activities or outstanding events. 

The operator can also overwrite an existing operator message (entered 
manually or automatically), and also view the edited message. This 
option can be used, for example, to record only part of an on-going 
process for display, or to modify a message to meet a particular 
requirement. 
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All messages, whether entered manually or automatically, are recorded 
and can be retrieved. 

➤ To record a new alarm message: 

Select an alarm in the Events Summary, and then select Message in the 
Operations menu. 

Or,  

Select an alarm in the Events Summary, and then right click to open a 
popup menu. Select Message. 

Or, 

Select an alarm and then click the  icon.   

 

Alarms that are entered manually are assigned the default severity level 
0, and the name MSGn, where n stands for the number of the alarm in 
the order of manually entered alarms (MSG1, MSG2, etc.). Manually 
entered alarms are always acknowledged. You can also edit a message 
and view the edited text, as described on the following page. 

➤ To edit an existing message: 

Select a message from the list in the Events Summary, then select 
Message from the Operations menu and change the text. 
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➤ To view the changes made to the message: 

Select the message in the Events Summary and then select Assist from 
the Operations menu.  

Notes: 

1.  Using the above options, you cannot change the text of system 
alarms (alarms defined by selecting Alarms from the Design menu in 
the Wizcon Studio Application, or by right-clicking Alarms in the All 
Containers section of the Wizcon Application Studio). 

2. An assistance file (.AHP) is generated for each operator message. 
This file contains all the operator message text except for the latest 
message entry. 

User Comments  

Comments regarding an alarm can be added to each alarm in the Event 
Summary.  This feature is used by operators to keep track of significant 
events occurring in the plant.   

■ 

■ 

■ 

Comments can only be added if the Record to File attribute has been 
added to the alarm. 

Comments can be created in Online mode only but can be viewed in 
both Online and History modes. 

If in the History mode there are already comments then new 
comments can be added. 



➤ To add comments to an alarm: 

Select the alarm in the Events Summary and then select User Comments 
from the Operations menu.  

Or,  

Select the alarm and then right click to open a popup menu.  Click User 
Comments. 

Or, 

Select an alarm and then click the  icon. 

The User Alarm Comments dialog box opens. 
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1. Type in your comments in the New Comments textbox and then 
click the Add button.  Your comment will be entered in the Previous 
Comments textbox. 

2. To clear a message from the textbox, select the message and click 
the Clear button. 

3. Click OK to confirm. 

Inhibit 

The Inhibit option is used to periodically freeze an alarm for a 
predefined period of time.  This feature is useful during maintenance 
when alarms can be deactivated and then reactivated when necessary.  At 
runtime alarms can be inhibited from the Events Summary. 

Selecting the Inhibit option from the Events Summary window opens the 
Internet Explorer where selected alarm levels can be inhibited. 

➤ To inhibit an alarm: 

Select the alarm in the Events Summary and then select Inhibit from the 
Operations menu.  

Or,  

Select the alarm and then right click to open a popup menu.  Click 
Inhibit 

Or, 

Select an alarm and then click the  icon. 

1. Select the level that you wish to inhibit and then check the Inhibit 
checkbox. 

2. Click the Modify buttons to activate the changes. 
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3. To reactivate an inhibited alarm, select the alarm and uncheck the 
checkbox. 

4. Click the Modify buttons to activate the changes. 

Settings  

Alarms can belong to several classifications. The Settings menu in the 
Events Summary window is used to determine which alarms will be 
displayed in the Events Summary and their order, alarms text and 
background colors. It is also used to view a list of alarm filters and 
alarms in historical and online mode. The following display options are 
available: 

Option Description 

Display Specifies which alarm fields will be displayed in 
the Events Summary 

Filter Assigns values to alarm classifications so that the 
Events Summary will display only the alarms that 
meet these specifications. 

Online Choose between Online mode for a list of alarms 
as they occur in the system, or History mode, for 
a list of historical alarms 

 



Alarm Display Setup 

The Display option is used to specify which alarm components will be 
displayed in the Events Summary. 

➤ To specify alarm components: 

Select Display from the Settings menu. The Display dialog box opens. 
This dialog box has four tabs: 

 

General: Where the Events Summary parameters 
for alarm Help text and for the alarm list are defined. 

■ 

■ Columns: Where the alarms content fields 
displayed in the Events Summary and Popup Event 
Summary windows are defined. 
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■ 

■ 

Colors: Where text and background colors of the 
alarms displayed in the Events Summary and in the 
Popup Events Summary windows are defined. 
Colors are determined by the alarm Severity or 
Zone. 

Events Summary Profile Settings: Where 
parameters used to monitor alarms on a Web 
browser are defined. 

General Settings 

The General Settings dialog box defines Event Summary parameters for 
alarm Help text and for the Alarms List. 
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This dialog box has the following fields: 

Number of Alarms in Events 
Summary   

This field defines the maximum number 
of alarms in the Events Summary.  The 
default is 3200 

Max Number of Alarms for 
Ack All Operation 

This field defines the maximum number 
of alarms that can be acknowledged in 
an Ack All operation.  The default 
number is 500 

Alarm Help Text Status This field defines the status of alarm 
help: 
Assist – instructions for handling the 
alarm appear in Help files either system 
or Html 
Ack – acknowledges the alarm 
Assist and Ack – both acknowledges 
the alarm and has Help file instructions 

Choose Font When clicked opens the Font dialog 
box where font type, size, style and 
color can be defined 

Advanced This button when clicked opens the 
Events Summary Window Attributes 
dialog box  

Note: Setting Window Attributes is not applicable on the Web. 
 



Events Summary Window Attributes 

In this dialog box, you can assign default attributes to all windows of the 
type you selected (Image, Charts, Events Summary, or History Viewer).  

 

This dialog box has the following fields:  

Title Bar: The line in the window containing the title name. 
This is relevant only if the Title Bar is On.  

Name in Title: The text appearing in the Title Bar. 

System Menu: The menu that appears when you click on the small 
box at the top left corner of a window.   This menu 
contains items that can be used to manipulate 
windows (move, size, close, etc.).  

Min/Max Button: The buttons that appear in the upper right corner of 
a window. These buttons can be used to shrink or 
enlarge the window to predetermined sizes.  

Size Border: Window borders that when clicked can be dragged 
to change the window size.  

Menu Bar: The line in which the window menus appear.  
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Always on Top: Select to display the window viewport on top of 
other open applications.  

Pos: The window X and Y position coordinates in pixels.  

Size: The window size in pixels. 
 

Columns Tab 

This tab defines the column fields that will appear in the Events 
Summary. 

 

The following options are available: 

Columns This field defines the columns that will be displayed 
in the Events Summary.   

Move up Moves the column one space up in the Events 
Summary window. 
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Move down Moves the column one space down in the Events 
Summary window. 

Select All Selects all the column options 

Deselect All  Deselects all the column options 

Default Returns this dialog box to the default options 

Alarm Colors 

The Colors tab is used to assign alarm text and background colors 
according to their severity level or zone to alarms displayed in the 
Events Summary and Popup Events Summary.  Up to 10 different colors 
can be defined for the text and background (10 for each). 

 
1. Under Text/Background select either Zone or Severity to define 

whether the text/background colors pertain to the alarm severity or 
zone.  
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2. The values entered in each column represent ranges for which the 
sample colors will apply. The values should be entered in ascending 
order. 

3. Each value has a color box that displays the selected color.  To 
change this click the color box to display a standard colors dialog 
box, where you can select a color or define a custom color. 

4. Click OK to confirm. 

Events Summary Profile Settings Tab 

This dialog box defines alarm monitoring on a Web browser.  
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➤ To modify an Events Summary: 

In the Wizcon Studio List of Events Summaries right click on the Events 
Summary to open a popup menu.  If the Events Summary is open then 
the properties option is enabled.  Click Properties, the Events Summary 
dialog box is displayed. 

1. Modify the existing Events Summary following the instructions for 
creating an Events Summary. 

2. Click OK to confirm. 

➤ To exit the Events Summary: 

Select Exit from the File menu, or double-click on the icon in the upper 
left corner of the Events Summary window.  

 Filter 

The Filter option is used to assign values to each of the alarm 
classifications so that the Events Summary will display only the alarms 
that meet these specifications.  Alarms are filtered according to family, 
severity, zone and classes.  New filters can be added, existing filters can 
be modified or deleted.   



Defining Filters 

➤ To add filters: 

Select Filters from the Settings menu. The Filters dialog box opens. 

  
1. To add a filter, select a filter from the All Defined Filters list and 

then click the Add button.  The filter will be added to the Selected 
Filters list. 

2. Click OK to confirm. 

➤ To delete a filter from the All Defined Filters list: 

1. Select the relevant filter from the list  

2. Click the Delete button.  A message box will open asking if you are 
sure that you want to delete the filter. 

3. Click Yes or No accordingly.  The filter will be removed from the 
list. 
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➤ To remove a filter from the Selected Filters list: 

1. Select the relevant filter from the list  

2. Click the Remove button.  The filter will be removed from the list. 

➤ To create a new filter: 

1. To create a filter, click the New button.  The Filter Properties dialog 
box opens. 

 

There are three tabs; General, Network and Counters. 
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General Tab 

This tab holds general information about the filter. 

1. In the Name field type a unique name for the filter. 

2. In the Description field type a short description of the alarm filter. 

3. Click the Family field’s arrow to open the dropdown list and select a 
family. Only alarms from this family will be displayed. 

4. In the Severity field specify the Minseverity and Maxseverity fields. 
Alarms out of these fields will not be displayed. 

5. In the Zone field specify the Minzone and Maxzone fields. Alarms 
out of these zones will not be displayed. 

6. Click the Select Class button to open the Set Class Filter dialog box. 
Filter classes can be used to categorize alarms to identify them more 
easily and to filter them in the Events Summary.  
Classes can be added and removed individually or as a group by 
clicking the Set All and Reset All buttons. 



7. Click OK to return to the General tab. 

 
8. Click OK to actually save the Alarm Filter definitions. 

Note:  The Family name list is defined in the Tags dialog box in the Tag 
Name field.   
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Network Tab 

This tab is used to define the Filter Alarm’s network station.  The 
stations appearing in the List All Stations list are defined in the Network 
menu.   

 
1. In the List All Stations column select the relevant station.  

2. Either double click the station name or, click the  button.  The 
station name will be transferred to the Selected Station column. 

3. To remove a station from the Selected Station list click the  
button.  

4. Click OK to confirm. 
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Counters Tab 

This tab defines the Alarm Filter dialog box columns. 

 
1. To enable the fields in this dialog box check the Enable Count 

Alarms checkbox. 

2. In each field click the arrow to open the dropdown list and make 
your selection. 

3. Click OK to confirm.  The defined fields will appear in the Filter 
dialog box. 

➤ To modify an existing filter: 

1. To modify a filter select the relevant filter and click the Modify 
button.  The Filter Properties dialog box opens.  

2. Follow the instructions for creating a New filter. 
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Online Mode 

This option is used to select the Online mode for a list of alarms as they 
occur in the system, or the Reports mode, for a list of historical alarms. 

To toggle the Events Summary mode, select Online from the Settings 
menu. When the Online mode is not active (no check appears beside the 
item), the Reports mode is active. 

Note: Alarms must be defined as Record to File in the Alarms module in 
order to be enabled in the History mode. 

Reports 

The Report menu is enabled only when the Online mode is off.  To turn 
the Online mode off, uncheck Online from the Settings menu.   

 

The Reports menu enables you to: 

Define the Alarm Report ■ 

■ Define the History folder  
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Defining Alarm Reports 

Alarm reports can have filters added to them. 

➤ To configure alarm reports: 

Select Options from the Report menu. The Alarm Report Definition 
dialog box is displayed: 

 

The following options are available: 

Note: Where two sets of columns appear in a field, the first set is used 
for From values and the second for To values. 

Start time Specifies the range of date and time for the alarm 
start time that will appear in the report: 
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Indicator:  Indicates whether the date and time is absolute or 
relative. Click inside the field to display the 
following options:  

Absolute:  The exact time specified. For example, if you 
specify the date 08-05-96, and the time 15:00:00, 
alarms will be listed from 3 PM on August 5, 1997. 

Relative:  The time and date that you specify will be relative to 
the current time and date. For example, for time 
10:00:00 and date 3, alarms will be listed from 3 
days and 10 hours ago. 

Relative Date:  Only the date that you specify will be relative to the 
current date (the time will remain absolute). For 
example, for time 10:00:00 and date 3, alarms will 
be listed from 3 days ago, at 10 AM. 

End Time Specifies the range of date and time for the alarm 
end time. Only alarms that ended in this date and 
time range will appear in the report. The options you 
can select for Indicator are the same as those for the 
Start Time field described above. 

Ack Time Specifies the range of date and time for the alarm 
acknowledge-time. Only alarms that were 
acknowledged in this date and time range will 
appear in the report. The options you can select for 
Indicator are the same as those for the Start Time 
field described above. 

Severity Range Specifies the range of severity levels of the alarms 
that you want to appear in the report.  

Zone Range Specifies the range of zones of the alarms that you 
want to appear in the report.  

Family Range Specifies the range of family prefixes of the alarms 
that you want to appear in the report.  



Class Activate this button to select alarm classes so that 
only the alarms that belong to one of those classes 
will appear in the report. The Set Class Filter dialog 
box is displayed. Select the alarm classes you want, 
and click OK. To select all the classes in the box, 
activate the Set All button. To de-select all the 
classes in the box, activate the Reset All button. 

Alarm Path: Additional field that filters alarms located in this 
level. 

Target In this field, specify the target of the alarm report to 
be generated. If you select File, specify the name of 
the file that you want the report to be written to. 

History Folder Settings 

This option is used to define the directory from which Wizcon will 
extract historical alarm data files.  

➤ To specify a directory: 

Select Alarms History Folder from the Reports menu. The History 
Directory dialog box is displayed, in which you can either specify the 
path of the directory in which the historical data file is located, or select 
the Use default history directory option. 

 

The default directory is that specified in the Set Default Paths dialog box 
for the Alarm History field. 
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Popup Events Summary 

The Popup Events Summary is an Events Summary that appears on the 
screen whenever a severe alarm occurs. As you define each alarm you 
can specify whether the alarm will appear in a Popup Events Summary 
or in an Events Summary. In addition, the operator can filter the alarms 
that will appear in the Popup Events Summary. 

This section describes how to use a Popup Events Summary.  The 
following is an example of a Popup Events Summary:  

 

The following alarm information is displayed: 

Alarms The number of alarms that appear in the Popup. 

Date The Popup activation date. 

Time The Popup activation time. 

Alarm List A list of the active alarms in the Popup. 
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The following options are available: 

Clear Clears the selected alarm from the Popup. 

Clear All Clears all the alarms from the Popup. When this 
button is activated, the Popup Events Summary will 
automatically disappear from the screen. 

Relax Clears the Popup Events Summary from the screen 
for a pre-defined period of time. 

Quiet Disables the Popup buzz feature for a predefined 
period of time. 

Notes: 

1. When the Clear button is activated and the alarm is removed from 
the Popup, the alarm's End or Ack status will not be affected. 

2. When a Popup is activated (when an alarm becomes active) and 
appears on the screen, you will not be able to perform any system 
function until the Popup disappears. This is meant to draw the 
operator's attention to serious alarms. The Popup will disappear 
only when all the alarms in the list are cleared (either one at a time 
or all together). However, the operator can cause the Popup to 
disappear temporarily by activating the Relax button. 

3. In the Popup an eight-star marker appears to the left of the alarm 
line. This marker indicates the alarm that is causing the current 
buzz. 



Designing Popup Events Summaries 

Popup Events Summaries are designed in the Wizcon Application 
Studio. 

➤ To design a Popup Events Summary: 

Select Popup Settings from the Design menu in the Wizcon Application 
Studio.   The Popup Settings dialog box opens: 

 

This dialog box has the following tabs: 

Columns: Where alarm fields displayed in the Events 
Summary and in the Popup Event Summary 
windows are defined. 

Colors: Where the text color and the background color of 
the alarms displayed in the Events Summary and in 
the Popup Events Summary windows are defined. 
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Filter  Defines which alarms will be displayed in the Popup 
Events Summary window. 

Popup Specification  Defines the Popup Events Summary window 
attributes. 

Columns Tab 

This tab defines the column fields that will appear in the Popup Events 
Summary. 

 

The following options are available: 

Columns This field defines the columns that will be displayed 
in the Popup Events Summary.   

Move up Moves the column one space up in the Popup 
Events Summary window. 

Move down Moves the column one space down in the Popup 
Events Summary window. 
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Select All Selects all the column options 

Deselect All  Deselects all the column options 

Default Returns this dialog box to the default options 

Colors Tab 

The Colors tab is used to assign alarm text and background colors 
according to their severity level or zone to alarms displayed in the 
Events Summary and Popup Events Summary.  Up to 10 different colors 
can be defined for the text and background (10 for each). 

 
1. Under Text/Background select either Zone or Severity to define 

whether the text/background colors pertain to the alarm severity or 
zone.  

2. The values entered in each column represent ranges for which the 
sample colors will apply. The values should be entered in ascending 
order. 
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3. Each entry has a color box displaying the selected color.  To change 
this, click the color box to display a standard colors dialog box, 
where you can select a color or define a custom color. 

4. Click OK to confirm. 

Filter 

The Filter tab defines which alarms will be displayed in the Popup 
Events Summary. 

 
1. In the MinSeverity field enter the minimal alarm severity that will be 

included in the Popup Events Summary window. 

2. In the MaxSeverity field enter the maximum alarm severity that will 
be included in the Popup Events Summary window. 

3. In the MinZone field enter the minimum zone range that will be 
included in the Popup Events Summary window. 

4. In the MaxZone field enter the maximum zone range that will be 
included in the Popup Events Summary window. 
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5. In the Family fields enter the first letters of the alarm families to be 
included in the Popup window. 

6. Click the Classes button to open the Set Class Filter dialog box 
where you can select the classes that will be displayed in the popup 
window.  See page 14-26 for further details. 

7. In the Network Stations for Filter field select the relevant stations 
whose alarms will be filtered and viewed in the popup window. 

8. Click OK to confirm. 

Popup Specifications 

This tab defines the appearance of the Popup Events Summary window. 
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1. In the List Length field type in the length of the list that is displayed 
in the Popup window.   

2. In the Relax Time field type in the amount of time that the Popup 
window waits before reopening on the operator’s screen when the 
Relax or Quiet buttons are clicked in the Popup window. 

3. In the Position field, specify the X,Y coordinates. 

4. In the Size field specify the width and length. 

5. Check the Title Bar field to display the title bar in the popup 
window. 

6. Check the Show Old Alarms field to activate this checkbox. 

7. To view these configurations click the Test button. 

8. Click OK to confirm. 

Popup Events Summary Buzz 

The Popup Events Summary can be defined to buzz. This feature can be 
used to call the operator's attention to the screen and indicate a severe 
warning. 

The buzz will be determined according to the alarm's severity. Different 
buzzes can be defined for different severity ranges. The Popup will buzz 
according to the parameters of the alarm with the highest severity. 

Note: Only alarms that belong to a class called Popup Buzz will be able 
to activate the Popup to buzz option. 
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➤ To define buzz parameters: 

From the Design menu select Popup and then Popup Buzz. The Popup 
dialog box opens. 

The Sound of Buzz field is used to define the *wav. file and its tone.   

The Sound field when selected opens a browser where a *.wav field can 
be located and selected, whereas the Tone field opens the Off time and 
Tone columns where these parameters are defined. 
The following options are available for the Tone option:  

Tone Specifies the buzz tone for a severity range. The 
value is in Hertz, and can be from 37 to 32,767 
(system limitation).  

Sound Specifies the buzz sound 

Buzz Parameters The following parameters are available: 

Severity Range: Specifies the severity range for 
which the other parameters in this line will be 
relevant. 

 The severity range will include all the severity 
levels greater than the one defined in the previous 
line, up to and including this severity. 

On Time: Specifies the amount of time in 1/10 
seconds that the Popup will buzz for a specific 
severity range. If you specify 0, no buzzing will 
occur for that severity range. This may be useful if 
you want to de-activate the buzzing for all alarms 
within a specific severity range. 

Note: It is recommended to specify short On-Time, up to 20 seconds, 
since this action uses large computer resources and slows the system. 

Off Time: Specifies the amount of time in 1/10 
seconds that the Popup will be silent between 
buzzes. 
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Status Parameters: The following options are available: 

Buzz Acked Alarms: Select this option if you want 
the buzz to operate on alarms that were defined to 
buzz, even if they were acknowledged. 

Buzz Ended Alarms Enables the buzz to operate on 
alarms that were defined to buzz, even if they were 
ended. 

Test Severity Buzz: The following options are available: 

Severity: Specifies a severity number to test how 
the Popup will buzz for the severity. 

Start Test: Starts the buzz test. A buzz will sound 
according to the parameters you defined in the 
dialog box. When the buzz is operating, the Start 
Test button will change to the Stop Test button. You 
can activate this button to terminate the test. 

Note: In the Popup, the alarms causing the current buzzing will be 
marked by a small eight-star marker in the left margin of the line that 
contains the alarm. 



 
1. Under Severity Range specify the range, for which the other 

parameters in this line will be relevant. The severity range will 
include all the severity levels greater than the one defined in the 
previous line, up to and including this severity. 

2. Under On time specify the amount of time in 1/10 seconds that the 
pop-up will buzz for a specific severity range. If you specify 0, no 
buzzing will occur for that severity range. This may be useful if you 
want to de-activate the buzzing for all alarms within a specific 
severity range. 

3. Under Off time specify the amount of time in 1/10 seconds that the 
pop-up will be silent between two buzz sessions. 
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4. Under Tone specify the tone frequency in Hertz units 

For Sound do the following: 

1. Under Severity Range specify the severity range, for which the other 
parameters in this line will be relevant. The severity range will 
include all the severity levels greater than the one defined in the 
previous line, up to and including this severity. 

2. Under Sound File, type the name of a sound file you want to play, or 
click the browse button to select a *.wav file. 

3. Under Status Parameters select Buzz acked alarms if you want the 
buzz to operate on alarms that were defined to buzz, even if they 
were acknowledged.  

4. Select Buzz ended alarms if you want the buzz to operate on alarms 
that were defined to buzz, even if they were ended. 

5. Under Test severity buzz, enter a severity number for which you 
want to test how the popup will buzz for that severity level and click 
the Start test button to start testing (when clicked, this button turns 
into a Stop test button, click it to end testing session).  

6. Click Apply for the changes to take effect. 



Events Summary Properties 

This section describes how to define Events Summary tuning 
parameters. 

➤ To define Events Summary properties: 

From the All Containers section of the Wizcon Application Studio, 
right-click on Events Summaries and select Properties from the Popup 
menu. The Events Summaries Properties dialog box is displayed: 
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The following options are available: 

Alarm help text status The following options are available: 

Assist:  Enables the user to obtain alarm help text from 
alarm Help files. 

Ack:  Acknowledges alarms. 

Assist and Ack:  Enables both the Assist and Ack options. This 
change can be implemented online. 

Scroll alarm list  Enables the Events Summary to scroll and display 
alarms at the top of the list. If this option is checked, 
this parameter determines that when a new alarm 
arrives the Events Summary automatically scrolls to 
show the top alarms in the list. This ensures that if 
the new alarm is important, it will not be missed if 
the operator scrolled the list too far. Restart Wizcon  
for changes to take effect. 

Show Force End User implements the Force End field, which helps 
the user to know whether the name that appears in 
the User field is the name of the person who ended 
or acknowledged the Alarm. 

Advanced Defines Events Summary window attributes. 

 



Defining Events Summary Window Attributes 

Click the Advanced button in the Events Summaries Properties dialog 
box, to define default Events Summary window attributes. 

 

The following options are available: 

Title Bar  Defines that a title bar will appear at the top of the 
window.  

Name in Title  Specifies that the name of the window will appear in 
the title bar.  

System Menu  Specifies that a menu appears when you click on the 
icon in the top left corner of the window. This menu 
contains items that can be used to manipulate 
windows, such as move, size, close and so on.  
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Min/Max Button  Specifies that a Minimize and Maximize button 
appear in the top right corner of the window. These 
buttons can be used to minimize or maximize the 
window to predetermined sizes.  

Size Border  Enables window borders that can be dragged to 
change the window size.  

Menu Bar  Specifies that a menu bar appears in the window.  

Always on Top Select to display the Events Summary window on 
top of other open applications. 

Pos  Specifies the window X and Y position coordinates 
in pixels.  

Size Specifies the window size in pixels. 

Title Bar Text Specifies the text that will appear in the Title bar. 
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Chapter 15   
Creating Events Summary 
Profiles & Popups 

 About this chapter: 

This chapter describes the Events Summary Profile that contains the 
definitions that determine the way alarms are displayed in a browser. It 
also describes how to create an Events Summary Viewer, an HTML 
page that features real-time monitoring of alarms. This chapter also 
includes a description of Events Summary popups, as follows: 
Overview, on the following page, is an overview of the Wizcon Events 
Summary Profile and Events Summary Viewer features. 
Defining and Modifying Events Summary Profiles, page 15-6, 
describes how to define which alarms will be displayed in the Events 
Summary, their order, how to assign alarms text and background colors.  
Creating Events Summary Viewers, page 15-21, describes how to 
create an Events Summary Viewer by generating an HTML page from 
the Events Summary. 
Changing the Default Location of Events Summary Profile Files, 
page 15-23, describes how to change the location of Events Summary 
Profile files. 
Popup Events Summaries, page 15-24, describes how to use popup 
events Summaries to enable real-time monitoring of alarms. 
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Overview 

The Wizcon for Internet system enables real-time monitoring of alarms.  

Events Summary Profile 

The Events Summary Profile module holds the definitions that determine 
the way alarms are displayed on the Internet browser. The Events 
Summary Profiles dialog box has the following tabs: 

■ 

■ 

■ 

■ 

Alarm Filters:  Which defines the alarm filtering criteria by which 
alarms are sorted and then displayed in the Events Summary. 

Display:  Which defines the display parameters of the Events 
Summary window. 

 Features: Which defines the features that will be enabled or 
disabled for the operator. 

 Colors: Which defines the default display options, default colors, 
and default sort order. 

Events Summary Profile files can be identified by their WNA file name 
extension. 

Events Summary Viewer  

The Events Summary Viewer features real-time alarms monitoring 
(online mode) according to the definitions specified in the Events 
Summary Profile. In addition to the online mode, Wizcon also provides a 
history mode that displays a report of historical alarms. This shows a list 
of alarm activities for a specified period of time. For example, alarm 
information one week before the current date.  



Wizcon enables you to define filters for the Events Summary Viewer to 
specify the type of alarm information that is displayed. For example, you 
can define a filter that will display only the start time of the alarms that 
were activated one week before the current date. 

You can also apply filters online and display a historical report. 

The screen shot below shows an example of an Events Summary Viewer 
in online mode. An Events Summary Viewer in history mode is shown 
on page 15-5. 

 

Interacting with the Events Summary Viewer 

Alarms are displayed according to parameters specified in the Events 
Summary Profile. In the example above, alarm information is displayed 
in the following columns: Start time, Ack time, End time, Severity and 
Text.  An operator can click a column heading to sort the information 
displayed in the column according to ascending or descending order. 

The Events Summary contains the following options:  
History Displays the Events Summary Viewer in history 

mode. (This option toggles with the Online mode, 
that displays the Events Summary Viewer in real-
time.) 

Ack Selected Acknowledges selected alarms.  If the alarm is 
ended the alarm will be removed from the list. 
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Force End Force ends displayed alarms. The time the alarm 
is ended is then displayed in the End time column.  
If the alarm is acknowledged it will be removed 
from the list. 

Assist Online Help that can be used to handle the cause 
of the alarm. 

Inhibit The Inhibit option opens a window displaying the 
alarm levels. Each level can be inhibited or not. 
All the alarms in an inhibited level will in turn be 
inhibited. 

Add Comments Enables the operator to add comments regarding 
the alarm. These comments can be read by other 
operators. 

Columns Displays the following window in which an 
operator can select which columns are displayed 
in the Events Summary.  

  
The columns that appear in the Display list on the 
right are those that are displayed in the Events 
Summary. To move a column from the Items list, 
on the left to the Display list and vice versa, select 
the column and click the Move button. 
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Filter List This feature displays a list of selected alarm 
filters.  The Select Filters button when clicked 
opens the Filters dialog box where the user can 
select an alarm from the list and add it to the list 
of selected alarm filters (or add new alarms).  
Existing alarm filters can be modified or added. 

When a column heading is clicked, an  arrow appears in the heading, 
which sorts the column information in descending order. Click the 
column again to display the information in ascending order. The arrow 
changes to an  arrow. The width and the height of the columns are 
determined when generating the HTML page. 

History Mode 

The following Events Summary Viewer is displayed in history mode. 
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The following options are always available.  The other options displayed 
here are described in the Events Summary Viewer on page 15-2. 
Online  Displays the Events Summary Viewer in online 

mode. 

Columns  Specifies filters for the Events Summary Viewer that 
determine what type of alarm information it displays.  

Report  Configures historical alarm reports, as described on 
page 15-19 

Note: Any changes you make to the Events Summary Viewer are 
available until you refresh. The next time you login, the default Events 
Summary Viewer parameters are displayed. 

Defining and Modifying Events Summary Profiles 

This section describes how to define an Events Summary Profile and 
how to modify an existing Events Summary Profile.  

➤ To define an Events Summary Profile: 

Click the New Events Summary  icon in the Wizcon Application 
Studio toolbar. 
Or,  
 
In the All Containers section of the Wizcon Application Studio, 
right-click Events Summary Profiles and select New Profile from the 
popup menu. The Events Summary Profile dialog box opens. 
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This dialog box has the four tabs: 

■ 

■ 

■ 

■ 

Alarm Filters: Which defines the alarm filtering criteria by which 
alarms are sorted and then displayed in the Events Summary. 

Display:  Which defines the display parameters of the Events 
Summary window. 

Features: Which defines the features that will be enabled or 
disabled for the operator. 

Colors: Which defines the default display options, default colors, 
and default sort order. 

➤ To modify an Events Summary: 

1. In the All Containers section, click Events Summary Profiles. The 
existing Events Summary Profiles are displayed in the List of Events 
Summary Profiles. 

2. Double-click the Events Summary Profile you want to modify. The 
Events Summary Profile dialog box is displayed. 

➤ To insert an Events Summary Profile: 

In the All Containers section, right-click Events Summary Profile and 
select Insert Profile from the popup menu. The Import File dialog box is 
displayed in which you can select a predefined Events Summary Profile 
and add it to the current application. 



Alarm Filters Tab 

The Alarm Filters tab enables you to set filter conditions for alarms. 
Only the alarms that meet these conditions are displayed in the Events 
Summary Viewer. 

 

The List of Selected Filters lists all filters that have been selected in the 
application. 
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➤ To select new filters: 

Click the Select Filters button to open the Select Filters dialog box. 

 

This dialog box has the following fields: 
All defined filters: Lists all defined filters in the application. 

Selected filters:  Lists selected filters only. 

Add: Adds a filter selected in the All Defined 
Filters list to the Selected Filters list. 

Remove: Removes a selected filter from both the All 
Defined Filters and Selected Filters lists. 

New:  This option when clicked opens the Filters 
Properties dialog box. 

Modify: This button when clicked opens the Filters 
Properties dialog box where the parameters 
of the selected filter can be modified. 
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Delete: Deletes a selected filter from both the All 
Defined Filters and Selected Filters lists. 

➤ To open the Filter Properties dialog box: 

Click the New button or select a filter in the Select Filters dialog box and 
click Modify.  The Filter Properties dialog box opens. 

There are three tabs: 

General ■ 

■ 

■ 

Network 

Counters 

General Tab 

This tab holds general information about the alarm filters. 

 
1. In the Name field type a unique name for the alarm filters. 

2. In the Description field type a short description of the alarm filters. 
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3. Click the Family field’s arrow to open the dropdown list and select a 
family. Only alarms from this family will be displayed. 

4. In the Severity field specify the Minseverity and Maxseverity fields. 
Alarms out of these fields will not be displayed. 

5. In the Zone field specify the Minzone and Maxzone fields. Alarms 
out of these zones will not be displayed. 

6. Click the Select Class button to open the Set Class Filter dialog box. 
Filter classes can be used to categorize alarms to identify them more 
easily and to filter them in the Events Summary. Classes can be 
added and removed individually or as a group by clicking the Set All 
and Reset All buttons. Click OK to return to the General tab. 

 
7. Click OK to actually save the Alarm filters definitions. 
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Network Tab 

This tab is used to define the Alarm Filters network station.  The stations 
appearing in the List All Stations list are active in the Network menu.   

 
1. In the List All Stations column select the relevant station.  

2. Either double click the station name or, click the  button.  The 
station name will be transferred to the Selected Station column. 

3. To remove a station from the Selected Station list click the  
button.  

4. Click OK to confirm. 
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Counters Tab 

This tab displays the status of the number of alarms in the system. 

 
1. To enable the fields in this dialog box check the Enable Count 

Alarms checkbox. 

2. In each field click the arrow to open the dropdown list and select the 
tag that will be counted.   

3. Click OK to confirm.  The defined fields will appear in the Alarm 
Filters dialog box. 
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Display Tab   

The Display tab enables you to determine which of the parameters 
selected during alarm definition is actually displayed in the Events 
Summary Profile. You can also determine the width of each column.  
The operator can then adjust the default display, resize columns and 
change alarm sorting at run time. 

Note: If an alarm is defined with both the Auto Acknowledged and Auto 
End options, it will be considered inactive and will not be displayed in 
an Events Summary Profile. 

The Display tab contains four columns in which display options are 
determined, as shown below: 
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The following options are available: 

Column Displays the available alarm parameters such as 
Start time and End time. A parameter is 
selected/deselected for display by double-clicking 
inside the View column.  

View Specifies which alarm parameters are displayed in 
the Events Summary Profile. Double-click inside the 
column next to the required parameters to select or 
deselect the parameters.  A plus sign (+) indicates 
that the parameter is selected. 

Order Specifies the order of the alarms in ascending or 
descending order. Double-clicking in the column 
along side the required parameters toggles it 
between ascending and descending. 

Weight Specifies the amount of space designated to a 
column in relation to the entire Events Summary. 
Double-clicking in the column next to the required 
parameters displays the Update Weight Value 
dialog. You can then enter a new value in the Value 
field, or click the up or down arrow to the right of 
the field until the required value is displayed.  

Move Up / Down Specifies the position of the parameters in the 
Events Summary. To move a parameter, click on a 
parameter to select it and click the Move Up or 
Move Down button. The selected parameter will 
move up or down one place in the list.  

Sorted By Specifies the default sort order of the alarms. Click 
in the field and select a sort order from the drop-
down list. For example, End Time. 

Time Format Specifies the alarm time format. Click in the field 
and select a time format option from the drop-down 
list.  



Features Tab  

The Features tab enables you to determine operator options. 

 

The following options are available: 

Allow Alarm Acknowledge ■ 

■ 

■ 

■ 

■ 

■ 

■ 

Allow Force End Alarm 

Allow to Modify Sorting 

Allow to Change Filter Definition 

Allow Field Sizing 

Allow Column Selection 

Allow Alarm Assistance 
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1. Click the checkbox to left of an option to deselect an option. The 
check mark is removed. 

2. Click the check box again to enable the option. 

3. Click the Select ALL button to select all options.  

4. Click the Reset ALL button to disable all options.  

Colors Tab 

Different colors can be assigned for alarm text and background in the 
Colors tab. Specifying different colors for different types of alarms 
enables each alarm to be easily distinguished and categorized. 

Different colors for background and foreground (text) can be defined for 
each Severity range and Zone.  

Note: Event time (Start Time, Ack Time and End Time) colors are 
assigned by the system and cannot be changed.  



 

➤ To assign text/background color to an alarm according to its 
severity or zone: 

1. In the text/background column select the Severity or Zone option 
from the By field.  

2. Enter the maximal value for the severity or zone in the numerical 
entry field.  

3. Click the color box to the right of the entry field to display a color 
box in which you can select a color for this maximal value. 

4. Click OK to activate and to close the dialog. 
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Notes: 

1. Alarms with severity or zone (according to the selection) below or 
equal to the entered maximum value will be displayed using the 
selected color. 

2. If the Ack Time or End Time option is not being used, the event time 
colors are applied to the Start Time option, if used.  

Configuring Alarm Reports to Display Historical Information 

Wizcon provides the following filters that can be configured online to 
display a historical report.  

The range of date and time an alarm was activated. ■ 

■ 

■ 

The range of date and time an alarm was acknowledged. 

The range of date and time an alarm ended. 

➤ To configure an alarm report: 

1. Select History in the Events Summary Viewer. The Events Summary 
Viewer is displayed in History mode. 

2. Select Report. The Alarm Report dialog box is displayed: 
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This dialog box is similar to the standard Alarm Report Definition 
dialog. For more information about specifying the filters in this 
dialog, refer to the section on Configuring Alarm Reports in the 
Events Summaries chapter. 

3. Click OK. The Alarm Report dialog box closes and a Progress 
dialog box is displayed while Wizcon Connects to the server.  
A system file with an adb extension is created in the Docs/History 
folder of your application. 

  
4. (Optional) You can stop Wizcon from transferring the history 

information to this file at any time by pressing Cancel. Wizcon then 
displays a message in the Events Summary Viewer, notifying that 
the history reading has been cancelled. 

 When the query is complete, Wizcon reads the history file prior to 
displaying the alarm report. A progress dialog box opens. 

  
5. (Optional) You can click Cancel at any time to stop Wizcon from 

reading the history prior to displaying the report in your browser. 
This is useful if the report is larger than you expected. 

6. When the history reading is complete, the report is displayed in your 
browser. 
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Creating Events Summary Viewers 

An Events Summary Viewer displays alarms generated in the Wizcon 
system according to definitions specified in an Events Summary Profile. 

Events Summary Viewers are created by generating an HTML page 
from the Events Summary Profile, in the Wizcon system, and publishing 
the resulting page on the Web. 

This section describes how to generate a single HTML page that 
contains the Trend Viewer. For details on generating a single HTML 
page that contains two or more objects or about publishing, refer to the 
Generating HTML Pages chapter. 

➤ To create an Events Summary Viewer:  

1. Click the New HTML File  icon in the toolbar.  

 Or, 

 From the All Containers section of the Wizcon Application Studio, 
right-click HTML and select New HTML File from the pop-up 
menu. The Generate new HTML file dialog box is displayed: 
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 The dialog box contains three sections: Picture, Events Summary 

Profile and Trend Viewer. 

2. Click the Include Events Summary Viewer box to enable the fields 
in this section. 

3. Click the Profile box and select an Events Summary Profile file from 
the list of available Profiles. 

4. (Optional). You can change the default width and height of the 
viewer in the Width and Height fields. It is recommended to 
generate the page first and view it in your browser, before changing 
the default options. 

5. Click Generate. The New File dialog box is displayed.  
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6. Navigate to the AnnPrf folder, enter a name for the HTML page and 
click Open. The page is generated. It is saved in the List of HTML 
files in the Application Studio. 

7. Click on the page in the List of HTML files to display it in your 
browser. 

Changing the Default Location of Events Summary 
Profile Files 

The Events Summary Profiles Properties dialog box enables you to 
determine the location of the Events Summary Profile files folder 
relative to the web application root directory. This folder (AnnPrf) is 
located by default in the Docs directory of the application.  

➤ To change the default location:  
1.  In the All Containers section, right-click Events Summary Profiles 

and select Properties from the popup menu. The Events Summary 
Profiles Properties dialog is displayed: 

 
The default folder name AnnPrf is displayed.  

2.  Enter a folder name and click Apply. If the folder does not exist, a 
message is displayed asking if you want Wizcon to create it. 

Creating Events Summary Profiles  15-23 



15-24  Wizcon for Windows and Internet User’s Guide 

3.  Click OK to save your changes and to close the dialog. 

You can also determine the location of the Events Summary Profile 
folder by right-clicking Web Application in the All Containers section, 
selecting Properties from the popup menu and selecting the Events 
Summary Profiles tab from the displayed dialog box. 

Popup Event Summaries 

The Wizcon for Internet system supports Popup Events Summaries to 
enable realtime monitoring of alarms. 

Designing Popup Events Summaries 

Designing a Popup Events Summary that is displayed in a browser is 
identical to designing a standard Popup Events Summary.  

Designing Popup Events Summaries is described in the Events 
Summaries Chapter. 

Wizcon supports the all popup display options, excluding Buzz. These 
options are defined by selecting Popup Settings from the Design menu of 
the Wizcon Application Studio, and are described in more detail in the 
Event Summaries chapter. 



Viewing a Popup Events Summary in a Browser 

Following is an example of a Popup Events Summary that appears in a 
browser: 

 

The Popup Events Summary displays the following alarm information at 
the top of its window: 
Alarms  Specifies the number of alarms that appear in the 

Popup Events Summary. 

Date  Specifies the date that appears in the server at the 
time the Popup Events Summary is activated.  

Time  Specifies the time that appears in the server when 
the Popup Events Summary is activated. 

Alarms are displayed in the Popup Events Summary according to the 
filter conditions specified when the Popup Events Summary is defined. 
The example on the previous page displays the following filters: 
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Start time  Displays the time the alarm was triggered. 

Zone  Displays the zone defined for the alarm. 

Text  Displays the text defined for the alarm.  

The following options are available at the bottom of the Popup Event 
Summary: 
Clear Clears the selected alarm from the Popup Events 

Summary. 

Clear All Clears all the alarms from the Popup Events 
Summary. 

Relax Clears the Popup Events Summary from the screen 
for a pre-defined amount of time. 

Enabling Popup Events Summary Display in Browsers 

You can specify whether or not Popup Event Summary display is 
enabled in a browser. Group authorization can be defined to determine 
that the Popup Events Summary is displayed only in the browser of 
authorized users. 



➤ To enable display in browsers:  

1. In the All Containers section of the Wizcon Application Studio, 
right-click HTML and select Properties from the popup menu. The 
HTML Properties dialog is displayed. 

2. Select the Popup tab to display the following: 

  
3. Check that Enable Popup window in browser is selected so that the 

Popup Events Summary is displayed in the browser.  

4. Click the Groups button to display the standard Wizcon Groups 
dialog box in which you can assign group authorization for Popup 
Events Summary display.  
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Chapter 16   
Introduction to the Image 
Module 

 About this chapter: 

This chapter is an introduction to the Image Module as follows: 
Images Overview, on the following page, discusses the basic Image 
options. 

Getting Started, as described on page 16-3 discusses the basic 
parameters required for creating an image in the Image module. 

Image Properties, as described on page 16-3,discusses how to 
predefine the Image Window parameters. 

The Image Window, as described on page 16-17, discusses the Image 
interface its toolbar, menu bar and various operational toolboxes. 

Basic Image Module Concepts, as described on page 16-22, 
discusses the various Image module concepts. 
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Images Overview 

Images are dynamic graphic representations of industrial processes.  
Each tag in an industrial process can be represented by an image object 
and each object can represent specific process values.  Together they can 
display a dynamic picture of the work process. 

Images can be saved into Html pages and be viewed from remote 
stations over the Internet.  Using the Goto Zone function, operators can 
receive alarms showing a graphical image of the cause of the alarm.   

Images can be imported, inserted or attached to a project from other 
projects or locations.  Graphics can also be saved in Cluster Libraries 
and be used to create multiple projects. 

The Layers functionality enables users to zoom in and out of an image 
for a more detailed view.  Different operators can view different layers, a 
feature which is useful for work efficiency and security. 
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Getting Started 

This section discusses basic work principles for creating an image.   

There are two work modes available, where each mode when selected, 
opens showing different functions on the computer screen.  These modes 
are: 

■ 

■ 

■ 

■ 

■ 

■ 

Edit – this mode is used for designing and editing images.  This 
mode opens displaying the Drawings, Colors, Objects and 
Operations toolboxes.   The Navigate toolbars can be activated in 
this mode enabling the user to move within the image and/or zoom 
in and out of it.  

Trigger on  – when the Trigger mode is set to ON, objects defined 
as trigger objects can be used for tag input. When this mode is OFF, 
no objects (even those defined as Trigger objects) can be used for tag 
input.  The Navigate toolbars can be activated in this mode enabling 
the user to move within the image and/or zoom in and out of it.  

Image Properties 

Image Properties are used to define the properties of the image. 

➤ To access the Properties dialog box: 

In the All Containers section right-click Images and select Properties 
from the popup menu. The Image Properties dialog box opens.  This 
dialog box has the following tabs: 

Picture - where the location of the pictures files is defined. 

View  - where image window view properties are defined. 

Loading - where the amount of memory available for Image objects 
is defined 

Trigger - where the parameters for trigger objects are defined. 



16-4 Wizcon for Windows and Internet User's Guide 

■ 

■ 

■ 

Rates - where image update performance in milliseconds and the 
size of the internal message buffer that images use to collapse 
tag/alarm notification message is defined. 

Fast Zone - where the period of time (in ms) for "slow" zones is 
defined. 

Dynamic Zone - where the blinking rate values for dynamic objects 
are defined. 

Pictures Tab 

This tab is used to define the location of the picture files folder.  By 
default this is the Docs directory, which is the default web root directory.  
Its location is relative to the web application root directory. 

 
1. Type in the required location. 

2. Click the Apply button to open another tab in this dialog box or, 
click OK to save this information and to close this dialog box. 

Note:  This dialog box can also be opened by right clicking Web 
Application in the All Containers side, selecting Properties and the 
Pictures tab. 



View Tab 

This tab is used to define the properties of the Image window, repaint 
and resolution level. 

 

The following options are available: 

Repaint images after 
editing operations 

When checked this field defines that an 
image will be repainted automatically 
after actions that may alter the image 
(such as, moving, copying) are 
performed. This option is useful in 
small and medium zones. 

Resolution factor Sets global stretching or shrinking 
factors applicable to all images.  This 
is required to solve display differences 
caused by replacing an operating 
system, monitor or other H/W or to 
move between resolutions. 
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Number of gradient 
color steps 

This field determines the number of 
steps used when drawing objects filled 
with gradient color.  The default is 16. 
Drawing large gradient surfaces in 
many steps may be slow therefore, 
develop using few steps and then 
increase for run-time. 

Advanced button Displays the Image Window Attributes 
dialog box where window attributes 
are defined. 

Note: When changing the Resolution Factor the window remains the 
same size in pixels.  However a centimeter in one image will not be a 
centimeter in another. The image remains unchanged when the value is 
1. Values greater than 1 expand the image.  

➤ To set correct application values: 
1. Load the image in a PC and measure an object’s length in the image 

(a line will do). 
2. Load the same image in another PC and measure the same object’s 

length. 
3. Divide the first length by the second length and the result is the xx.xx 

value. 
4. Enter the IMG_RESFACTOR with the value you found and reload 

Wizcon. 

The range is 0.1<=IMG_RESFACTOR<=10. 

The default value: 1 
5. Restart the application for changes to take effect. The range of the 

factor is 0.1<+IMG_RESOLUTION _FACTOR<=10. 
 



➤ Setting Image Window Attributes 

Click the Advanced button in the View tab of the Properties dialog box. 

Note: Image Windows Attributes is not applicable on the Web. 

 

Each listed attribute can be set to On or Off. When confirmed, the 
selected attributes will apply to all future windows of the type specified.  
The following options are available:  

Title bar The line in the window holding the title.  
This is relevant only if the Title bar is 
active. 

Name in title Title bar text. 

System menu The menu that opens when clicking on the 
top left corner of a menu.  The menu 
options are: Move, Size, Close. 

Min/Max button This option defines whether the min/max 
buttons will appear in the Image window. 
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Size Border Specifies that window border size can be 
changed by clicking and dragging. 

Menu Bar Specifies that the menu bar will open in 
the Images window. 

Always on Top When selected the image is displayed on 
top of other applications. 

Pos Specifies X and Y coordinate in pixels. 

Size Specifies window size in pixels. 

Title Bar Text Specifies the name appearing in the title 
bar. 

Notes: 

1. The system menu is title bar dependent. Its corresponding checkbox 
is unchecked and disabled.  

2. If the menu bar is not selected but the system menu is, the menus and 
items included in the Menu bar will appear in the system menu. 



Loading Tab 

This tab determines the amount of memory available for image objects.  
It also enables/disables tag name parsing when loading images and 
determines the mode in which the image will open.   

Notes:  

1. Setting the amount of memory available for image objects is not 
applicable on the Web. 

2. Always restart the program after updating this tab. 
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The following options are available: 

Images memory pool 
size 

Enables large images with many objects 
to be created, but allows only 10 (+-) 
Image windows to be open at one time. 
The lower the value, the more Image 
windows that can be opened 
simultaneously (they must be smaller in 
size). The value for the parameter can be 
set from 60 to 200. 

Parse each image 
when loading 

Enables or disables tag name parsing 
when loading in the Images module. 
Disable this option to shorten image load 
time for images that contain network tags. 

When this option is disabled network tags 
validity is not checked. Therefore, use this 
option after all tag definitions in the 
network station are complete. 

Open new image in 
Navigation mode 

This checkbox defines that the new image 
will be opened in Navigation mode. 

 



Trigger Tab 

This tab defines trigger objects and onmouseover properties. 

 

This tab holds the following fields: 

Trigger object Determines whether trigger objects are 
highlighted when selected. If this option 
is checked, trigger objects will be outlined 
(with dashed lines) when they are 
selected. The default option is not 
selected. 

Mouse pointer on 
triggers 

Determines whether the mouse pointer 
will be highlighted when it is moved on 
top of a trigger object in an image. The 
default option is not selected. 

Trigger small input 
box 

When checked, the input box when 
defining data entry for triggers, will be 
small and and will only have a field for 
entering the value.  
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State Determines which trigger object is 
activated when overlapping triggers are 
clicked.  This could be either; Top 
(default) or Bottom. 

Note: Always restart the program after updating this tab. 

Rates Tab  

Note: The Image Rates Properties is not applicable on the Web. 

This tab determines the image update performance in milliseconds.  It 
also defines the size of an internal message buffer that images use to 
collapse tag/alarm notification messages received by WizPro. 
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This tab has the following fields: 
 

Image update rate Specifies the image update performance 
in milliseconds. Specify maximum and 
minimum rates. The default values are: 
Maximum = 2000  

Minimum = 10. 

Message buffer size Determines the size of the internal 
message buffer that images use to 
collapse tag/alarm notification messages 
received by WizPro. When tag values 
change, an image receives messages in a 
buffer from WizPro and updates graphical 
objects accordingly. The range is 5 to 500 
messages. 

A high value for this parameter improves 
the performance of images with rapidly 
changing dynamic objects, so that images 
will not have to make graphical updates 
for each value message. The default is 20 
messages. 

Note: Always restart the program after updating this tab. 



Fast Zone Tab  

Note: Image FastZone Properties is not applicable on the Web. 

This tab determines the period of time (in ms) for “slow zones”.  A zone 
is slow if it has a background that takes more than a given period of time 
to draw.  This parameter improves the drawing time for Goto Zone 
operations by using a cache of memory bitmaps for drawing the 
background of slow zones.   

 

This tab has the following fields: 

Fast zone threshold 
(msec) 

Specifies the fast zone threshold. If this 
parameter is set to be 2500 and the 
background takes 2500ms or more to 
draw, the zone is considered to be slow. 
The range is 0 to 1 hour (in ms). The 
default is 2500ms. 
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Maximum fast zones Determines the limit of the number of fast 
zone bitmaps that can be kept in a single 
window's memory cache. When a window 
reaches this limit, the least recently used 
fast zone bitmap is removed from the 
cache to make room for the new bitmap. 
The available range is 0-50.The default is 
0 (FastZone disabled).  

Notes:  

1. This only affects the background of the image. 

2. Dynamic elements are drawn as before. Operate only when NOT is Edit 
mode. 

3. Always restart the program after updating this tab. 

Dynamic Tab 

Note: Image Dynamic Properties is not applicable on the Web. 

This tab determines blinking rates for dynamic objects.  The blink rate is 
the period of time that the object will appear on the screen, disappear, 
and then reappear, and so on. 

The format of this parameter is from left to right.  It is recommended to 
increase the values for this option if it is anticipated that a large number 
of dynamic objects on the screen will be updated at once.   



 

This tab has the following fields: 

The blinking rate 
values for dynamic 
objects (msec) 

Specifies the fast zone threshold. The 
values specified for fast, medium and 
slow are in milliseconds and can be from 
50 (1/20 second) to 30,000 (30 seconds). 
If a value that exceeds these limits is 
specified then the application will 
automatically apply the maximum and 
minimum values instead. The default 
values are 200, 500 and 1000 ms. 
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Notes: 

1. High blink rates decrease the system's performance. 

2. When using the Wiztune.dat file to enter the values, use commas (,) 
to separate the values. 

3. Restart the application for changes to take effect. 

The Image Window 

Images are created, edited and viewed in windows that can be moved, 
sized and closed. The Image window can be operated using standard 
window techniques, according to the windows specific configuration 
defined during application setup. 

➤ To open an Image window: 

Click the New Image  icon in the toolbar.  
 
Or, 

From the File menu in the Application Studio, point to New and select 
Image.  
Or,  
In the All Containers section, right-click Images, and select New Image 
from the pop-up menu.   The Images interface will open on your screen.  
The screen shot below shows an Images window in Edit mode when the 
Navigate option has been selected. 
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Title Bar Image Menu

Status Bar

Vertical
Scroll Bar

Toolbar

Zoom Bar

Action Buttons

Image Region

Horizontal
Scroll Bar  

Screen 
Feature 

Description 

Title Bar Displays the title of the image. 

Image Region The work area where the image is designed. 

Scroll Bars The bottom and right edge sliders are used 
for scrolling horizontally and vertically. The 
slider position and size relative to the scroll 
bar, represent the position and size of the 
window relative to the workspace. 

Status Bar Specifies information of x y coordinates, 
scale and layers. 

Zoom Bar The left edge slider is used for zooming: 

• Moving up - zooms out 

• Moving down - zooms in 
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Action 
Buttons 

Buttons located above and below the Zoom 
Bar, used for viewing operations. These 
operations include automatic positioning of 
the Image (a), window selection (w), and 
Image Redraw (r). 

Toolbar Holds icons which activate the most 
common functions. 

Menu Bar 

The Image menu bar contains the following menus and options: 

Menu Options 

File Save, Save as, Insert, Import, Attach to, Print, 
Exit 

Edit Undo/Redo, Copy/Paste to clipboard, 
Find/Find next, Align, Select, Operator, 
Options, Drawings, Line type, Set background 
color, Get/Save background colors 

View Toolbar, Font bar, Status bar, Objects, 
Operations, Drawings, Patterns, Align, Colors 

Layers Elaborate on, Active layer, Definition, 
Override show/hide, move objects to active 
layer 

Clusters Define, Break, Open lib, Rebuild instances, 
Basket maintenance, Open basket 

Options Auto window, Goto, Goto Zone, Zones 
Definition, Repaint window, Simulate, Force 
dyn show, Mark triggers, Styles definition 



Modes Edit, Navigate, Trigger on, Copy on, Grid 
setup, Snap to grid, Grid show 

Help Image module Help files. 

Toolbar 

The Image toolbar contains the following icons and commands icons: 

Icon Command 

 Save 

 Print 

 Copy 

 Paste 

 Undo/Redo 

 Goto 

 Goto Zone 

 
Define Zone 

 Edit Zone 

 Navigate Zone 

 Trigger On 
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 Mark Triggers 

 Force Dynamic Show 

 Grid Setup 

 Set Background Color 

 Repaint 

 Line Type 

Additional toolboxes can be activated/deactivated in the View menu.  
The following options are available. 

Objects - enables definition of image objects such as Alarm, 
Trigger, Dynamic, Cluster Definition, Group, Slider and Media. 

■ 

■ 

■ 

■ 

■ 

Operations - includes Rotate, Pick Color, Active Layer, Toggle Fill, 
Cluster Library, Send to Back, Bring to Front, Delete, Grid, and 
Snap to Grid. 

Drawings - contains simple drawing objects such as Line, Pipe, 
Box, Text, and Circle. Both filled and unfilled objects can be 
selected. The selection and text tool are also included in this toolbox. 

Patterns - contains 16 different fill patterns, including solid and 
transparent. The Image drawing patterns also support 32 gradient 
styles.   The first color used for the gradient is the foreground color, 
while the last color used is the background color.  

Align - enables alignment of two or more selected objects. The 
objects can also be centered or resized horizontally, vertically or 
both. The objects can also be arranged so they are equal distances 
from each other, either vertically or horizontally. 
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■ Colors - includes 32 colors for background and foreground (text). A 
left mouse click selects the line color while a right mouse click 
selects the fill color. 

Opening Existing Files 

Image files are opened from the Application Studio. 

➤ To open an existing Image file: 

From the File menu of the Application Studio, select Open. In the dialog 
box that is displayed, select the file to be opened. Image files have the 
extension *.VIM. 
Or, 
Select the relevant file from the List of Images in the Application Studio. 
When a file has been selected and confirmed, the image will be opened. 

If an image with an undefined tag is loaded, an error message will appear 
with a reference to a file called imgname.mis, where imgname will be the 
name of the Image that was loaded. The .mis file can be opened for 
further information using any text editor. The file includes the name of 
the undefined tag and its type (dynamic or trigger). 

Basic Image Module Concepts 

Active Layer 

An image is made up of layers and is built one layer at a time. A layer 
being worked on is referred to as the active layer. The layer that always 
exists by default is called the base layer. 

The active layer name is displayed in the window title together with the 
Image name and the current scale. 
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Mouse Buttons 

Generally, the left button is used to draw objects. Click the left button on 
specific points in the image to start and end objects. The right button is 
generally used to cancel operations or complete them. 

Cursor 

When a drawing operation is selected, the cursor will take on the 
appearance of the icon representing the operation that was selected. 

Filling 

Any figure can be filled with a pattern. A pattern is structured as a 
foreground (text) color over a background color. A transparent attribute 
can also be selected. Open figures will be filled up to the line connecting 
the endpoints of the figure. 

Orientation 

Some figures are drawn in an orthogonal orientation (only in the 
horizontal, vertical, or 45-degree directions). Once such a figure is 
drawn, it can be rotated to any angle. 

Attributes 

Each figure (circle, square, polygon, and so on.) is assigned a set of 
attributes, including colors, filling and patterns. 

An important drawing feature is that once a figure with specific 
attributes is drawn, each time that the operation is selected again the 
figure will be drawn with the same attributes. 
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Continuous Design 

After an object is drawn, a new object with the same attributes can be 
drawn immediately without selecting the operation again. 

Multiple Windows 

Several Image windows may appear on the screen simultaneously. One 
toolbox of each type will appear for each different Image. For example, 
if you opened three windows for the same image called DEMO, one 
toolbox of each type will serve all three windows. 

File Management 

Normally an Image window and image are the same. The file name for 
both are identical except for the extension.  The Image module will 
automatically open/save both files as required. 

When saving an image for the first time the Save As dialog box opens 
where files can be saved in the following formats:  

■ 

■ 

■ 

Image *.VIM 

Bitmaps *.BMP 

ASCII *.ILS 
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Image Limitations  

The following table lists the technical specifications of the Image 
module: 

Image Specifications  

Coordinate space 2,000,000 x 2,000,000 pixels 

Number of static elements 100,000 

Number of dynamic elements 10,000 

Number of zoom scales 2,048 

Number of zones 500 

Number of layers 64 
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Chapter 17   
Image Editor 

 About this chapter: 

This chapter describes the Wizcon for Windows and Internet Image 
Editor, as follows:  

Overview, page 17-2, provides an overview of the Image Editor. 

Basic Principles, page 17-3, describes some of the basic concepts used 
for Image design. 

File Menu, page 17-7, describes the options in this menu. 

Edit Menu, page 17-13, describes the options in this menu. 

View Menu, page 17-36, describes the options in this menu. 

Layer Menu, page 17-44, describes the options in this menu. 

Cluster Menu, page 17-49, describes the options in this menu. 

Options Menu, page 17-68, describes the options in this menu. 

Modes Menu, page 17-83, describes the options in this menu. 
 

Image Editor  17-1 
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Overview 

The Image Editor is the graphic tool of the application. It is used to 
create and view the images that enable the operator to visualize part or 
all of a control process. 

The Image Editor operating in an Image window defined during 
application setup includes a wide variety of drawing tools that make 
image design quick and easy. Any drawing in this window can be 
zoomed and scrolled.  

Objects created using the Editor can be linked to tags, so that as the 
values of a tag change, the objects linked to the tag will change 
accordingly. In addition, objects can be defined as triggers for tag value 
input. 

Image Editor operations can be performed only by operators that have 
the appropriate authorization level permission. While some operators 
may be authorized to design and view images, others may only be able to 
view them. In addition, each object in an image has its own authorization 
level. 

The following basic activities can be performed using the Image Editor: 

■ 

■ 

■ 

Image Editing Image design. 

Image Animation Associating Image objects and dynamic 
 properties with tags and modifying 
 their values. 

Image Navigation Navigating within an image. 
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Basic Principles 

This section describes some of the basic concepts used for image design 
that should be understood before using the Image Editor. 

Objects 

Objects are geometric figures or text that together make up an image. 
Objects that are geometric figures can be either open or closed, and can 
be filled with specified patterns and displayed in unlimited colors. 

In addition to the standard object design features, the following features 
are also available: 

■ 

■ 

■ 

■ 

Objects can be defined as Groups, Dynamic, and Triggers. 

The Cluster Library contains defined objects that can be used in any 
image.  Library clusters can be defined to include one or more 
existing image object. 

An image can include widgets (slider scale objects and Media 
Player) to enable fast and simple tag value changes.  Widgets are 
custom designed and can be placed anywhere within the image. 

Image objects can be associated with alarms.  

Drawing Space 

An image is drawn in a drawing space measured in drawing units. This 
measurement can be useful when moving throughout the drawing space 
and determining object sizes. 

The drawing space is from -1,000,000 to +1,000,000 drawing units. 
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Image Window 

An image is held in an image window. The part of the image that is 
displayed in the window depends on the window size, image size, and 
zoom level. 

Fast Actions 

Fast Actions are predefined macros that can be attached to triggers to 
enable you to perform routine operations.  These include: 

■ 

■ 

■ 

■ 

■ 

■ 

■ 

■ 

■ 

■ 

CloseActiveImage - used to close the currently opened Image file. 

CloseChart - used to close a specified Chart file. 

CloseEventSummary - used to close a specified Events Summary 
file. 

CloseImage - used to close a specified Image file. 

 LoadAnnFile - used to open a specified Events Summary Profile 
file, or an Event Summary file. 

LoadHtmlPage - used to load a specified HTML page. 

LoadImage - used to open a specified Image file, window and zone. 

LoadPictureFile - used to open a specified image window. 

LoadTrendFile - used to open a specified trend file. 

LockTagsValues - used to open the Tag Value Lock window where 
you can lock/unlock tags and change the locked tags definitions. 

Lock Object 

This option defines that a selected image object when locked cannot be 
moved from its location. 
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Zoom Level 

The zoom level determines how the image will be viewed. The smaller 
the zoom level the closer and larger the image. 

Any zoom level can be assigned from 1 to 2048. At a zoom level of 64, 
each drawing unit is 0.01 mm on a standard monitor. 

Layers 

An image is structured in layers. Each layer contains a part of the overall 
image.  When the drawing is completed the layers can be merged.   Each 
individual image layer can be made visible or hidden. Layers can be 
added or changed, but not removed. 

Zones 

Zones are predefined positions in the image window.  

Goto Zones 

The operator with the relevant authorization can, using the Goto Zone 
option, jump to any defined zone from anywhere in an image.  The Goto 
Zone dialog box is used to enter the coordinates of the location to which 
to jump in the image. Any position in the image can be jumped to 
whether or not that position is defined as a zone.  

Zone Navigator 

The Zone Navigator is a global, multi-image zone navigation window 
that enables you to quickly and efficiently navigate through a list of 
zones defined in the application's various image files. A number of 
navigators each of which can contain a number of zones from one or 
more different image files can be defined in the Zone Navigator module. 
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Toolboxes 

The following toolboxes can be activated in the View mode.  When the 
Image window definition is to open with Navigate Mode On, the 
Drawing, Operations, Options and Color toolboxes will also open. 

Image Files 

There are three file extension types: 

■ 

■ 

■ 

■ 

■ 

■ 

Image  *.VIM 

Bitmaps *.BMP 

ASCII  *.ILS 

By default image files are saved as *.VIM. 

ASCII Files 

By default images are saved in .VIM files. You can, however, also save 
images as ASCII files, which can then be edited and loaded in the Image 
window. 

Image ASCII files can be useful for the following purposes: 

Viewing: Saving images in ASCII format enables you to obtain 
documented records of the images so that they can be viewed by 
opening the file with any text editor. 

This option provides the illustration designer and plant engineer with 
a powerful image-debugging tool. 

The ASCII format enables images to be converted easily from/to 
other formats and be used as drawing objects. 
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■ 

■ 

■ 

This option also enables you to draw Images by editing text files. 
This can be useful when you are working outside the application 
environment, or want to create an image without physically drawing 
it. 

Images in ASCII format can be used for numerous purposes, to 
enhance Image creation and modification capabilities. 

Images saved as ASCII (x.ILS) files can be loaded in the same as 
any other image. 

Bitmap 

A bitmap is a graphic format informing the application to consider the 
graphic element (text or drawing) and its background as a solid unit. 

File Menu 

The Image File menu has the following options: 
Option  Command  

Save Select this option to save the current image file with 
its original name. 

Save as Select this option to save the current image file with a 
new name. 

Insert This option allows you to insert an existing image 
file into an existing Image window. 

Import An image file that has been saved as an ASCII file 
can be imported into the image. This file can then be 
viewed and edited. 

Attach to The File Attach to menu allows you to attach an 
image (*.VIM) to an existing window. This replaces 
the image in the window. The VIM file is modified to 
reflect this change. 

Print Select this option to print the current view. 
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Exit Select this option to close the current window. 

New Image Files 

New Image files are opened from the Application Studio. 

➤ To open a new Image file: 

From the File menu in the Application Studio, point to New and select 
Image.  

Or,  
Press Ctrl +N. 

Or,  

In the Container List of the Application Studio Containers right-click 
Images and select New Image from the popup menu. A new Image is 
displayed with the default Image properties. 

Open Files 

Image files are opened from the Application Studio. 

➤ To open an existing Image file: 

From the File menu of the Application Studio, select Open. In the dialog 
that is displayed, select the file to be opened. Image files have the 
extension *.VIM. 

Or, 
Select the relevant file from the List of Images in the Application Studio. 
When a file has been selected and confirmed, the Image will be opened. 

If an image with an undefined tag is loaded, an error message will appear 
with a reference to a file called imgname.mis, where imgname will be 
the name of the image that was loaded. 
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The .mis file can be opened for further information using any text editor. 
The file includes the name of the undefined tag and its type (dynamic or 
trigger). 

Saving Files 

When saving the image for the first time, the Save As dialog box with 
the extension of *.VIM opens in the default directory for the image.  

➤ To save an Image as an Image file: 

1. Select Save as to open the Save as dialog box. 

2. Select Image from the Save as type list. The file is saved with the 
*VIM extension. 

➤ To save an Image as a Bitmap: 

3. Select Save as to open the Save as dialog box. 

4. Select Bitmap from the Save as type list. The file is saved with the 
.BMP extension. 

➤ To save an Image as an ASCII file: 

5. Select Save as to open the Save as dialog box. 

6. Select ASCII from the Save as type list. The file is saved with the 
.ILS extension. 



Deleting Files 

Images are deleted from the Application Studio. 

➤ To delete an Image file: 

Select the image name from the List of Images in the Application Studio. 
Right-click on the file you wish to delete and select Delete from the 
popup menu. 

Inserting Files 

➤ To insert an image: 

 
1. Select Insert from the File menu. The Open dialog box opens.   

2. Double click the relevant file from the list.  The file contents will be 
merged into the currently opened image file. 
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Note: Imported objects will be placed in the layer to which they 
belonged in the source image (according to the ordinal number of the 
layer and not the layer name), or in the current layer if the layer to 
which they belonged does not exist in the target image. The same applies 
for text in different fonts. 

Importing Files 

The Import option enables you to import or load an image file that has 
been saved as an ASCII file (*.ILS) into the Image window. This file can 
then be viewed and edited. 

➤ To import an Image as an ASCII file: 

1. Select Import from the File menu. The Open dialog box opens.   

2. Double click the relevant file from the list.  The file contents will be 
imported into the currently opened image file. 

Notes: 

1. Imported objects will be placed in the layer to which they belonged 
in the source Image (according to the ordinal number of the layer 
and not the layer name), or in the current layer if the layer to which 
they belonged does not exist in the target Image. The same applies 
for text in different fonts. 

2. Images that were saved as ASCII (x.ILS) files can be loaded in the 
same way as any other image. 

3. For more information see Appendix G, ASCII (ILS) File Format for 
the structure and format of an ILS file. 
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File Attachment  

The Attach to option enables you to attach an Image (*.VIM) to an 
existing window. This replaces the image inside the window. The VIM 
file is modified to reflect this change.  

➤ To attach an image file: 

1. Select Attach to from the File menu. The Open dialog box opens.   

2. Double click the relevant file from the list.  The file contents will be 
imported into the currently opened image file. 

Printing Images 

Images are printed from the Image file menu. 

➤ To print an Image file: 

Select Print from the File menu. The Print dialog box is displayed: 

1. To send the Image to a file in the bitmap format 

2. Select the Bitmap option and specify the filename. 
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Edit Menu 

The Image Edit menu is the graphic tool of the application and is used to 
create and view the images enabling you to visualize part or all of a 
control process. The following options are available:  

Option  Command  

Undo 
Redo 

Undo/redo the last action. 

Copy to Clipboard Transfer data between applications. 
Paste from 
Clipboard 

Paste objects from the Clipboard to an image. 

Edit Properties Edit drawing objects and clusters. Attributes such as 
line and fill color, existing dynamic definitions and 
trigger definitions can be modified. 

Find Find and go to an object that matches the search text. 
Find Next Search for the next occurrence of the last search 

string. 
Align Align two or more objects at right top or bottom. 

Center or resize horizontally, vertically or both. 
Select Select objects in the image. 
Operations This option when selected enables editing and 

animation operations in an Image. 
Drawings This option when selected enables you to draw and 

add text by using the polyline, box, circle, pipe, text, 
and pick color tools or assign trigger objects with the 
button tool. The media player or slider properties can 
also be defined. 

Set Background 
Color  

This option when selected sets the image background 
color. 

Get Colors This option when selected retrieves customized 
colors. 

Save Colors This option when selected saves customized colors. 
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Undo/Redo 

The Undo and Redo operations are available for Image drawing 
operations. This applies to actions such as delete, scale, rotate and 
change attributes (color) of an object. The Undo command reverses or 
deletes the last entry. 

Immediately after you undo an action, the Undo command changes to 
Redo, enabling you to restore what you reversed. Up to 50 levels of 
Undo/Redo operations are available. 

Copy/Paste to Clipboard 

The Clipboard is a convenient way to transfer graphic objects from the 
application to external applications, vice versa, and from one image to 
another.  This option is only available when the Edit mode is activated. 

Image Parameters 

This format is used by to create image objects. Each object in an image 
includes several parameters (such as dynamic, trigger, etc.). These 
parameters inform the application how the object behaves. 

If this format is used, when transferring an object from/to the clipboard 
the object will include other Imaging parameters information. 

Bitmap 

A bitmap graphic is captured by pixels. In a Copy to Clipboard 
operation, the application copy’s the selected object(s) in all of the 
formats.  During a Paste from Clipboard operation, the application will 
paste the clipboard object first in the image parameter format. If the 
object is not in this format it will be pasted in bitmap format and if this 
fails the object will not be pasted. 
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Note: If you paste an object from the clipboard, the imported object will 
be placed in the current active layer. 

When a text object is pasted from the clipboard and the original font of 
the object you pasted does not exist in your system, the object will 
appear in the current active font. 

The following editing operations can be applied to objects pasted from 
the Clipboard to an image: 

 
Operation Bitmap 

Move Yes 
Size Yes 
Rotate No 
Fill No 
Color No 
Dynamic Yes 
Trigger Yes 

➤ To copy an object from an image to the Clipboard: 

Select an object(s), and then select Copy to Clipboard from the Edit 
menu, or click the <Ctrl-Insert> key combination.  

Or, 

Select an object and then right click to open a pop up menu and select 
Copy to Clipboard. 
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➤ To paste an object from the clipboard to an image: 

1. Select Paste from Clipboard in the Edit menu, or press the <Shift-
Insert> key combination or select an object and then right click to 
open a pop up menu and select Paste to Clipboard.   

2. To paste the object do either: 

■ 

■ 

Double-click on the point in the image where you want the 
object to appear. The object will automatically be pasted at the 
location you selected in its original size. 

Click once to set the size and location of the object. You can 
then define the area that the graphic object will fill, using an 
outline box. After the initial click, simply move the outline box, 
by moving the mouse, to the end point of the object, and click 
again. 

Note that if you start by clicking on a high point, and move down and 
click on a lower point, the graphic object will appear upside-down 
(unless that object is in the bitmap format). 



Edit Properties 

The Edit Properties dialog box is used to modify selected objects. 

➤ To open the Edit Properties dialog box: 

Select Edit Properties in the Edit menu, or select an object and then right 
click to open a pop up menu and select Edit Properties. 

 

This dialog box has the following options: 

Objects List This section displays a tree of the object 
according to hierarchy. 

Object Properties This section shows the object selected from 
the Objects List. 

Definition  This button when clicked is used to modify 
dynamic tag parameters and is only 
available for objects such as button, alarm 
or text. It is not available that are defined as 
basic objects. 
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Attributes This button when clicked is used to modify 
an objects color line and color fill. 

Trigger This button when clicked opens the Trigger 
Definition dialog box. 

Triggers 

Trigger objects are objects that you can click on to cause pre-defined tag 
values to be set automatically or manually, cause the image to go to a 
pre-defined zone, or cause pre-defined macros to be activated.  Any 
object can be defined as a trigger object. However, only one tag value 
input method can be assigned per object. 

The tag value input method that you select in the dialog box will be 
marked by an arrow.   

The Data Entry, Bit, Smooth, and Test the last position of the dialog box 
will be saved (unless you activated the Cancel button before completing 
the operation). This means that you can drag the dialog box to any 
position on the screen, and thereafter, whenever the dialog box will be 
invoked, it will appear in its last position.  However, the dialog box 
position is relative to the window position. If the window is moved and 
then the dialog box is invoked, it will appear in the position it was last 
saved, relative to the new location of the window.  
For Text Table objects, the String button will appear in the Input Method 
field instead of Data Entry. 
For Time objects, the Time button will appear in the Input Method field 
instead of Data Entry. 
For Date objects, the Date button will appear in the Input Method field 
instead of Data Entry.  



➤ To define a trigger 

Select the object you want to define as trigger, and then Right click the 
selected object.  Select the Trigger Definition from the popup menu. 

Or, 

From the Edit menu select Operations, then click on the Trigger option. 

Or, 

From the Objects toolbar select the Trigger tool. The Trigger Object 
Definition dialog box opens: 

  
1. Select the station to which the tag associated with the trigger object 

is attached. 

2. Select the tag associated with the trigger object, or click the browse 
button to open the Tag Definition dialog box where you can define a 
new tag. 

3. Select the trigger object Input Method. Several tag input methods 
can be used for trigger objects. To test an input method, tag value 
variations can be simulated.  
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 The tag value input methods include the following: 

Action  When the operator clicks on an object, a present 
value is applied to the tag, or a pre-defined macro is 
activated. This method is valid for all tags and 
objects. 

Buttons When the operator clicks on an object, a set of 
buttons with present values appears. Activating a 
button causes a value to be applied to the tag, or a 
pre-defined macro to be activated. This method is 
valid for all analog and digital tags. 

Bit When the operator clicks on an object, On, Off, and 
Toggle buttons appear. This method is valid for all 
tags and objects (except string tags). 

Data Entry When the operator clicks on an object, a dialog box 
appears to specify a numerical tag value. This 
method is valid for all tags and objects besides Text 
Table objects. 

String The String button will appear instead of the Data 
Entry button. When the operator clicks on an object, 
a Text Table that was made active for the tag 
associated with the object will be applied. The Text 
table contains a list of strings corresponding to 
different tag values. 

Date The Date button will appear instead of the Data 
Entry button. When the operator clicks on an object 
defined as a Date/Time object, a dialog appears with 
the current date value to be modified. 

Time The Time button will appear instead of the Data 
Entry button. When the operator clicks on an object 
defined as a Date/Time object, a dialog box appears 
with the current time value to be modified. 
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Smooth When the operator clicks on an object, a dialog box 
appears with tag values that can be selected using 
sliders. This method is not valid for string tags.  

Momentary When the operator clicks on an object, a dialog box 
appears enabling the user to change tag value in a 
one short action. 

Fast Action When the operator clicks on an object, a pre-defined 
macro, called Fast Action is executed (note that Fast 
Action is Web enabled). 

4. Click the Set Macro button to define macros for trigger objects (note 
that Set Macro is not supported on the Web). 

5. Click the Test button to test the input method and adjust its 
appearance. In addition you can move the numeric keypad to any 
location on your screen. When you re-open Wizcon and operate the 
keypad, it will be opened at the same location as you selected. 

Fast Actions 

Fast Actions are pre-defined macros that can be attached to a trigger, 
enabling you to easily execute routine operations.  

Note: Fast actions are Web enabled. 

➤ To define Fast Action triggers: 

1. Click the Fast Action button on the Trigger Object Definition dialog 
box.  The List of available Fast Actions dialog box is displayed. 



 
2. Select the Fast Action you want to attach to the trigger: 

CloseActiveImage  used to close the opened Image file. 

CloseChart  used to close a specified Chart file. 

CloseEventSummary  used to close a specified Events Summary.  

CloseImage  used to close a specified Image file. 

LoadAnnFile  used to open a specified Events Summary  
Profile file or an Event Summary file. 

LoadHtmlPage  used to load a specified HTML page. 

LoadImage  used to open a specified Image file, window 
and zone. 

LoadPictureFile  used to open a specified image window. 

LoadTrendFile  used to open a specified trend file. 

LockTagsValues used to open the Tag Value Lock window 
where you can lock / unlock tags and 
change the locked tags definitions. 

3. Click OK to define the selected Fast Action Parameters. 
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Find\Find Next in Image 

The Find option is used to search and jump to an object that matches the 
search text. This feature is available in Edit mode only. The Find 
command opens the Find dialog box while Find Next searches for the 
next occurrence of the last search string. 

A search string can be of upto and including 256 characters.  Search 
options are common for all Image windows 

➤ To open the Find/Find next dialog boxes: 

Select Find/Find next from the Image Edit menu or press the following 
keys: 

Ctrl F = Find ■ 

■ F3 = Find next 

Clicking the Advanced button in the Find dialog box opens the lower 
section of the dialog box showing the advanced search options. If a 
search fails, a notification message is displayed with the searched string. 

The Find in Image dialog box has the following options. 
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Simple text Check this checkbox if the Find field is in simple 
text. 

Tag name This includes tag names in Dynamic object, Tag 
value, Trigger, Text table and Widgets. 

Alarm family As defined in alarm object. 

Match case The search is made for full matching letter 
cases; otherwise, strings are compared ignoring 
the case. 

Match whole word The search is made to find the exact full text, all 
characters are accounted for. Otherwise, the 
search is made to find the occurrence of the 
search string inside any text. 

Only in visible view If this option is checked, the search is limited to 
the visible part of the Image inside the Image 
window. 

Trigger macro name The name of the macro that a trigger activates. 

Trigger zone name The name of the zone that a trigger jumps to. 

Trigger button Any name in a trigger button including title and 
legend on each button. 

Cluster instance The instance name of a cluster. 

Cluster library The library name of cluster instance. 

Cluster object The cluster object name as appearing in the 
library. 

Text table value The current string value matches the search 
string. 

String tag value The current string tag value matches the search 
string. 
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Goto object Checks that the application will automatically 
navigate to the found object and bring it into the 
middle of the current window; scale will not be 
changed. 

Always Goto object The application will jump to the found object, 
even if it already appears in the visible part of 
the Window. 

Smart order Performs a geometric search. The image is 
searched from ‘left to right’ in strips of the same 
size of the current open view. In many cases, 
such a search is more intuitive, especially if the 
image is divided into zones with a 
corresponding layout. If this option is not 
checked, the search is simple, meaning that the 
search is by the order of objects in the image, 
from the first object created to the last one.  

Notes: 

1. For Text table and String tag the Simple text option must be also 
checked. 

2. If searching for trigger zone or macro the search is also made in 
trigger buttons for a match. 

3. Options can be set independently. 



Aligning Objects 

The Align option is used to align objects with other objects or to resize 
objects.   

➤ To align objects: 

Select Align in the Image Edit menu or activate the Align toolbox by 
checking Align in the View menu. 
This menu has the following options: 

Icon Command 

 
Align objects by their left edges. 

 
Align objects by their right edges. 

 
Align objects by their centers (vertically). 

 
Align objects by their middles (horizontally). 

 
Align objects both horizontally and vertically. 

 
Align objects by their tops. 

 
Align objects by their bottoms. 

 
One or more objects can be resized to the same width.  

 
One or more objects can be resized to the same height. 

 
One or more objects can be resized to both same height 
and width. 
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Objects can be arranged (distributed) so they are equal 
distances from each other horizontally.  

 
Objects can be arranged (distributed) so they are equal 
distances from each other vertically. 

Note: The Align feature does not support the Undo option. 

Select Options 

There are three Select Options: 

Select ■ 

■ 

■ 

Deselect Last  

Deselect All 

1. To select several objects simultaneously using the left mouse draw a 
rectangle around the relevant objects.   

2. To add a new object to already selected objects press the <Shift> key 
and click a new object. 

3. Deselect objects by clicking on an empty part of the image area or 
select Select/Deselect Last/All.  

4. Deselect the last selected object by pointing to Select in the Edit 
menu and selecting Deselect Last.  

Note: Right-clicking sets the object automatically to select mode and 
cancels the move operation. 
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Drawing Options 

The Drawings toolbox options are used to design image objects. Line, 
Pipe, Box, Text and Circle. 

Both filled and unfilled objects can be selected. The selection and text 
tool are also included in this toolbox. 

Filled rectangle or square tool

Filled circle tool

Filled ellipse tool

Filled closed arc tool

Filled orthogonal polygon tool

Filled polygon tool

Orthogonal pipe tool

Pipe tool

Text tool

Select tool

Unfilled rectangle or square tool

Unfilled circle tool

Unfilled ellipse tool

Unfilled closed arc tool

Unfilled  orthogonal polygon tool

Unfilled polygon tool

Arc tool

Orthogonal polyline tool

Polyline toolInsert Picture

Button  

Drawing Lines and Segmented Shapes  

This section describes how to draw with the following group of tools: 

➤ To draw: 
1. In the Drawings toolbox, click the appropriate shape.  
2. Click the left button on the start point. 
3. Click the left button on successive end points. 
4. Click the right button and the last point will automatically be 

connected to the start point, closing the polygon. 
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5. Right-click in the Image to deselect the tool. 

If you click the right button before starting to draw, the Select tool will 
be activated. 

➤ To create an arc: 
 

Click on a line end while holding down the <Shift> key. The line 
between the last two points will be marked by the system as an arc, 
which can then be adjusted to the required radius and set by clicking the 
left button. 

Drawing Rectangles and Ellipses  

➤ To draw: 

1. In the Drawings toolbox, click the appropriate shape. 

2. Position the mouse pointer where you want to start drawing. 

3. Drag diagonally. 

4. Release the mouse button. 
5. Right-click in the Image to deselect the tool. 

If you click the right button before starting to draw the select tool will be 
activated. 

Drawing Arcs  

Note: The angle of an arc or closed arc may be affected is the arc is 
scaled. 



➤ To draw an arc: 

1. In the Drawings toolbox, click on the appropriate tool. 

2. Position the mouse pointer where you want to start drawing, drag to 
the end point and then release the mouse button. 

3. Move the mouse to the desired radius point and left-click the mouse 
button. 

4. Right-click in the Image to deselect the tool. 

Drawing Pipes 

Note: The thickness of the pipe can be controlled using the plus (+) and 
minus (−) keys at any stage during the drawing process. 

➤ To draw a pipe: 

1. From the Drawings toolbox, click on the appropriate pipe tool. 

2. Click the left mouse button on the start point. 

3. Click the left mouse button on successive end points. 

4. Right-click when the shape is complete. 

5. Right-click in the Image to deselect the tool. 

Text 

This section describes how to insert text into an image: 

➤ To use the text tool: 

1. From the Drawings toolbox, click on the text tool . 

2. Enter text in the Text dialog box. Click OK. The text will appear at 
the specified location on the screen. 
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The other Text Types field is used for the dynamic display of tag values. 
When the text is entered and confirmed, it will appear at the specified 
location on the screen. 

Font Style Selection 

In the application any text object, simple, tag value or text table, can 
have its own font style. The Font bar reflects the font style that is going 
to be used for the next text object. It also reflects the font style of the 
current selected, single, text object. Changing the font style while a 
single text object is selected will change that object's style. Predefined 
text styles can be used for easy uniform texts as labels, titles and so on. 

It is possible to set a style to text and then change only part of the style 
properties. If a style is changed, all texts with that style are changed in 
any property that was not modified for that text.  The text object colors 
are selected and set as any other object. 

➤ To define font styles: 

1. From the Options menu, select Styles Definition. The Styles 
Definition dialog box is displayed: 

2. Click the Add button to open the Style Properties dialog box. 



  

3. Specify the required font style from the following options and click 
OK to save your definitions and close the dialog.  

Style name  Selected from list. Reflects the font style that is 
going to be used for Text objects. Predefined 
text styles can be used for easy uniform texts as 
labels, titles and so on. 

Font Face Name Can be bitmap or TrueType - selected for 
available fonts (system dependent). List of 
available system fonts. 

Font size  For bitmap fonts you can select from sizes 
available for that face name. If another value is 
entered, the Image will use the best fit. In 
TrueType fonts size 14 is translated as 1,000 
word units on scale of 64. 

Effects Select from the following options: Bold: (font 
dependable), Italic, Underline and 
Strikethrough. 

Note that Underline and Strikethrough are not applicable on the Web. 
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Sample Text Type any text to obtain an example of the way 
the text will appear in the Image. The text 
example that you type appears in the example 
box below this field. 

You can activate the Properties button in the Font Styles Definition 
dialog box to reopen the Font Properties dialog box where you can 
change your font definitions. 

It is important to note that when using bitmap fonts, since these fonts 
cannot be scaled or rotated, changing the zoom does not change the size 
of the font. It is recommended to place bitmap text in layers using only 
one scale level. 

Modifying Text 

Text in an image can be edited by selecting the relevant text and then 
activating the Text tool in the Drawing toolbox. 

➤ To modify text: 

1. Select text and activate the Text tool. The Modify Text dialog box is 
displayed: 

  
2. The text you selected to edit will appear in the Text field.  

3. Change the text and activate the OK button to cause the new text to 
replace the old text.  

For tag value, text table, or date/time text, the appropriate dialog is 
displayed in which you can change the text attributes. (For text tables, 
you will be able to select a different file to use.) 
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Specifying Line Properties  

An image can be drawn using different types of lines. The following line 
widths are supported: 1, 2, 4, 6, 8 and 10 pixels. 

➤ To specify the line width/type: 

1. Select the line you want to modify. 

2. Select the Line type  button in the Image toolbar, or select Line 
Type from the Edit menu to open the Lines dropdown list. 

 
3. Select a line type the original line will change to the selected line. 

Colors 

This application has full color support that is limited only by your 
computer’s operating system and hardware. 

Double-clicking on any color in the Color toolbox opens a common 
color dialog box where colors can be selected to customize your toolbox.  
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Setting the Image Background Color 

The Set Image Background feature enables you to set the image 
background color.  

➤ To set the background color: 

1. From the Edit menu select Set Background Color. The Color dialog 
box opens.  

2. Select a color and click OK.  The background of your image will 
display the selected color. 

Saving and Getting Colors: 

The *. pal file contains the 16 toolbox colors as well as the additional 16 
custom colors from the Color dialog box. Once you define or customize 
your colors, you can save them in a *.pal file.  

➤ To get saved colors: 

From the Edit menu select Get/Save Color. The Color dialog box opens. 
The Color dialog box is displayed where you can select the colors from a 
*.pal file. 

If the Image file name and *.pal file name are the same, the *.pal file is 
loaded automatically. You can then continue to work with the 
customized palette every time you open an Image. 

Pick Color Tool 

Select the  Pick Color tool in the Operations toolbox for filling or 
drawing objects with the exact color used in a different object. 

The Pick Color tool enables you to take a color sample from an area of 
an image to designate a new line color or fill color.  
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➤ To select the line or fill color using the Pick Color tool: 

1. Select the drawing tool of your choice. 

2. Select the  Pick Color tool, and then place the dropper icon on 
any point in the image over the desired color. 

3. Draw your new object and the object fills with the selected color. 

4. To select a new line color, in the Color toolbox, click the required 
color. The toolbox resets to the last drawing tool that was used, and 
the color becomes the default color for that drawing tool. 

5. To select a new fill color, in the Color toolbox, right click the 
required color.  The toolbox resets to the last drawing tool that was 
used, and the color becomes the default color for that drawing tool. 

View Menu 

The View menu activates/deactivates the Image module’s toolbar, status 
bar and unique toolboxes.  To activate/deactivate an option click the 
specific menu item in the View menu. 
Option  Command  

Toolbar Defines that the toolbar is activate in the Image 
window. 

Font bar Defines that the font bar is activate in the Image 
window. 

Status bar Defines that the status bar is activate in the Image 
window. 

Objects Defines that the Objects toolbox is activate in the 
Image window. 

Operations Defines that the Operations toolbox is activate in the 
Image window. 
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Drawing Defines that the Drawing toolbox is activate in the 

Image window.  The drawing tools enable the user to 
draw and edit images.  Also included is the Widget 
option and a trigger button. 

Patterns Defines that the Patterns toolbar is activate in the 
Image window. 

Align Defines that the Align toolbox is activate in the 
Image window. 

Colors Defines that the Colors toolbox is activate in the 
Image window. 

Toolbar 

The Image toolbar contains the following icons and commands icons: 
Icon Command  

 Save 

 Print 

 Copy 

 Paste 

 Undo/Redo 

 Goto 

 Goto Zone 

 
Define Zone 
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 Edit Zone 

 Navigate Zone 

 Trigger On 

 Mark Triggers 

 Force Dynamic Show 

 Grid Setup 

 Set Background Color 

 Repaint 

 Line Type 

 

Font Bar 

The Font bar enables you to set the text font style for any text object, 
simple, digital or text table. This toolbar includes the font name, size, 
direction and different text effects. The text can be bold, italic, 
underscored or strikethrough. 

 

Status bar 

The Image module Status bar displays the coordination scale and layer 
of the image object. 



Objects Toolbox 

The Objects toolbox enables you to define image objects such as: Alarm, 
Trigger, Dynamic, Cluster Definition, Group, Slider and Media. 

Alarm Definition

Trigger Definition

Dynamic Definition

Cluster Definition

Group
Slider Media Player

 

Operations Toolbox 

The Operations toolbox includes:  Rotate, Pick Color, Active Layer, 
Toggle Fill, Cluster Library, Send to Back, Bring to Front, Delete, Grid, 
Snap to Grid. 

Rotate

Pick Color

Active Layer

Cluster Library

Send to Back
Bring to Front

Delete

Grid Snap to Grid

Toggle Fill

 

Patterns Toolbox 
The Patterns toolbox contains 16 different fill patterns, including solid 
and transparent. The Image drawing patterns also support 32 gradient 
styles. The first color used for the gradient is the foreground color, while 
the last color used is the background color.  

Gradient fills are supported for the following objects: Text, Filled 
box/circle, Polygon. 
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Note:  Pipes do not support Gradient fills. 

 

Align Toolbox 

The Align toolbox enables you to align two or more selected objects. 
They can be aligned to the left, right, top, or bottom. Objects can also be 
centered or resized horizontally, vertically or both. The objects can also 
be arranged so they are equal distances from each other, either vertically 
or horizontally. 

Align Top

Align Left

Align Bottom

Align Right

Center Vertical
Center Horizontal

Center Horizontal and Vertical

Same Width and Height
Same HeightSame Width

Even Spacing Horizontal

Even Spacing Vertical
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Color Toolbox 

The Color toolbox includes 32 colors for background and foreground 
(text). A left mouse click selects the line color while a right mouse click 
selects the fill color. 

Double-clicking either mouse button opens the Color dialog box, 
enabling you to customize any color. 

Line color
(left-click)

Fill color
(right-click)

Transparent  
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Additional Drawing Tips 

Moving and Scaling Objects 

When an object is selected, eight handles will appear around the object 
to indicate that it is selected. 

➤ To move an object or group of objects in the Image: 

1. Select the object(s) you want to move. 

2. Click inside the object (or bounded rectangle for a group of objects) 
hold the mouse button down and drag the object(s) to the desired 
location. 

➤ To scale an object or group of objects in the Image: 

1. Select the object(s) you want to scale. 

2. Click on one of the eight handles of the object (or bounded 
rectangle, for a group of objects) hold the mouse button down and 
drag the handle to resize the object(s). 

➤ To resize the object(s) proportionally: 

Click and drag any corner handle in a diagonal direction, as in the 
following illustration: 

Note: To terminate a move or scale operation, press the <Esc> key. 

Grouped Objects 

Grouping objects combines two or more objects into a single object. You 
can flip, rotate, and resize or scale all the objects in a group as a single 
unit. You can also change the attributes of all objects in a group at one 
time. Grouped objects can be edited the same way as any other object, 
but cannot be nested (a group cannot include another group). A grouped 
object can also be ungrouped to separate its original elements. 



Note: Any object in a segment which is defined as a trigger object, will 
function in the Trigger mode in the same way as when it is not included 
in a segment.   

Grouping and Ungrouping Objects 

➤ To group objects: 

1. Click the select tool and then drag to select the drawing objects you 
want to group.  

2. Click the button on the Group tool  in the Objects Toolbox or, 
point to Operations in the Edit menu and select Group.  

➤ To ungroup objects: 

Select the grouped objects.  Click the right mouse button on the grouped 
objects and select Ungroup from the popup menu or, point to the 
Operations in the Edit menu and select Ungroup. 

Lock Objects 

Image objects can be locked and unlocked.  A locked object cannot be 
moved or modified. 

➤ To lock an image object: 

1. Select an image object.  

2. Right click to open a popup menu.  Select Lock. 
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Bring to Front/Send to Back 

The Bring to Front option enables you to place objects in the front of 
your Image.  

➤ To bring objects to the front: 

Select the drawing object you want to bring to the front and click the 

Bring to Front tool  in the Operations toolbox. 

➤ To send objects to back: 

Select the drawing object you want to send to the back and click the 

Send to Back tool  in the Operations toolbox or, from the 
Operations menu click Send to Back.  The selected drawing object is 
placed in behind other overlapping objects. 

Layers Menu 

An image is structured in layers. Each layer contains a part of the overall 
image.  When the drawing is completed the layers can be merged.   Each 
individual image layer can be shown/hidden. Layers can be added or 
changed, but not removed. The layer that always exists by default is 
called the base layer. 

Each image can consist of one layer (the Base layer) or several layers.  
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The Layer menu options are as follows: 
Option  Command  

Elaborate on If the Elaborating Zoom is On, each layer will be 
viewed in the scale range assigned when the layer is 
defined. If the Elaborating Zoom is off, each layer 
will always appear (even if scaling ranges were not 
specified for them). 

Active layer The active layer definitions sets the parameters for 
which all subsequent editing operations will be 
performed. 

Definition This option opens the Layers Definition dialog box 
where the parameters for the layer are defined. 

Override 
show/hide 

This option when set to hide indicates that a layer 
will always be hidden, despite the Elaborating Zoom 
mode setting. Any layer set as hidden is marked with 
a special arrowhead character.  
Note that if both Hide and Show attributes are 
assigned to a layer, the layer will be hidden. 

Move objects to 
active layer 

This option is used to move a selected object to the 
layer defined as active. 

Elaborate on 

Layers can be viewed in the Elaborating Zoom On or Elaborating Zoom 
Off mode.  If the Elaborating Zoom is on, each layer will be viewed in 
the scale range you assign when you define the layer. If the Elaborating 
Zoom is off, each layer will always appear (even if scaling ranges were 
not specified for them). 

➤ To toggle the Elaborating Zoom mode on and off  

Select Elaborate On from the Layers menu. 



Active Layer 

The layer that is worked on is referred to as the active layer. The active 
layer name is displayed in the window Title bar together with the Image 
name and the current scale. 

➤ To select an active layer: 

Select Active Layer from the Layers menu. 

Definition 

This option when selected opens the Layers Definition dialog box where 
layers can be defined or modified. 

➤ To define a layer: 

In the Layers menu select Definition. The Layers Definition dialog box 
opens. 
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1. In the Name field type the name of layer. 

2. In the From Scale field, specify the lower limit of the zoom level 
range for elaborating zoom. 

3. In the To Scale field, specify the upper limit of zoom level range for 
elaborating zoom. 

4. Click the Group button to open the Access Permission Manager 
dialog box opens, where you can assign authorized users and groups 
for this layer. 

5. Click the Add button to add your definition to the list of layers. 

➤ To modify a layer: 

1. Select the relevant layer. 

2. Modify the layer using the instructions above.  

3. Click the Change button for the changes to take effect. 

➤ To remove a layer 

Select the relevant layer and click the Delete button. 

Override Show/Hide 

You can override the current visibility mode and make a layer visible or 
hidden. The Layer Override Hide or Layer Override Show dialog boxes 
are basically identical and enable you to select a layer from the list and 
make it visible or hidden.   

When Override Hide is selected the layer will always be hidden, despite 
the Elaborating Zoom mode setting.  A layer set to show/hide is marked 
with an  arrowhead. 

Note: If both the Hide and Show attributes are assigned to a layer, the 
layer will be hidden. 
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➤ To open the Layer Override Show dialog box: 

From the Layers menu select Override Show/Hide.  The Layer Override 
Show/Hide dialog box opens. 

 
1. Select the layer that you wish to show/hide and then click the 

Show/Hide button. This layer will always be visible/hidden. 

2. Click the Clear button if you want all layers to revert to default 
visibility. 

Move Object to Active Layer 

This option is used to move a selected object from a layer to the layer 
defined as active. 

➤ To move an object to the active layer: 

Select an object in one layer and then from the Layers menu select Move 
Objects to Active Layer.  The object will appear in the Active Layer. 

Note:  You can select an object and then click the right mouse button on 
the active layer. 
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Cluster Menu 

A Cluster is an object-class. Clusters can easily placed in an application 
and be reused as required.  Clusters can be small or large. They can be 
simple, such as circles or pumps, or complex, such as a complete sub-
application that includes tanks, pumps and valves.  

Once clusters are instantiated in an Image, they can be moved, scaled, 
rotated, and deleted in the same as any other Image object. To cancel a 
Cluster definition select a cluster object in the Image and then select 
Break from the Clusters menu in the Image. 

Instances cannot be defined as dynamic, as trigger, or as another cluster 
(no nesting of clusters), unless they are broken apart.  

The Clusters menu has the following options: 
Option Action  

Define This option defines clusters and adds them to the 
Cluster Library 

Break This option cancels a selected cluster object in the 
image 

Open lib This option is used to open a library. 
Rebuild instances This option enables instances to be built 

automatically after updating the original cluster in the 
library  

Basket 
maintenance 

A basket is a tool supplying high-level engineering 
and application design. It is used to make a prototype 
of the application before actual implementation and 
traces the progress of the application development.  

Open basket This option displays the clusters defined in a basket. 
On the right of the cluster, the number of times that 
the cluster has been used and maximum usage 
permitted are displayed. 
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Cluster Library 

The Cluster Library uses object-oriented technology to simplify and 
speed up application design and maintenance. A Cluster Library holds a 
number of clusters.  

There are two steps for working with clusters:  

■ 

■ 

Defining clusters and adding them to libraries. This step requires 
knowledge of all the application components and is usually 
performed by application designers.  

Using existing clusters and placing them in the application. This 
requires minimum knowledge of the application and no 
programming skills. 

Once a cluster is placed in an application an instance can be created. One 
cluster can have many different instances, each with the specific 
characteristics defined according to the application’s needs. The action 
of creating a separate instance of the object or function is called 
instantiation.  A unique editing feature allows you to modify any object 
and simultaneously apply the changes to all application diagrams. For 
example, to modify runtime supervision in a certain pump type, you can 
redefine the pump cluster in the library and then rebuild all instances of 
the pump to incorporate the changes made to the cluster definition. 

The application includes a set of ready-to-use cluster libraries.   

It is recommended to use clusters whenever possible. Working with 
clusters is much easier than working with graphics, tags, and alarms 
separately. Besides saving time, you can use an object that has been 
already approved for work. 



Defining Clusters 

➤ To define a cluster and add it to a library: 

Select the graphic object in the image that you want to include in the 
cluster and then either:  
From the Clusters menu select Define. 
Or,   

Click the  tool from the Objects toolbox. 
Or,  
Right-click and select Cluster Definition from the popup menu.  
If no tags or alarms are associated with the graphic objects that are 
selected in the image (the object was not defined as a dynamic, trigger, 
or alarm object), the Define Cluster Object dialog box is displayed: 

 

The following options are available: 

Name Specifies the name of the cluster (up to  
15 characters). 

Lib Specifies the name of the library in which the cluster 
will be placed. To select from existing libraries, 
click on the arrow to the right of the field. 

Description Specifies a brief description of the cluster (up to  
40 characters). 

Note: These fields and buttons appear in the dialog box only if the object 
is defined as a dynamic, trigger, or alarm object. 
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Linked Tags and Alarms 

If the object you selected in the image is associated with tags or alarms 
(the object was defined as a dynamic or trigger object), the Define 
Cluster Object dialog box is displayed:  

 

This listbox contains a list of tags and alarms associated with the object 
you selected, and the type of the object with which the tags and alarms 
are associated. 

The object types, enclosed in brackets (<>), include: 

D for dynamic ■ 

■ 

■ 

■ 

■ 

■ 

■ 

G for trigger 

A for alarm (Not applicable on the Web) 

W for widgets (tag value sliders) 

T for text table 

N for digital, date/time, and string displays 

t for dynamic text tables 
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■ n for dynamic digital, date/time and string displays  

Note: To indicate the connection between the selected line in the list box, 
and the corresponding graphical object, there is an arrow in the 
“Objects View” window (in the right hand side of the list box) from the 
left top corner of the window to the middle of the object. 

➤ To define tags and alarms do the following: 

In the Define Cluster dialog box, click the Tags or Alarms button.  A 
new tag/alarm with the modified original tag/alarm definition will be 
generated during cluster instantination in the image. The Tag Definition 
dialog box is displayed. Only tags/alarms that are associated with the 
cluster objects will appear in the tags/alarms list and only the Change 
button is enabled.  

1. Click the Change button to open the Tag/Alarm Specification dialog 
box. 

2. Complete the fields in this dialog box according to instructions in 
the Tags and Alarms chapters.  

Note: You can also access this dialog by double-clicking on a line in the 
list. 



 

Special Tokens 

In the Tag/Alarms Definition dialog box, you can use special tokens to 
enable customized tag creation and identification during object 
instantiation. These tokens can be used in the Tag Name, Address and 
Description fields to enable customized tag attribute generation. 

‘[..]’ brackets specify an optional parameter. 

The following tokens can be used: 

$ID([from-to]) 

The from-to variable represents characters from the data supplied by the 
operator during instantiation. The following methods can be used for the 
From-To parameter: 

 #-# All the characters within the number range specified will be 
displayed. For example, if the string is ABCDE and 2-4 for From-To 
is specified, the letters BCD will be displayed. 
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#  The character located at the number you specify will be displayed. 
For example, if the string is ABCDE, and you specify 3 for From-
To, the letter C will be displayed. 

#- All the characters from the number you specify and forward will 
be displayed. For example, if the string is ABCDE, and you specify 
3- for From-To, the letters CDE will be displayed. 

-# All the characters up to the number you specify will be displayed. 
For example, if the string is ABCDE and you specify -3 for From-
To, the letters ABC will be displayed. 

For example, If you specify the tag name ANA$ID(2-3) in the Tag 
Definition dialog box and if the operator instantiates the object for 
which this tag was defined and enters the instance name I02, a tag 
called ANA02 will be created for that object (the count for 2-3 in 
I02, is I=1, 0=2, and 2=3). 

For tag address, if, for example, you want the address constant to be 
0000, in the Address field of the Tag Definition dialog box, you can 
choose 0000$ID(2-3). Then if, for example, the operator enters A10 
in the instance name, the address of the tag generated upon 
instantiation of the object would be 000010. 

The same applies for Description. For example, if you want the 
constant valve to appear in the description followed by the valve 
number, if you use Valve$ID() (where the empty parentheses 
indicates that all the characters in the operator-supplied name should 
be used). If the operator enters 12 for the instance name while 
instantiating the object, the description of the generated tag will be 
Valve12. 

Different combinations of the $ID variable can be used to customize 
generated tag attributes upon object instantiation. 



$ASK(“text”[, from-to]) 

For text, specify the text that will appear in the prompt upon 
instantiation. The from-to parameter is optional and can be used in the 
same way as described in $ID token. 

For example, if you entered $ASK(“TAG NAME”) in the Tag/Alarm 
Name field of the Tag/Alarms Specifications dialog box and $ASK 
(“Enter Description”) in the Description field, when you instantiate the 
object in the image, the Instance Parameters dialog box appears: 

 

If you enter $ASK(“Tag Name”,1-4) in the Tag/Alarm Name field of the 
Ta/Alarm Specifications dialog box and $ASK(“Enter Description”,1-5) 
in the Description field, when you instantiate the object in the image, the 
Instance Parameters dialog box  reappears. However, only the first four 
characters of the tag/alarm name and the first five characters of the 
tag/alarm description specified by the operator are extracted and used. 

➤ To find an existing tag/alarm: 

1. Click the find button to open the Find dialog box. 

 
2. Specify the name prefix of the tag or alarm family that you want to 

search, and click the Find button.   

3. Select Define each Object when Instantiating to define alarms during 
cluster instantiation in the Image. 
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Open Lib Options 

This menu option is used to insert an image from an existing Cluster 
Library into an image. 

➤ To instantiate a cluster from a library to the application: 

Select Open Lib from the Clusters menu in the Image window.  
Or,  

Select the  tool from the Operations toolbox. The Drag &Drop To 
Img dialog box is displayed: 

 

Note: This window is modeless (meaning that you can perform other 
application or operating system functions while this window appears on 
the screen). In addition, the library window can be resized to adjust its 
height. 

1. Specify the library from which you want to instantiate a cluster. To 
open a list of existing libraries, click on the arrow to the right of the 
Library field. Double click on a specific cluster to open an 
information box where the library to which the cluster belongs and 
further information regarding the cluster is listed. 
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2. Select the cluster and instantiate it in the image by right clicking on 
the object and dragging it to the required location in the image.  

3. After placing a cluster from a library into an image, the application 
enables you to determine parameters that are used to generate the 
instance characteristics.  If the cluster is not defined with the Define 
each Object when Instantiating option, the Instance Parameters 
dialog box opens. Click the Browse button to locate the tag you want 
to associate with the instance parameters. 

 

Note: If the cluster contains $ASK variables, this dialog includes the 
$ASK Parameter field in which you can specify additional user data. 
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➤ To determine parameters: 

1. Enter a unique instance name in the Instance name field. 

2. Enter a tag name in the TAG NAME field or click the Browse 
button. The Tags Identifier dialog box opens:  

 
3. In the Station field, enter a station name, or click the arrow to the 

right of the field and select the required station from a list of 
available stations.  
To associate more than one station to the instance parameters, select 
another station and click Add. The station is added to the field.  
To replace stations in the Station field, select a station from the list 
of stations and click Change. The specified station is added to the 
Station field, replacing all other stations.  

4. In the Tag field, enter a tag name, or click the arrow to the right of 
the field and select a tag from a list of tags. To associate more than 
one tag to the instance parameters, select another tag and click Add. 
The tag is added to the field. To replace the tags in the Tag field, 
select a tag from the list of tags and click Change. The specified tag 
is added to the Tag field, replacing all other tags. 
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If the cluster is defined with the Define each Object when Instantiating 
option, the Define Instance Links dialog box opens: 

 

The following options are available: 

Instance Name The unique name of the instance in the 
image. 

Linked Tags and Alarms This listbox contains a list of all the tags 
and alarms associated with the object(s) in 
the cluster, and the operation defined for 
each. 

Tags/Alarms Activate these buttons to change the 
original definitions of the tags and alarms 
associated with the objects in the cluster. 
The tag and alarm definitions that you 
specify will be used to generate new tags 
and alarms for the cluster in the Image.  
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Find Activate this button to search for a tag or 
alarm in the Linked Tags and Alarms 
listbox. In the entry field, you can specify 
the full name of the tag or alarm, or a name 
prefix. 

Breaking/Editing Clusters  

Clusters can be modified without breaking the cluster. This includes 
changing tag names and range parameters in dynamic operation. You 
can also change the fill and line color of the objects. Trigger operations 
can also be edited. 

Note: Editing allows modifying, but not adding new properties to the 
cluster. 

➤ To Edit Clusters: 

1. Select the cluster you want to edit. 

2. Right-click the object and select Edit Properties from the popup 
menu.  
Or 
From the Edit menu click Edit Properties. The Edit Properties dialog 
opens. 



  
 The Edit Properties dialog displays the structure of the cluster. The 

dialog box is divided into two frames: 

Object List on the left. The Object tree contains the structural 
makeup of the cluster. For example the displayed truck consists of 
dynamic objects, groups and polylines. Each object can be modified. 

■ 

■ Object Properties on the right. When clicking on an object in the 
Object list, it is shown on the right. The Definitions and Attributes 
buttons allow you to modify the object. You can also modify 
triggers with the Trigger button.   

Note:  For further information read Edit Menu Edit Properties page 17-
17. 
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 Deleting a Cluster from the Library 

Clusters can be deleted from their library. 

➤ To delete a cluster from the library: 

1. Select the Cluster and the Open Lib menu.  

2. In the Library field select the library from which you want to delete 
the object. Then, select the cluster from the clusters list in the dialog 
box and press the Delete button on the keyboard. 

Note: Since a library must contain at least one cluster, the last cluster in 
the library cannot be deleted. 

Copying Clusters from One Library to Another 

Clusters can be copied from one library to another. 

➤ To copy a cluster from one library to another: 

1. Select the Cluster and the Open Lib menu.  

2. In the Library field select the library from which you want to copy 
cluster. Then select this menu item again. 

3. In the new dialog box select the library to which you want to copy 
the cluster. 

4. Then simply drag the cluster from the source library dialog to the 
target library dialog, and the cluster will be copied. 

Note: Clusters that reside in the same library must have different names. 
Therefore, if the cluster you want to copy already exists in the target 
library, you will not be able to copy it.  



Rebuild Instances Option 

One of the big advantages of using clusters is the ability to rebuild all 
instances automatically after updating the original cluster in the library.  

➤ To rebuild the instances in the application: 

1. Select Rebuild Instances from the Clusters men to open the Rebuild 
Cluster Instances dialog box: 

  
 In the list, you can see all the instances that were placed in the 

current Image. Each line contains the library name, the cluster name, 
and how many instances of that object were placed.  

2. Select those items you want to update (note that the list box has 
multiple selections, and therefore, you can select more than one line 
in the list), and press the Rebuild button. 
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Notes: 

1. The tags and alarms that were associated with each instance will 
remain unchanged. 

2. The Rebuild operation will fail if there is no compatibility between 
the cluster in the library, and the instances in the Image. 
Compatibility means that the tags, alarms and triggers must have 
the same links. For example you cannot redefine an object that was 
linked to one tag to be connected to two tags. 

3. You can select all items in the list by pressing <CTRL></> keys 

Cluster Baskets 
The basket is a tool supplying a high level of engineering and 
application design. It is used to make a prototype of the application 
before starting to actually implement it, and also to trace the progress of 
the application development. 

When you place an object from the basket to your application, there is 
one less object that you can take from the basket. If you delete an 
instance that is a basket item from the application, it will be added to the 
basket again (as if not taken from there). All the basket operations are 
also logged in a file called BASKET.LOG, which describes who takes or 
adds items from and to the application basket, and when. 

There is only one basket in the system, which is kept in a simple ASCII 
text file called BASKET.DAT. This file can be edited using any text 
editor to ensure simple and fast image design for the application 
engineers. The format of the BASKET.DAT file is similar to the one that 
appears in the listbox of the Basket Maintenance dialog box. 



➤ To define an application basket: 

Select Basket Maintenance from the Clusters menu to open the Basket 
Maintenance dialog box. 

 
The following fields are available: 

Name Specifies the name of the item as you want it to 
appear in the basket library. 

Library Specifies the library from which you want to extract 
the cluster. To select from a list of existing libraries, 
click on the arrow to the right of the field. 

Object Specifies the name of the cluster as it appears in the 
library you specify. To select from a list of existing 
objects, click on the arrow to the right of the field. 

Amounts For Required, specify the amount of times the 
cluster object will be available in the basket library. 
For Used, the value is usually 0 (if you do not fill 
this field, the default value is also 0). This indicates 
that the first cluster object in the basket library will 
be number 0.  
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Cluster Listbox A list of existing clusters defined in the basket 
library. 

Add Activate this button to add the current cluster 
definition to the basket library. 

Change Activate this button to change the definition of a 
cluster in the basket library to the current definition. 

Delete Activate this button to delete the cluster from the 
basket library. 

Open Cluster Basket Objects 

This option is used to open a cluster basket and import an object into an 
image. 

➤ To instantiate an existing cluster: 

Select Open Basket from the Clusters menu. The Drag &Drop to Img 
dialog box is displayed: 
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➤ To instantiate an object from the library window: 

Click the right mouse button on the object you want to instantiate, and 
drag the object to the desired location in the image. 

Note: In addition to each object in the library, the numbers indicate the 
amount of required objects that you specify in the Basket Maintenance 
dialog box and the amount of objects you already instantiated in the 
Image. 

Options Menu 

This menu defines image properties and zones that will appear on the 
operator’s workstation. 

The Goto, Goto Zone and Zone Definition options are used to define and 
jump to zones. 
Option  Command  

Autowindow This option when selected automatically sets the 
image window position and zoom level. 

Goto This option opens the Goto dialog box where the 
coordinates of the location to which you want to 
jump in the image are defined. 

Goto Zone Using the Goto Zone function, operators can receive 
alarms showing a graphical image of the cause of the 
alarm.   

Zones Definition This option when selected opens the Zones 
Definition dialog box where zone parameters are 
defined.  These zones will appear in the Goto Zone 
list. 

Repaint Select this item to redraw the current image. This is 
useful to view the results of editing operations, if 
they do not immediately appear on the screen.   



Window A window zoom is defined by marking a window in 
an image. This zoom enables the operator to define a 
window’s contents. 

Simulate Select this option to simulate variations of tag values 
and observe how the image is affected by each value. 

Force Zone Dyn 
Show 

This option when selected causes a dynamic object in 
an image to appear. 

Mark Trigger This option when selected causes all trigger objects 
in the window to be marked (or unmarked) on the 
screen. A red hand will appear in all the trigger 
objects in the image. 

Styles Definition Select this option to define a font for image text 
objects. 

Autowindow Option 

This option automatically sets the Image window position and zoom 
level, so that all image objects in the window will be arranged.  

This function can also be performed by clicking the  button on the left 
side of the Image window. 
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Goto Option 

This dialog box is used to enter the coordinates of the location to which 
you want to jump in the image. You can jump to any position in the 
image, whether or not that position is defined as a zone. 

➤ To open the Goto dialog box: 

1. Select Goto from the Options menu or click the  icon. The Goto 
dialog box opens. 

 
2. Enter a scale level between 1 and 2048. 

3. Enter the X and Y coordinates, in drawing units.   

4. Click OK to confirm. 

Note:  In the Image module scale represents the image zoom level.  The 
smaller the scale, the closer the image is.  At a scale of 64 each drawing 
unit is 0.01 on a standard workstation monitor. 
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Goto Zone 

The Goto Zone dialog box enables you to easily jump to any of the 
zones defined in the Zones Definition dialog box. 

➤ To jump to a specified zone in an image: 

From the Options menu select Goto Zone  

Or, 

Click the  icon. The Goto Zone diaog box opens. 

 
1. Select a zone and click OK, or double click a zone. 

2. The image window will immediately be centered on the zone's 
central point and the zoom level will be adjusted to the level defined 
for that zone.    

Note that a pre-defined zone called Previous Zone is included in the 
zone list. You can goto this zone the same way as any other zone. 
However, if there is no zone to return to the previous zone item will be 
disabled. 
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Zone Definition 

A Zone is a pre-defined position and zoom level in the image that can be 
jumped to by selecting the Goto Zone item in the Options menu.  

➤ To open the Zone Definition dialog box 

From the Options menu select Zones Definition 

Or,  

Click the  icon. The Zone Definition dialog box opens: 

  

1. In the Name field type in a unique zone name. 

2. In the Central Point field enter the X and Y coordinates, in drawing 
units, to define the zone center in the image window.  

3. In the Scale field type in a level between 1 and 2048. 

4. Select the Control tag checkbox if you want to use a digital tag to 
indicate the zone status. At run-time, if the digital tag value is 1, the 
zone status will be BAD; if set to 0, the zone status will be GOOD. 
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5. In the Station field select the station from which you want to select a 
tag. 

6. In the Tag field select the tag you want to use from the drop-down 
menu, or click the browse button to open the Tag Definition dialog 
box. 

7. Click the Add button to add the zone. The new zone is displayed in 
the list. 

8. Click Save to save the zone definition and exit the dialog box. 

➤ To modify a defined Zone parameters: 

1. Select the zone you wish to modify. 

2. Using the instructions for Zone Definition, modify the selected zone 
parameters. 

3. Click the Change button. The zone properties displayed in the list of 
zones are modified. 

➤ To remove a zone: 

1. Select the relevant zone. 

2. Click the Delete button. 

Zone Navigator 

The Zone Navigator is a global, multi-image zone navigation window 
that enables efficient navigation through a list of zones defined in the 
application's various image files.  

Using the Zone Navigator window a number of navigators each of which 
can contain a number of zones from one or more different image files 
can be defined. 

 



The Zone Navigator can be applied on images through button and action 
type triggers or by configuring an action macro using the Zone 
Navigation Action macro. 

A digital tag representing the zone status of each Zone Navigator can be 
attached.  If the tag value is set to 1 Zone Navigator status will be BAD 
and if set to 0 Zone Navigator status will be GOOD.   Additionally, 
colors can be defined in which zones with a control tag of BAD status 
will be displayed in the run-time Zone Navigator window.  This option is 
Web enabled. 

➤ To open the Zone Navigators window: 

Double click the  icon on the Studio Control panel.  

Or, 

Select Zone Navigators from the Studio Design menu. 

Or,  

In the Edit mode right click an object to open a popup menu and select 
Trigger Definition, Action and then Zone Navigator.  The Zone 
Navigator dialog box opens. 
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The Zone Navigator has the following fields: 

List of Zone Navigators:  This list displays all the Zone Navigators 
defined. Each navigator is identified by a 
unique name and general description. 

New:   Click this button to add a new Zone 
Navigator.  

Modify:   Click this button to modify the selected Zone 
Navigator.  This will open the New Zone 
Navigator dialog box where the Name field 
will appear in gray.   

Delete: Click this button to delete the selected Zone 
Navigator. 

Select Status Color:  Click this button to open the Color dialog box 
where color indicating zones status can be 
defined. The default color is red. 
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➤ To open a new Zone Navigator: 

In the Zone Navigator dialog box click New to open the New Zone 
Navigator dialog box. 

 

The New Zone Navigator dialog box has the following fields: 

Name: Unique Zone Navigator name. This can be 
up to 60 characters including spaces. 

Description: Unique description of the Zone navigator. 
This can be up to 256 characters, including 
spaces. 
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Enable Tag Control: This checkbox when checked enables 
definition of a digital tag that will indicate 
Zone Navigator status.  At run-time, if the 
digital tag value is 1, the zone navigator 
status will be BAD, if set to 0, the zone 
navigator status will be GOOD.  This option 
has the following fields: 
Station:  Indicating the station from which 
the Tag is selected. 
Tag:  Indicating the Zone Navigator Tag. 

List all Selected Zones: Displays a list of all selected zones.  This 
list has three columns:  Zone Name, Image 
Name and Control Tag.  

Add: This button when clicked opens the Add 
Zones dialog box which displays a list of 
defined zones which can be added/removed 
to the List all Selected Zones. 

Delete: This option when clicked deletes a selected 
zone from the List all Selected Zones. 

Window Properties: The following fields define the zone’s 
behavior on the operator’s workstation: 
Automatically close window after (Sec): 
This option defines that the window will 
automatically close after the indicated 
number of seconds. 
Always Select before Opening: This 
checkbox when checked defines that this 
window will be displayed on top of other 
opened windows. 
Always select before opening:  This 
checkbox when checked indicates that the 
user will jump to the zone only after 
selecting to view it when the alarm is 
received. 
Open in existing window: This checkbox 



when checked indicates that zones will be 
opened in the same image window, even 
when they belong to a different image 
window than the currently opened one. 
When unchecked, each zone will be opened 
in the image file in which it was defined. 

➤ To Add zones to the Zone Navigator: 

Click the Add button to open the Add Zones dialog box: 

 
This dialog box has the following fields: 

List of All Zones: This displays a list of all defined zones in 
the application.  

Selected Zones: This displays a list of the zones selected 
from the List of All Zones. 
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Add/Add All: Click these buttons to either add a selected 
zone to the Selected Zones list or click Add 
All to add all the zones to the list. 

Remove/Remove All: Click these buttons to either remove a 
selected zone from either lists or click 
Remove All to remove all the zones from 
the list. 

Repaint Option 

This option when select redraws the current image. This is useful to view 
the results of editing operations, if they do not immediately appear on 
the screen, or to remove undesirable residues that may remain on the 
screen after editing.    

➤ To repaint an object: 

Select the Repaint option from the Options menu. 

Or, 

Click the  button on the Image scroll bar. 

Window Option 

A window zoom is defined by marking a window in an image.  This is 
later used as the window. This zoom enables the operator to define what 
is to be included in the window. 

➤ To zoom in to a specific part of the image: 

1. Click on any location in the image to define the start and end points 
of the image section you want to zoom in on. 

2. Click in the outlined box, or, click the  button on the Image scroll 
bar. 
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3. To move an outlined box, position your cursor on a box border (a 
multiple arrow cursor appears), click, and drag the box to the new 
position. 

Simulate Option 

This option opens the Simulate Tags dialog box, which is used to specify 
tag values and simulate them for test purposes. After dynamic objects are 
defined, the operator can test an object's response to different tag values 
using an application mechanism that simulates tag values without 
affecting the tag itself.   

➤ To simulate tag values: 

1. Select Simulate from the Options menu. The Simulate Tag Values 
dialog box opens. 

  
2. In the Station field click the arrow to open the dropdown list and 

select the tag station. 

3. In the Tag field click the arrow to open the dropdown list or click the 
Browse button to select the relevant tag. 

4. In the New Suggested Value field type in a value. 

5. To set the value is click the Apply button, or, use the horizontal 
scroll bar to immediately set and simulate the specified value. 

6. Click the Range button to specify the upper and lower range limits 
of the tag value to be simulated. 
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7. Click the Exit button to quit the dialog box and leave the last set 
value. 

Force Zone Dyn Show 

This option when selected causes a dynamic object in an image to appear 
even if the object is hidden. 

➤ To define Force Dynamic show 

Select an object form the view and then select Force Dyn. Show from the 
Options menu, right click an object to open a popup menu and then 

select Dynamic Definition or, click the  icon from the Image Main 
Menu. 

Mark Trigger 

Note: Mark Triggers is not supported on the Web.  

Triggers can be marked in Edit mode during image design. When this 
option is selected all trigger objects in the window are marked (or 
unmarked) on the screen. After selecting the Mark Triggers option, a red 
hand will appear in all the trigger objects in the image. The Mark 
Triggers function will apply to any trigger object.  

Note: If an object is marked (with a red hand) to indicate that it is a 
trigger object, but is dynamically or manually transformed (moved, 
rotated, scaled, etc.), the trigger mark may disappear or will not appear 
in its proper location. If this occurs, you can refresh the screen by 
pressing  <Alt-R>. 
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Styles Definition 

This option is used to define the image text style. 

➤ To define text font style: 

1. Select Styles Definition from the Options menu. The Styles 
Definition dialog box opens. 

 
2. Click the Add button to open the Style Properties dialog box where 

you can define the new style properties. 

3. To change the definition of an existing style select a style from the 
list click the Properties button to open the Style Properties dialog 
box.  Change the style attributes: size and effect and click the OK 
button. 

4. To Remove a style, select a style from the list and click the Remove 
button. 
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Modes Menu 

This menu sets the operating mode of the window. Several image 
windows can appear on the screen simultaneously enabling the operator 
to view and edit separate parts of the same or different images on the 
same screen.  The different modes can be activated/deactivated by 
selecting/deselecting the relevant mode option.  

 
Option Command 

Edit The Edit mode is used for designing and editing an 
image. In this mode, an image can be viewed and 
edited.  

Navigate This option is used to move through an image 
workspace without editing the image. 
In this mode, the displayed image can only be viewed 
and not navigated or edited, though tag input can be 
performed if the operator is authorized to do so and 
the Trigger on mode has been activated. 

Trigger on When the Trigger mode is set to On, objects defined 
as Trigger objects can be used for tag input. When 
this mode is Off, no objects, even one defined as a 
Trigger object, can be used for tag input. 

Copy on When this option is selected transformations do not 
affect the original objects.  For example, if an object 
is moved, both the original and the moved objects 
will remain on the screen (the object will be copied). 
If this mode is Off, when an object is moved, only 
the newly positioned object is moved.    
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Grid setup This option when selected opens the Grid Setup 

dialog box where you can select the grid unit types 
and coordinates, reference point to which all other 
points are relative and preview the defined grid. 

Snap to grid When this option is On the cursor will move only 
from point to point on the grid, without skipping 
points. This mode can be activated to position objects 
accurately in the image. 

Grid show When this option is selected a grid appears in the 
image window. 

Edit Mode 

The Edit mode is used for designing and editing an image. In this mode, 
an image can be viewed and edited. 

A check mark beside the Edit option indicates that it is active. Selecting 
the option again causes the system to revert the Monitor Mode. 

In the Edit mode, all the image Window functions are present, including 
the Tools windows which contains the drawing and editing tools used to 
create and modify images. When the Edit Mode is activated, all the 
Tools available in the window will appear.  The Tools window contains 
the object, the operation, the drawing and the color tools. In addition, the 
current coordinates of the location of the cursor in the image will appear 
in the title bar of the window (or in the caption of the icon, if it was 
minimized).  

Note: If the Edit mode is activated without the Navigate mode, you will 
be able to edit the image, but not scroll, pan, or zoom in it.   

➤ To access the Edit Mode: 

Select Edit from the Modes menu. 



Navigate Mode 

The Navigate Mode is used to move through an image workspace 
without editing the image. 

In this mode, the displayed image can only be viewed and not navigated 
or edited, though tag input can be performed if the operator is authorized 
to do so and the Trigger on mode has been activated.  The Tools window 
initially appears outside the Image Window, but can be moved to the 
new location.   

If this mode is selected without the Edit mode, you will be able to scroll, 
pan, and zoom in the image, but not edit it.  

In addition, if the Edit mode is not activated together with this mode, the 
Tools window will not appear. 

➤ To enable the Navigation mode 

Click the  icon in the Image main menu. 

Or, 

Select Navigate from the Modes menu. 

Trigger On  

When the Trigger mode is set to ON, objects defined as Trigger objects 
can be used for tag input. When this mode is OFF, no objects, even those 
defined as a Trigger object, can be used for tag input. 

When this mode is active, you can move from one trigger object to 
another by pressing the Tab key. To move in the reverse order, press the 
Shift and tab keys together. Note that you move from one object to 
another according to the order in which the objects were designed. To 
change the order, use the Z order tool.  After you select this item, the 
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cursor will appear as a white hand. When the hand is placed on a trigger 
object, it will turn red.  In this mode, image objects designed for tag 
input (trigger objects) can be activated. 

➤ To access the Trigger on mode: 

Click the  icon on the Image Main Menu.  

Copy On  

The Copy On mode enables duplication of objects in Transform 
operations. 

When the Copy On mode is activated, a transform operation will 
preserve the original object. When the Copy on mode is not activated, a 
transform operation will discard the original object (only the transformed 
object will remain). 

➤ To toggle the Copy On mode: 

Select Copy On from the Modes menu. A check beside the item indicates 
that it is active. 

In addition to the Copy mode, the following methods can also be used to 
copy objects: 

Grid Setup 

A grid is an array of points superimposed on an image. It is used to 
accurately position objects in an Image. 

A grid consists of the following elements: 

Origin The origin is the reference point that all other points 
are made relative to. The origin can be any point in 
an Image. 
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Step The distance between adjacent grid points. Different 
values can be assigned for horizontal and vertical 
steps. 

Snapping The cursor can be made to move only in grid point 
steps. When the mouse is moved, the cursor will 
jump to the next grid point. 

The following types of grids can be used: 

World The grid step is set to the Drawing Space: When the 
zoom level is changed, the visible distance between 
grid points also changes accordingly together with 
the other geometrical objects in the Image. 

Pixels The grid step is set to the screen pixels: Whatever 
the zoom level, the distance between the grid points 
remains the same, even though object sizes visibly 
change. 

Grids can be made visible or hidden. The following sections describe the 
operations that are performed to create grids and set their attributes. 



➤ To configure a grid: 

Select Grid Setup from the Modes menu, or the Grid Setup tool  
from the toolbar. The Grid Setup dialog is displayed: 

 

The following options are available: 

Step Units Specifies the grid type, as follows: 
 Pixels are Image grid type units. 
 World are geometric grid type units. 

Step The grid step (in the respective units): 

 X is the horizontal step. 

 Y is the vertical step. 

Origin Used to enter the origin point X-Y coordinates. 

Select Point When this button is activated, the dialog will 
temporarily be suspended, and the operator can then 
indicate the origin point by clicking the left button 
in the window. 
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Show When this button is activated, the grid is displayed 
on the Image to verify the setting. If the operator 
changes the setting and activates the button again, 
the old grid will be deleted and the new one will be 
displayed. 

Snap to Grid  

➤ To toggle the Grid Snapping mode on and off: 

Click the  tool in the Operations toolbox, or select Grid Snap from 
the Modes menu. 

Grid Show 

➤ To make a grid show or hidden: 

Click on the Grid tool  from the Operations toolbox, or select 
Grid Show from the Modes menu. A grid is displayed over the 
Image. 
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